
 

 یدانش آزمون



 .به مجموعه از عناصر قابل لمس و فیزیکی و مدارهای الکترونیکی ....... گویند-1

 ICتراشه  -لفا

 توریترانس -ب

 سخت افرار  -ج

 نرم افرار -د

2-IT ؟ چیست به معنای 

 تارتباطا و اطلاعات فناوري -لفا

 فناوري اطلاعات  -ب

 وتریفناوري کامپ -ج

 یارتباطات مخابرات -د

3-CPU ...... اطلاق می شود..به واحد .. 

 پردازشگر مرکزي  -لفا

 کنترل -ب

 محاسبه ومنطق -ج

 حافظه -د

 واحد مناسب عملیات ریاضی و منطقی نامیده می شود؟ cpuکدام یک از بخش های -4

 Cu -لفا

 Alu  -ب

 Register -ج

 Cache -د

 محتوای کدام یک از حافظه های زیر با قطع جریان برق از بین می رود؟-5

 ROM -لفا

 RAM  -ب

 EPROM -ج

 PROM -د

 .هر کیلو بایت شامل ........ بایت می شود-6

 تیبا 2048 -لفا

 تیبا 1000 -ب

 تیبا 1024*  1024 -ج

 تیبا   1024  -د

 وان خروجی عمل می کند؟کدام یک از سری دستگاه های زیر به عن-7

 دیکل صفحه-شیصفحه نما -چاپگر  -لفا

 پلاتر   -  شینما صفحه   -  چاپــگر -ب

 پلاتر-دیصفحه کل-شیه نماصفح -ج

 اسکنر-پلاتر-دیصفحه کل -د

 ؟ کنند می کار صفحه به اشعه پرتاب با مانیتور مدل کدام-8

 -LCD لفا

 CRT  -ب

 LED -ج

 پلاسما -د



 م یک از چاپگرهای زیر بهتر  است ؟کیفیت چاپ کدا-9

 یسوزن يچاپ گرها -لفا

 جوهر  افشان.  يچاپ  گرها -ب

 يرزیل يچاپ گرها -ج

 یحرارت يگرهاچاپ -د

 کدام یک از دستگاه های زیر جهت انتقال تصاویر به کامپیوتر به کار می رود؟-10

 اسکنر -لفا

 پلاتر -ب

 دیصفحه کل -ج

 ماوس -د

 کدام گزینه زیر می باشد؟تعریف نرم افزار -11

 اجزاي قابل لمس -لفا

 ر فلزيیقطعات غ -ب

 داده ها  و  دستورالعمل ها -ج

 حافظه ها -د

 غیر قابل فهم به زبان قابل درک کامپیوتر کدام برنامه وظیفه این کار برعهده دارد؟ ل دستوراتدیبرای تب-12

 ستم عاملیس -لفا

 مترجم  -ب

 يکاربرد ينرم افزارها -ج

 یکمک ينرم افزارها -د

 کدام نرم افزار به عنوان صفحه گسترده تدریس می شود؟ ICDLدر مهارت های هفتگانه  -13

 MS_WORD -لفا

 MS-Access -ب

 MS_EXCEL  -ج

 Outlook express -د

 مهم ترین نرم افزار سیستمی کامپیوتر چه نام دارد؟-14

 Presentation -لفا

 Utility -ب

 Operating system  -ج

 Compiler -د

 کدامیک از سیستم عامل های زیر تک کاربره می باشد؟-15

 Dos  -لفا

 Windows -ب

 Linux -ج

 Unix -د

 حسوب می شود؟م اینترنت جز کدام شبکه-16

 یمحل -لفا

 گسترده  -ب

 شهري -ج

 یخانگ -د



 کند؟ می تبدیل برعکس و آنالوگ دستگاهی که سیگنالهای دیجیتال را به-17

 تلفن -لفا

 مودم  -ب

 عامل ستمیس -ج

 نترنتیا -د

 گویند؟ می چه  اینترنتی خدمات دهنده  ارائه های شرکت به-18

 -ISDN لفا

 PSTN -ب

 ISP  -ج

 ADSL -د

 استفاده در شبکه را اصطلاحا چه می نامند؟ عددی موردی آدرس ها-19

 IP  -لفا

 TCP -ب

 DNS -ج

 PASSWORD -د

 ترنت ..... و ارسال فایل به اینترنت را ....... می گویند.)راست به چپ(به دریافت فایل از این-20

 Receiving , Sending -لفا

 Download , Upload -ب

 Upload, Download  -ج

 Sending , Receiving -د

 توپولوژی چیست ؟-21

 قانون تبادلات اطلاعات در شبکه -لفا

 انه ها   در شبکهیرا   یکیزیش   فیآرا -ب

 انه در شبکهیآدرس هر را -ج

 شبکه ياجزا -د

 تجارت الکترونیک به چه مفهومی است ؟-22

 ینترنت و شبکه جهانیف ایتوص -لفا

 نترنتیق ایاز طر يتجار يانجام کارها  -ب

 ستمیس يریو به کارگ يزداراه ان -ج

 نترنتیق ایاز طر یبانک يانجام کارها -د

 می رود؟کدام گزینه در مورد آرگونومی بکار -23

 ط کاریمح ییروشنا -لفا

 لیروش استفاده از وسا -ب

 مناسب یاستفاده ازصندل -ج

 ط کاریحفظ سلامت انسان در مح  -د

 چیست؟E-Mailمفهوم -24

 یکیپست  الکترون -لفا

 یکیرونکتتجارت ال -ب

 یکیکتابخانه الکترون -ج

 یکیبانک الکترون -د



 کار می رود؟کدام گزینه در مورد دولت الکترونیکی ب-25

 E-Learning -لفا

  E-Government  -ب

 E-commerce -ج

 E-Mail -د

 به کامپیوتری که در یک شبکه به کامپیوترهای دیگر سرویس دهد چه می گویند؟-26

 Node -لفا

 Client -ب

 Sever  -ج

 Work station -د

 آدرس منحصر بفرد هر منبع در اینترنت چه نامیده می شود؟-27

 URL  -لفا

 https -ب

 ETP -ج

 Telnet -د

 بهترین راه برای جلوگیری از سرایت ویروس به سیستم کامپیوتری چیست ؟-28

 یل الصاقیداراي فا یکینامه هاي الکترون یبررس -لفا

 ن را داشته باشد.وز شدر به ییاب که توانایروس یک ویداشتن   -ب

 نترنتیاتصال به ا -ج

 یاستفاده از حافظه هاي جانب -د

 شبکه ها از نظر توزیع جغرافیایی به چند دسته تقسیم می شو ند؟-29

  Wanو   Lanو  Man  -لفا

 LANو  Wanو  Star -ب

 Busو  Starو  Ring -ج

 Ringو  LANو  Star -د

 متن مناسب است؟ش کدام یک از انواع نرم افزار برای ویرای-30

 یستمیس -لفا

 یبانک اطلاعات -ب

 گاه دادهیپا -ج

 اژه پردازهاو  -د

به نرم افزاری که مصرف کننده برای مدت مشخصی به طور آزمایشی و رایگان ازآن استفاده می کند ولی بعد -31

 از مدتی غیرقابل استفاده می شود؟

 Free Ware -لفا

 Demo -ب

 Share ware  -ج

 Open Source -د

 کدام گروه از نرم افزارهای رایگان نیست؟-32

 یحق کپ يدارا  يهانـرم  افـزار -لفا

 یشینما ينرم افزارها -ب

 متن باز ينرم افزارها -ج



 Demo ينرم افزارها -د

 نوار باریکی که در پائین صفحه  دسک تاپ  نمایان می شود ، چه نام دارد ؟-33

 نوار وظیفه  -لفا

 نوار ابزار -ب

 نوار آدرس -ج

 نوار عنوان -د

 ایش می یابد، چه نام دارد؟منویی که با کلیک راست روی آیکن  نم-34

 منوي میانبر  -لفا

 نوار منو -ب

 منوي فعال -ج

 منوي فایل -د

 برای مشاهده مشخصات پوشه ها باید از چه روشی استفاده کرد؟-35

 Openکلیک راست روي آیکن پوشه و انتخاب  گزینه  -لفا

 Propertiesگزینه ن پوشه و انتخاب  یککلیک راست روي آ  -ب

 لیک روي آیکن  پوشه  مورد نظردابل ک -ج

 درگ کردن  آیکن پوشه  مورد نظر -د

 ظاهر  شدن علامت  فلش  در کنار  یک آیکن  نشانه چیست؟-36

 میانبر بودن آن  -لفا

 انتخاب  آن -ب

 پنجره  بودن آن -ج

 کوچک شدن  پنجره آن -د

 )+(  نمایش یابد، نشانه چیست ؟  علامتپوشه  در ساختار  درختی    اگر  در کنار  نام آیکن-37

 داشتن فایل -لفا

 داشتن زیر پوشه  -ب

 خالی بودن پوشه -ج

 میانبر بودن پوشه -د

 در کدام یک از موارد  زیر امکان  به حد اکثر  رساندن  پنجره  وجود دارد؟-38

 کادر پیغام -لفا

 کادر هشدار -ب

 کادر محاوره -ج

 معمولی ره جنپ  -د

 یابی  پوشه  و یا فایل  حذف شده باید از کدام فرمان استفاده کرد؟برای  باز-39

 Select All -لفا

 Copyو   Paste -ب

 Refresh -ج

 Restore  -د

برای انتخاب گروهی  آیکن  های پراکنده باید از کدام یک از کلید های  زیر به همراه کلیک کردن استفاده -40

 کرد؟

 Shift -لفا

 Alt -ب



 Ctrl  -ج

 Alt + Shift -د

 معیاری استفاده کرد؟ چهباید  از  gif.برای جستجو  فایل های -41

 gif*.  -لفا

 .*gif -ب

 *.* -ج

 *.*gif -د

 با  انتخاب کدام یک از گزینه های زیر امکان جا به جا کردن نوار  وظیفه  وجود ندارد ؟-42

 Lock the taskbar  -لفا

 Keep the taskbar on top of the other windows -ب

 Auto-hide the taskbar -ج

 Show Quick Launch -د

 به ناحیه سمت راست  نوار وظیفه چه می گویند ؟-43

 Toolbar -لفا

 Quick Launch  bar -ب

 Notification area  -ج

 Control box -د

 پسوند  فایل های پشتیبان  چیست؟-44

 bkf  -لفا

 bak -ب

 zip -ج

 rar -د

 پنجره ها به صورت پشت سرهم  کدام گزینه صحیح است؟توای محیش برای نما-45

 Details -لفا

 List -ب

 Content  -ج

 Tiles -د

 است؟ صحیح گزینه کدام ویندوز توسط جهت نمایش محتوای فایل های  شناسایی نشده-46

 دیینما کیکل دابل آنها يرو بر -لفا

 دییمان را انتخاب open نهیگز و کرده کیکل راست لیفا يرو بر -ب

 دییرا انتخاب نما openنه یک کرده و گزیل کلیفا يبررو  -ج

 دییرا انتخاب نما open Withنه یک کرده و گزیل راست کلیفا يبر رو -د

 درکدام حالت از نحوه نمایش پنجره، امکان فیلتر کردن محتوا وجود دارد؟-47

 Tiles -لفا

 Content -ب

 List -ج

 Details  -د

 ع، از کدام گزینه زیر استفاده می شود؟ای میز کار بر اساس نوه برای مرتب کردن آیکن-48

 Size -لفا

 Name -ب



 Date Modified -ج

 Item Type  -د

 Deleteبرای حذف دائم یک فایل به طوری که در سطل بازیافت قرار نگیرد از کدام کلید همراه دکمه -49

 استفاده می شود؟

 Shift  -لفا

 Alt -ب

 Ctrl -ج

 Tab -د

 می اتنخاب را ای گزینه چه ها آن روی راست کلیک از ت فایل ها و پوشه ها پسده خصوصیااهبرای مش-50

 کنیم؟

 Shortcut -لفا

 Properties  -ب

 Refresh -ج

 Attributes -د

 کدام یک از اسامی زیر برای نام پوشه غیر مجاز است؟-51

 Con  -لفا

 Directory -ب

 Listname -ج

 Asp -د

 است؟ ..روش شناسایی فایل  .....-52

 رهیکن و نوع ذخیشکل آ -لفا

 کنیو شکل آ لیپسوند فا -ب

 کنیل و شکل آینام فا -ج

 لیل و نام فایره فایمحل ذخ -د

 کنیم؟ها به کدام گزینه مراجعه میو پوشهبرای انتقال فایل-53

 Open -لفا

 Organize  -ب

 Print -ج

 Burn -د

فعلی ام قبلی ذخیره و بادستور .... می توان اطلاعات فایل ن بادستور ..... می توان تغییرات یک فایل را با همان-54

 را با نام دیگری ذخیره کرد؟ )از راست به چپ(

 Save as-Save  -لفا

 Save-Save as -ب

 Save-Save -ج

 Save as- Save as -د

 کنیم؟ می استفاده زیر گزینه از کدام txtجستجوی کلیه فایل ها با پسوند برای -55

 txt.? -لفا

 ?txt.? -ب

        txt*.  -ج

 .*txt -د



 برای بازکردن فایل فشرده کدام گزینه صحیح است؟-56

 ل فشرده وجود ندارد.یامکان باز کردن فا  -لفا

 د.ییرا انتخاب نماSend  toنهیک راست نموده و گزیآن کل يبررو -ب

 د.ییرا انتخاب نما Extract Allنهیک راست نموده و گزیآن کل يبررو -ج

 د.ییرا انتخاب نما Propertiesنهیگز و نموده راست کیکل نآ يبر رو -د

 توسط نرم افزار فشرده سازی، می توان حجم فایل را تا ...... کاهش داد.-57

 %40 -لفا

 %50  -ب

 %10 -ج

 %60 -د

 چنانچه آیکن ضد ویروس با رنگ قرمز نمایان شود نشانه چیست؟-58

 روسیخراب شدن ضدو -لفا

 ستمیشدن س یروسیو -ب

 روسیبودن ضد وروز ن به  -ج

 ستمیروس در سیعدم وجود و -د

 برای تنظیمات کاغذ از کدام گزینه استفاده می شود؟ Notepadدر نرم افزار -59

 Print preview -لفا

 Send -ب

 Print -ج

 Page setup  -د

 امکان چاپ صفحه جاری سند را فراهم می کند؟ Printکدام یک از گزینه های کادر محاوره ای -60

 Collate -لفا

 Selection -ب

 Current page  -ج

 All -د

 برای تعیین چاپگر به عنوان چاپگر پیش فرض گزینه ...... را انتخاب می کنیم.-61

 Add Prnter -لفا

             Set as Local Printer  -ب

 Set as default printer -ج

 Set as device -د

 سند چگونه عمل می کنیم؟ک برای توقف و برای از سر گیری مجدد عمل چاپ ی-62

 م.یکن یرا انتخاب م Printing Preferenceنه یگز Properties يازمنو -لفا

 م.یکن یرا انتخاب م Pauseنه یگز Document يازمنو -ب

 م.یریگیادامه چاپ در نظر م يرا برا Pauseنه یتوقف وگز يرا برا Resumeنه یگز Document ياز منو -ج

 م.                     یریگ یادامه چاپ در نظر م يرا برا Resumeنه یتوقف و گز يرا برا Pauseنه یگز Document يازمنو  -د

 ر هر صفحه وب چه نامیده می شود؟آدرس منحصربه فرد د-63

 URL  -لفا

 Https -ب

 Etp -ج

 Telent -د



ت کلیدهای ای( کافیست بعد از تایپ نام سWWW.نام سایت.COM) قالب با برای دسترسی به سایت های-64

 ..... را بزنیم.

 +Ctrl -لفا

 Ctrl+Shift -ب

 Ctrl+Esc -ج

  Ctrl+Enter  -د

 مختص کشور ایران است؟کدام یک از دامنه های زیر -65

 TR -لفا

 IR  -ب

 UK -ج

 US -د

66-ISPچیست؟ 

 نترنتیارائه خدمات ا يشرکت ها -لفا

 ند.یمرورگر وب را گو -ب

 ند.یوگISPنترنت را یاشتراک در ا يفرم ها -ج

 ند.یق خط تلفن گوینترنت ازطریبه اتصال ا  -د

 صفحه خانگی یک وب سایت را ...... گویند-67

 Firste pag -لفا

 Home page  -ب

 Web page -ج

 Current page -د

برای اینکه عبارت مورد جستجو به همان شکل در اینترنت جستجو شود)دقیقا همان عبارت(ازکدام کاراکتر -68

 استفاده می شود؟

 {}  -فلا

 ] [ -ب

 ) ( -ج

 " "  -د

متن انتخاب شده به ...... انتقال می  ctrl+cپس از انتخاب قسمتی ازمتن یک صفحه ی وب و فشردن کلید -69

 یابد.

 wordواژه پرداز  -لفا

 گریصفحه وب د -ب

 (clipboard)ندوزیو موقت يحافظه   -ج

 RAMحافظه  -د

 د.دریافت اطلاعات از اینترنت را ...... می گوین-70

 

 Load -الف

 Upload -ب

 Move -ج

 Download  -د

 دوق پستی صحیح می باشد؟کدام یک از گزینه های یک آدرس صن-71



 bayat@irantvto.ir  -لفا

 Yahoo.com@info -ب

 www.yahoo.com -ج

 yahoo@com.alireza -د

 کدام جمله درست است؟-72

 باشد یل منحصر به فرد میمیآدرس ا يپسورد برا -لفا

                      منحصر به فرد است. E-mailل یمیا رسک آدی  -ب

 باشد یمه کاره مین ينامه ها يمحل نگهدار Inboxپوشه  -ج

 باشد یم يورود ينامه ها يمحل نگهدار Spam پوشه -د

 مشهورند؟ نامی چه به پستی صندوق در ناخواسته های پیغام-73

 Noise -لفا

  Spam  -ب

 Virus -ج

 لیمیا -د

 شامل....است. sentپوشه -74

 است شده افتیدر يها نامه ستیل -لفا

             ل نشده است.یند ارسال آنها تکمیاست که هنوز فرا ییست نامه هایل  -ب

 حذف شده است يست نامه هایل -ج

 ارسال شده است يست نامه هایل -د

 کدام پوشه در برگیرنده پیام های دریافت شده می باشد؟-75

  Inbox  -لفا

 Draft -ب

 Outbox -ج

 Sent item -د

 نامه های پیش نویس درکدام پوشه قرارمی گیرند؟-76

 Inbox -لفا

 Outbox -ب

 Sent Item -ج

 Draft  -د

 برای آنکه رونوشت یک نامه از سایر گیرندگان پوشیده بماند....-77

 م.یکن یوارد م ccآدرس آن را در قسمت  -لفا

 م.یکن یوارد م Bccآدرس آن را در قسمت   -ب

 م.یکن یوارد م Toدر قسمت  س آن راآدر -ج

 م.یکن یوارد م Fromآدرس آن را در قسمت  -د

 نامه چه چیز را می نویسیم؟ Subjectدر قسمت -78

 رندهیآدرس گ -لفا

 یرنده مخفیآدرس گ -ب

 موضوع نامه  -ج

 متن نامه -د

 برای ارسال نامه نوشته شده از کدام دکمه استفاده می شود؟-79



 Send  -لفا

 Draft -ب

 Mail -ج

 Reply -د

 برای ضمیمه )پیوست( کردن یک فایل به نامه الکترونیکی از کدام گزینه استفاده می شود؟-80

 Reply -لفا

 Attach File  -ب

 Forward -ج

 Priority -د

 برای ارسال پاسخ به تمام فرستندگان یک نامه از کدام گزینه زیر استفاده می شود؟-81

 Reply -لفا

 Forward -ب

 Reply all  -ج

 Creat mail -د

 برای حذف نامه باید کدام گزینه را انتخاب کرد؟-82

 Clear -لفا

 Delete -ب

 Delete Letter -ج

 Clear Letter -د

 نامه های حذف شده در کدام پوشه قرار دارند؟-83

 Drafts -لفا

 Sent Items -ب

 Deleted Items -ج

 Inbox -د

 چه آدرس است؟کدام گزینه مربوط به کتاب-84

 Address book  -لفا

 Address -ب

 Find -ج

 Book -د

 برای ارسال یک نامه دریافت شده به اشخاص دیگر از کدام گزینه استفاده می شود ؟-85

 send -لفا

 forward  -ب

 Reply all -ج

 reply -د

86-Favorites چه کاربردی دارد؟ 

 مورد علاقه يت هایست سایل يفعال ساز -لفا

 تیحرکت به جلو در سا -ب

 انامه ه سخپا -ج

 تیمشاهده سا -د

 کلید میان بر وسط چین نمودن متن کدام است؟-87



 Ctrl +R -لفا

 Ctrl +E  -ب

 Ctrl +L -ج

 Ctrl +J -د

 برای تغییر جهت کاغذ به صورت افقی از چه گزینه استفاده می کنیم ؟-88

 Portraitنه یگز  Orientationگروه   Page layoutسر برگ  -لفا

 Landscapeنه یگز  Orientationه گرو  Insertسر برگ  -ب

 Portraitنه یگز  Marginsگروه  Insertسر برگ  -ج

 Landscapeنه یگز Orientationگروه  Page layoutسر برگ   -د

 برای تغیر اندازه ی کاغذ از چه گزینه ای استفاده می شود؟-89

 Sizeنه یگز Insertسربرگ  -لفا

 Page Scapeگروه  Page layoutسربرگ   -ب

 Sizeنه یگز Viewرگ سرب -ج

 Sizeنه یگز  Page Setupگروه  Page Layoutسربرگ   -د

 برای ذخیره یک سند تحت نامی دیگر از کدام فرمان استفاده می شود؟-90

 save in -لفا

 save as  -ب

 save -ج

 look in -د

 .کرد استفاده -----ترکیبی یک جمله باید از کلید برای انتخاب-91

 ctrl +click -لفا

 ctrl +Alt -ب

 ctrl +home  -ج

 view -د

 برای وارد کردن یک فایل تصویری در محیط سند، از کدام گزینه استفاده می کنید؟-92

 insert \ picture  -لفا

 home \ picture -ب

 view \ picture -ج

 insert \ chart -د

 برای تقسیم یک خانه جدول به چند خانه از کدام گزینه استفاده می کنیم؟-93

 Merge Cells -لفا

 Split Table -ب

 Split Cells  -ج

 Align top left -د

 کنیم؟ می استفاده گزینه کدام از فرد و زوج صفحات یپاصفحه و سرصفحه در تفاوت برای ایجاد-94

 Different First Page -لفا

 Different Odd & Even Pages  -ب

 Even page -ج

 Insert header and footer -د

 ه صورت باید عمل نمود؟ره صفحه به چمابرای درج ش-95



  Insert>Header & Footer >Page   Number -لفا

 Home>Page Number -ب

 View>Page Number -ج

 Page Layout>Macros>Page Number -د

 برای تنظیم میزان فرورفتگی از کدام گزینه استفاده می شود؟-96

 Indent  -لفا

 spacing -ب

 alignment -ج

 hyphenate -د

 برای جایگرینی عبارتی در اسناد از .......... استفاده می شود؟-97

 Replace  -لفا

 Find -ب

 select -ج

 search -د

 نجام شده بکار می رود؟کدام مورد برای لغو آخرین عمل ا-98

 ctrl + y -لفا

 ctrl + x -ب

 ctrl + z  -ج

 ctrl + v -د

 حالت بزرگ نمایی چه تاثیری بر سند می گذارد؟-99

 کند. یره میذخ ییبا بزرگ نما ند راس -لفا

 کند. یچاپ م ییسند را با بزرگ نما -ب

 چاپ ندارد یري بر چگونگیچ گونه تاثیه  -ج

 کند. یدست کاري مز قلم متن را یسا -د

 برای وارد کردن یک فایل تصویری در محیط سند، از کدام گزینه ها استفاده می کنید؟-100

 Insert \ chart -لفا

 View \ picture -ب

 Picture \ home -ج

 Insert \ picture  -د

 گزینه های مربوط به حاشیه بندی صفحه در کدام زبانه قرار دارند ؟-101

 Insert -لفا

 page layout  -ب

 View -ج

 home -د

 کدام گزینه برای تنظیم شروع شماره صفحات از عدد خاصی است؟-102

 Alignment -لفا

 Position -ب

 Start at  -ج

 Continue -د

 ؟می شودکلید استاندارد استفاده برای تایپ نیم فاصله از کدام کلید ترکیبی در صفحه-103



 spacebar + shift -لفا

 enter + ctrl  -ب

 spacebar + alt -ج

 shift + enter -د

 ازکدام استفاده می شود؟ Wordبرای تبدیل یک جدول به متن در -104

 Table to Text←Table -لفا

 Convert to Text ←Table  -ب

 Text to Table←Table -ج

 Table to Text←Convert -د

 ارند؟قرار د insertتصاویر در کدام گروه از زبانه -105

 pages -لفا

 text -ب

 header & footer -ج

 illustrations  -د

 گردد؟ می انتخاب فایل فرضدر هنگام ذخیره سند کدام فرمت به عنوان پسوند پیش-106

 dot -لفا

 html -ب

 docx  -ج

 txt -د

برگ ها یک عدد یا با فشردن کدام کلید تابعی مکان نما از حالت متن خارج و سربرگها فعال و در کنار سر-107

 یک حرف قرار می گیرد؟

 F2 -لفا

 F4 -ب

 F6  -ج

 F8 -د

 برای تغییر زبان انگلیسی به فارسی و برعکس از ترکیب چه کلیدهایی استفاده می شود؟-108

 Ctrl+ALt -لفا

 Alt+Shift  -ب

 Ctrl+Enter -ج

 Home -د

 دیده نمی شود؟در کدام نمای سند حاشیه و اشکال گرافیکی -109

 Draft  -لفا

 Web layout -ب

 Print layout -ج

 Full Screen -د

یک کلید میانبر ایجاد کنیم از کدام گزینه  Symbolاگر بخواهیم برای کاراکتر انتخاب شده در پنجره -110

 استفاده می کنیم؟

  Shortcut key-لفا

 Autocorrect -ب

 Insert -ج



 Symbol -د

 نوشته شده به لاتین بزرگ است؟ کدام گزینه برای تغییر حروف-111

 Lowercase -لفا

 Toggle Case -ب

 Uppercase  -ج

 Sentence Case -د

 جهت ایجاد لیست علامت گذاری کدام ابزار مناسب است؟-112

 Bullets  -لفا

 Nambering -ب

 Table -ج

 Symbol -د

 از کدام کلید استفاده می شود؟کستن خطوط یک پارگراف با حفظ تراز و عدم بهم خوردگی متن ی شارب-113

 Enter -لفا

 SHift+Enter  -ب

 Ctrl+Enter -ج

 ask Space -د

 برای تغییر رنگ قلم متن نوشته شده از ........ استفاده می شود-114

 Font Color  -لفا

 Fill Color -ب

 Font -ج

 Highlight -د

 شود ؟ محتویات یک سلول از چه گزینه ای استفاده می حذف ایبر-115

 Deleteنه یگزHomeسربرگ   -لفا

 Clear Contentsنه یگز Homeسر برگ   -ب

 Clearنه یگز Dataسر برگ  -ج

 Clear Formatنه یگز Clearگروه  Homeسر برگ  -د

 ؟ یمبرای اضافه کردن توضیحات به یک سلول از چه گزینه ای استفاده می کن-116

 Homeاز سر برگ  Editنه یگز -لفا

 Reviweاز سر برگ  new Commentنه یگز  -ب

 Viewسر برگ  Insert Commentنه یگز -ج

 Insertاز سر برگ  Commentنه یگز -د

 برای درج یک کاراکتر ویژه از چه گزینه ای استفاده می شود ؟-117

 Styleنه یگز Viewسر برگ  -لفا

 Chartنه یگز Insertسر برگ  -ب

 Symbolنه یگز Insertسر برگ   -ج

 Objectنه یگز Insertسر برگ  -د

 برای ضبط یک ماکرو از چه گزینه ای استفاده می کنیم ؟-118

 macroنه یگز Insertسر برگ  -لفا

 View Macroنه یگز Viewسر برگ  -ب

 Record Macroنه یگز Macroگروه  Viewسر برگ   -ج



 Record Macro نهیگز Macroگروه  Insertسر برگ  -د

 کلیدهای ......... مورد استفاده قرار می گیرند. redoریع فرمان برای اجرای س-119

  ctrl +z -لفا

 ctrl +y  -ب

 ctrl +v -ج

  ctrl +x -د

را   excel templateکافی است در لیست ....... گزینه templateبرای ذخیره کردن یک الگو به عنوان یک -120

 انتخاب کنید.

 save  in -لفا

 save   as  type  -ب

 save  as  name -ج

 file name -د

 برای مرتب کردن اطلاعات موجود در لیست )بر اساس حروف الفبا ( ......-121

 data \ sort  -لفا

 data \ filter -ب

 insert \ sort -ج

 home \ find -د

 علامت مساوی در شروع یک خانه  نشانه چیست؟-122

 ک فرمولیشروع   -لفا

 جستجو کیروع ش -ب

 filteringات یشروع عمل -ج

 لیک فای يره سازیشروع ذخ -د

 را در چند سلول محاسبه کند ؟ 3کدامیک از توابع زیر می تواند تعداد اعداد بزرگتراز -123

 if -لفا

 count -ب

 count if  -ج

 sum if -د

 برای بدست آوردن جمع محتویات دوسلول اکسل کدام فرمول صحیح است؟-124

  =A1+B5  -لفا

 A1+b5  = X -ب

 = A1+5 -ج

 A1+b5=x -د

 هریک از خانه ها در صفحه کاری چه نام دارد؟-125

 sheet -لفا

 cell  -ب

 Work book -ج

 file -د

 بالاترین الویت در خواندن فرمول ها کدام است؟-126

 توان -لفا

 پرانتز  -ب



 ضرب -ج

 میتقس -د

 ؟ شود می استفاده ای گزینه چه از در اکسل برای حذف یک سطر-127

 Delete sheet Rowsنه یگزHomeسربرگ    -لفا

 Clear Rowsنه یگز Homeسر برگ  -ب

 Delete columnsنه یگز Dataسر برگ  -ج

 Clear Formatنه یگز Clearگروه  Homeسر برگ  -د

 دکلیدهای ...... مورد استفاده قرار می گیرن undoبرای اجرای سریع فرمان -128

 ctrl +y  -لفا

 ctrl +z -ب

 ctrl +v -ج

  ctrl +x -د

 .کنید را انتخاب ...گزینه  save as type لیست در است برای ذخیره کردن یک الگو  در اکسل کافی-129

 save  in -لفا

 excel template  -ب

 xml data -ج

 file name -د

 ؟می شود استفاده نهگزی کدام از لیست در موجود اطلاعات برای فیلتر کردن-130

 data \ sort  -لفا

 data \ filter -ب

 insert \ sort -ج

 home \ find -د

 کدام علامت در ابتدای یک خانه  نشانه فرمول است.-131

 =  -لفا

 $ -ب

 ؟ -ج

 : -د

 کدامیک از موارد زیر از توانایی های برنامه های صفحه گسترده نمی باشد؟-132

 يوتریمستقل کامپ ییاجرا ک برنامهید یتول  -لفا

 یک شرکت بازرگانی يحسابدار -ب

 يتجار يت اطلاعات و داده هایریدم -ج

 ک شرکتیزان فروش یم یبررس -د

 .......  می گویند. اکسل جدول داخل کاربرگ زبه هر سطر ا-133

 Cell  -لفا

 table -ب

 row -ج

 Column -د

 چه فرمولی باید نوشت؟ برای بدست آوردن ضرب محتویات دوسلول اکسل-134

 =A*5b 1  -لفا

 A1*b5  = X -ب



 = A1*B5 -ج

 A1*b5=x -د

 را می فشاریم. Deleteبرای حذف نمودار روی ......کلیک کرده، کلید -135

 عنوان نمودار -لفا

 محور نمودار -ب

 کل نمودار  -ج

 راهنماي نمودار -د

 دارد؟ وجود کاربرگ ندچ جدید کارپوشه کی 2013اکسل  به طور پیش فرض در-136

 3-لفا

 2 -ب

 4 -ج

 1 -د

 د؟کنفرمان  ...... کاربرگ فعال را حذف می -137

 Rename -لفا

 Delete  -ب

 Tabcolor -ج

 Insert -د

 نام پیش فرض فایل های اکسل چیست؟-138

 Document -لفا

 Book  -ب

 Workbook -ج

 Database -د

 چه کاربردی دارد؟ Numberه ای در کادر محاور Decimal placesگزینه -139

 یش اعداد منفینما -لفا

 ییجدا کردن ارقام اعداد به صورت سه تا -ب

 تعداد ارقام اعشار  -ج

 ن نوع عددییتع -د

140-Chart type در نمودارها چه کاربردی دارد؟ 

 ن عنوان نمودارییتع -لفا

 نمودار ين راهنماییتع -ب

 ش خطوط راهنماینما -ج

 ع نمودارر نوییتغ  -د

 با چه قالبی ذخیره می شوند؟  Accessفایل های -141

 DOCX -لفا

 BMP -ب

  accdb -ج

  PPTX -د

 شود؟ می استفاده افزار نرم کدام از موضوع یک مورد در اطلاعات سازماندهی و یروآ جهت جمع-142

           بانک اطلاعاتی-لفا

 واژه پرداز -ب



 برنامه نمایشی -ج

 جدول -د

 به مجموعه ای از یک یا چند رکورد.............می گویند.-143

 لدیف -لفا

 جدول -ب

 لیفا -ج

 یبانک اطلاعات -د

 ه گفته می شود؟تی در پایگاه داده چعاکوچکترین جزء اطلا-144

 جدول -لفا

 رکورد -ب

 یبانک اطلاعات -ج

 لدیف  -د

 می شود؟کدام نوع داده زیر برای متن های طولانی استفاده -145

 Text -لفا

 Number -ب

 long text  -ج

 Currency -د

 به ارتباطات بین جداول در پایگاه داداه چه می گویند؟-146

 Relationship  -لفا

 Entity -ب

 Integrity Rules -ج

 Database -د

 است؟ مناسب اعشاری عددهای به هنگام تعریف داده های عددی کدام نوع جهت-147

 Byte -لفا

 Integer -ب

 Long integer -ج

 decimal  -د

 کدام نوع رابطه در بین جداول اشتباه است؟-148

 کیک به یرابطه  -لفا

 ک به چندیرابطه  -ب

 کیرابطه چند به  -ج

 د به چنده چنبطرا  -د

 قرار می گیرد؟ Byteحداکثر چه عددی در فیلد عددی از نوع -149

 65000 -لفا

 1024 -ب

 255  -ج

 نامحدود -د

 نمی باشد؟ accessکدام گزینه از اجزای بانک اطلاعاتی -150

 form -لفا

 table -ب



 report -ج

 database  -د

 فرض می باشد؟ یشکدام یک از خصوصیات زیر درمورد فیلدها تعیین کننده مقدار پ-151

 default value  -لفا

 caption -ب

 new value -ج

 input mask -د

 جاد ارتباط بین دو جدول از سربرگ ...... گزینه ....... استفاده می شود؟برای ای-152

 relation shipsنهیگز data base toolsسربرگ  -لفا

  formنه یگز createسربرگ  -ب

 relation shipsنه یگز home سربرگ -ج

 createنه یگز tableسربرگ  -د

 کاراکتر دریافت نکند؟ 20ی تنظیم کردکه بیشتر از با تنظیم کدام مشخصه،می توان فیلد نام را طور-153

 Required -لفا

 Validation Text -ب

 Filed Size  -ج

 Format -د

یغام اخطار ظاهر پ اگر بخواهیم جدول را طوری تنظیم کنیم که با خالی رها کردن یک فیلد از طرف سیستم-154

 شود از کدام مشخصه استفاده می کنیم ؟

 format -لفا

 required  -ب

 caption -ج

 name -د

 کدام خاصیت زیر قانون صحت ورود اطلاعات را مشخص می کند؟-155

 Field Size -لفا

 Caption -ب

 Validation Rule  -ج

 Required -د

 م؟نیبرای ایجاد فیلد کلیدی چه مسیری را انتخاب می ک-156

 Design  →   tools  →  primary key -لفا

 Design→builder -ب

 Design→show/hide→index -ج

 Design→ key -د

 برای ایجاد جدول و یا فرم و گزارش در بانک اطلاعاتی از کدام سربرگ استفاده می شود ؟-157

 Home -لفا

 Create  -ب

 External Data -ج

 Data base Tools -د

 رد ؟یک پرس و جو  تهیه کام گزینه می توان کدبا  استفاده از -158

 Table -لفا



 report -ب

 macro -ج

 query  -د

به کار رود در لیست نتیجه  and <=1367  >=1360برای فیلد تاریخ تولد عبارت   queryاگر در یک -159

 کدام مورد زیر ظاهر می شود؟

 تکمتر اس 1367خ تولد آنها از یفقط اطلاعات افرادي که تار -لفا

 است 1367تا  1360از  اطلاعات افرادي که تولد انها  -ب

 شتر استیب 1360خ تولد انها ار یفقط اطلاعات افرادي که تار -ج

 (1367تا  1360ن یشتر است)بیب 1360کمتر و از  1367خ تولد انها از یاطلاعات افرادي که تار -د

 شود؟ یم استفاده جو و پرس کی در قسمت کدام از معیار کی درج برای-160

 Show -لفا

 field -ب

 Or -ج

 Criteria &  Or  -د

 برای جستجوی رکوردی با مشخصات خاص در یک جدول از کدام فرمان استفاده می شود؟-161

 form -لفا

 Filter  -ب

 Find -ج

 Search -د

 شود؟ می استفاده گزینه کدام از فیلتر جهت اعمال-162

 Delete Filter -لفا

 Apply Filter -ب

 Auto Filter -ج

 Toggle Filter  -د

 برای اینکه در پرس و جو، شرط ورودی را موقع اجرا درخواست کند، از کدام علامت استفاده می کنید-163

  ] [  -لفا

 ) ( -ب

 “   “ -ج

 به علامتی نیاز نیست -د

 در صورتیکه مشخصه ........فیلد دارای مقدار.........باشد می توان فیلد را خالی رها نمود؟-164

 Yes-Required -لفا

 No-Required  -ب

 Yes-Default Value -ج

 No-Default Value -د

 در کدام قسمت پنجره جستجو می توان تعیین کرد که جستجو بر روی کل فیلدهای جدول انجام شود؟-165

 Match -لفا

 find What -ب

 Look in  -ج

 Search -د

 د؟می باش Sort Descendingکدام گزینه به معنای -166



 يصعود يزمرتب سا -لفا

 یبه روش نزول يمرتب ساز  -ب

 باانتخاب کردن يمرتب ساز -ج

 يبدون مرتب ساز -د

چنانچه گزارش ما بیش از یک صفحه بوده و بخواهیم یک عبارت ثابت را فقط در ابتدای اولین صفحه از -167

 گزارش ببینیم، آن عبارت را می بایستی در کدام بخش قرار داد؟

 Page Header/Footer -لفا

 Detail -ب

 Group Header/Footer -ج

 Report Header / footer  -د

سندی که به صورت ساخت یافته اطلاعات استخراج شده از بانک اطلاعاتی را نشان می دهد چه نامیده می -168

 شود؟

 Query -لفا

 Table -ب

 Report  -ج

 Form -د

د می توانیم گزارش را قالب بندی وناده ها در گزارش نمایش داده می شدر کدام نما ، همزمان با اینکه د-169

 یم؟کن

 Print Preview -لفا

 Design View -ب

 Layout View  -ج

 Report View -د

 برای گروه بندی گزارش کدام گزینه استفاده می شود؟-170

 Add -لفا

 Field ّ-ب

 Sort -ج

 Group & Sort  -د

 م؟کنی استفاده printیک فرم ازکدام بخش کادر 5تا  2برای چاپ صفحه -171

 All -لفا

 Pages  -ب

 Selection Record -ج

 Number of Copies -د

 برای اینکه اجرای صوت تا پایان اسلایدها ادامه داشته باشد کدام گزینه را باید انتخاب کرد؟-172

 Automatically -لفا

 clicked  -ب

 play Across slides -ج

 play sound -د

 رنامه نمایشی از کدام اسلاید انجام می شود؟ای بجرا From current slideبا استفاده از گزینه -173

 د اولیاسلا -لفا

 یانید میاسلا -ب



 د آخریاسلا -ج

 يد جاریاسلا  -د

 ............ ذخیره می شود؟یک........... گویندکه با پسوند Powerpointبه هر فایل تولیدی در-174

 Doc-document -لفا

 Pptx-presentation  -ب

 pxt-slide -ج

 xls-spreadsheet -د

 با فشردن کدام کلید بر روی عناوین اسلاید ، اسلایدی جدید ایجاد می شود؟Outlineدر نمای -175

 Space Bar -لفا

 Ctrl+Enter -ب

 Enter  -ج

 F5 -د

 برای ایجادانیمیشن کاربرد دارد؟ Powerpointارافز درنرم کدام منو-176

 Animations  -لفا

 Slide Show -ب

 Design -ج

 Review -د

 درج متن از چه روشی استفاده می شود؟ ایبر-177

 Format -لفا

 Text Box  -ب

 دیاسلا يبدنه  -ج

 یخارج یک شی -د

 به نحوه قرار گرفتن محتوای اسلایدها ....... می گویند.-178

 Slide Design -لفا

 Slide Layout  -ب

 Slide Sorter -ج

 Color Schemes -د

 استفاده می شود ؟_نهزیجهت زمانبندی کردن تعویض اسلایدازکدام گ-179

 Advanced Slide  -لفا

 Preview -ب

 Transition to this Slide -ج

 Animation -د

 گزینه کاربرد دارد؟ برای افزودن مقادیر داده ها بر روی نمودار کدام-180

 Data Label  -لفا

 ChartTitle -ب

 ChartType -ج

 ChartLayout -د

 ه در اسلاید است؟شدکدام گزینه برای تغییر نوع نمودار رسم -181

 Chart Layout -لفا

 Data Label -ب



 ChartTitle -ج

 Chart Type  -د

 ام است؟سریعترین و راحتترین روش برای ایجاد فایل نمایشی کد-182

 Office ياز منو Newنه یانتخاب گز -لفا

 Ctrl+N يدهایفشردن کل  -ب

 Ctrl+M يدهایفشردن کل -ج

 Office ينوم ازRecent Documentنه یانتخاب گز -د

 قابلیت کوچک نمایی برای مشاهده کل اطلاعات به صورت یکجا را ....... می گویند.-183

 Zoom in -لفا

 Zoom out  -ب

 Font Size -ج

 Fit -د

 به نحوه قرار گرفتن متن،تصویر،نمودارو .... در اسلاید چه می گویند؟-184

 Slide   layout -لفا

 Slide Design -ب

 Themes -ج

 Templates -د

 از کدام گزینه استفاده می شود؟Designبرای انتخاب رنگ و طرح زمینه دلخواه برای اسلایدها از سربرگ -185

 Themes  -لفا

 Background Style -ب

 Color -ج

 Effects -د

 کدام گزینه را انتخاب کنیم؟ Insertبرای درج آرم های ذخیره شده از سر برگ -186

 Picture  -لفا

 Clip Art -ب

 Shapes -ج

 Table -د

 کدام گزینه متن انتخاب شده را سایه دار می کند؟-187

 Outline -لفا

 Underline -ب

 Engrave -ج

 Shadow  -د

 در تنظیمات پارگراف ،تورفتگی ابتدای آن را از کدام بخش انجام می دهیم؟-188

 Spacing -لفا

 Indentation  -ب

 Direction -ج

 Alignment -د

 ی فانتزی به متن استفاده می شود؟هااز کدام گزینه برای اعمال جلوه -189

 Shape -لفا

 Text Box -ب



 Font -ج

 Word Art  -د

 پس از درج جدول توسط کدام ابزار می توان مدل خطوط را تغییر داد؟-190

 Eraser -لفا

 Pen Color  -ب

 Pen Style -ج

 Table Style -د

 کدام است؟ "درصد اطلاعات"مناسب ترین نمودار جهت نشان دادن -191

 Line -لفا

 Column -ب

 Bar -ج

 Pie  -د

 ام گزینه استفاده می شود؟برای افزودن عنوان به نمودار از کد-192

 Chart Layout -لفا

 Data Label -ب

 Chart Title  -ج

 Chart Type -د

 کدام گزینه را انتخاب کنیم؟Insertبرای ایجاد یک نمودار سازمانی در اسلاید از سربرگ -193

 Chart -لفا

 Organization Chart -ب

 Smart Art  -ج

 Shapes -د

 می توان مجموعه ای از تصاویر را به صورت آلبوم ایجاد کرد؟ Insertربرگ توسط کدام ابزار در س-194

 Picture -لفا

 Clip Art -ب

 Photo Album  -ج

 Shapes -د

 کدام گزینه برای استفاده از جلوه های آماده متحرک سازی است؟-195

 Animate  -لفا

 Advanced Slide -ب

 Slide Show -ج

 Slide Transition -د

اگر بخواهیم متحرک سازی یک شی همراه با متحرک سازی قبلی اجرا شود، کدام گزینه را انتخاب می -196

 کنیم؟

 On click -لفا

 With Previous  -ب

 After Previous -ج

 Direction -د

 یم؟کنبرایتصحیح خودکار کلمات اشتباه آن ها را به کدام بخش اضافه می -197

 Auto Correct  -لفا



 Spelling -ب

 Dictionary -ج

 Language -د

 کدام یک از موارد زیر تعریف کامپیوتر می باشد؟-198

 انجام دهد ینیرا با سرعت بال یات محاسباتیتواند عمل یاست که م يزین حساب قابل برنامه ریک ماشیوتر یکامپ -لفا

 یآن انجام داده و خروج يرو یات خاصیافت کرده و عملیدر ين وروردعنوا بهرا  ییتواند داده ها یاست که م  يـله ایوس -ب

 د   کند.یاز را تولین مورد يها

 کند ياریاز کارها انسان را  ياریتواند در بس ینان است که میاست هوشمند،خالق و قابل اطم يله ایوتر وسیکامپ -ج

 سرعت و دقت بالا انجام دهد. را بان انسا يکه قادر است همه کارها یکیاست الکترون یدستگاه -د

 شوند؟ کدامیک از موارد زیر یک سیستم عامل محسوب می-199

 Netscape -لفا

 windows10 -ب

 PowerPoint -ج

 Photoshop -د

 شود؟ از کدام مورد برای اتصال به اینترنت استفاده می-200

 LANشکبه  -لفا

 کارت صدا -ب

 مودم -ج

 کیکارت گراف -د

 ؟نیستکامپیوتر کدام یک از گزینه های زیر ضروری و موزیک در ت اده از صوبرای استف-201

 کارت صدا -لفا

 مودم -ب

 ییدئویا وی یل صوتیفا -ج

 بلندگو -د

 به ورودیهای خام سیستم چه می گویند؟-202

 ستمیس -لفا

 اطلاعات -ب

 پردازش -ج

 داده  -د

 یعنی چه؟ copyright قانون-203

  ین نرم افزار  را  کپیحق ندارد بدون اجازه او ا یو کس شود یمک آن محسوب الده  هر  نرم افزار مد  کننیتول  یعنی -لفا

 کند.

 گر استفاده شودید يد توسط شرکتهایشرکتها که به نام آنها ثبت شده است نبا یبعض یاسام یعنی -ب

 ندد و فروش شوید کنندگان خرید بدون اجازه تولینبا يقطعات سخت افزار یعنی -ج

 کند. يبردار یا کپیگران استفاده ید یطلاعات شخصرد از اداحق ن یکس یعنی -د

 سرعت پردازش و ظرفیت ذخیره سازی اطلاعات در کدام نوع از کامپیوترهای زیر بیشتر است؟-204

 super Computer  -لفا

 Micro Computers -ب

 Mini Computer -ج

 Main Frame -د



 ر جزء دستگاههای خروجی هستند ؟کدام یک از ابزار زی-205

 Speaker -فلا

 Mouse -ب

 Keyboard -ج

 Scanner -د

 در موارد زیر چند دستگاه ، ورودی است؟-206

 يد، ماوس، پلاتر، چاپگر، اسکنر، قلم نوریش، صفحه کلیصفحه نما 

 9 -الف

 4  -ب

 5 -ج

 1 -د

 ؟نمی شونده گر محسوب کدامیک از گزینه های زیر جزو وسایل کنترل کننده اشار-207

 ماوس -لفا

 یسصفحه لم -ب

 يدسته باز -ج

 اسکنر  -د

 کدامیک از حافظه های زیر فقط خواندنی هستند؟-208

 Diskette -لفا

 Hard Disk -ب

 ROM  -ج

 RAM -د

 شبکه داخلی یک اداره از چه نوعی است؟-209

 LAN  -لفا

 MAN -ب

 Internet -ج

 wan -د

 ا در کدام واحد قرار می گیرند ؟برنامه ها جهت اجر-210

 یحافظه اصل  -لفا

 هیذتغمنبع  -ب

 هیثانو یحافظه کمک -ج

 یواحد خروج -د

 است ؟ غلطدر مورد حافظه ثانویه کدامیک از موارد زیر -211

 رود ین نمیان برق اطلاعات آن از بیاست که با قطع جر یحافظه دائم -لفا

 با نامحدود استیتقر یسه با حافظه اصلیدر مقا یا فرعیه یحجم حافظه ثانو -ب

 ره کردیذخ یا کمکیه ید آنها را در حافظه ثانویبات اطلاعا یره دائمیذخ يبرا -ج

 ره کردیذخ یا کمکیه ید آنها را در حافظه ثانویره موقت اطلاعات بایذخ يبرا  -د

 به ترکیب سخت افزار و نرم افزار چه می گویند؟-212

 ( ICتراشه ) -لفا

 ستوریرانزت -ب

 ان افزاریم -ج



 نرم افزار -د

 سیستم عامل چیست ؟-213

 گرید يجاد نرم افزارهایا ياست برا يارنرم افز -لفا

 يانجام امور ادار ياست برا ينرم افزار -ب

 نترنتیاستفاده از ا ياست برا ينرم افزار -ج

 .دارد عهده   ستم را بریس  يافزارنرم   و  يافزار سخت  منابع   تمام  تیریمد  است که  يافزار  نرم -د

 ؟ باشدی نم cpuکدامیک از بخشهای زیر جزء واحدهای -214

 ALU -لفا

 CU -ب

 (REGISTERثبات ) -ج

 MEMORY SECONDRY  -د

 واحد کنترل نامیده می شود ؟ CPUکدامیک از بخشهای -215

 Alu -لفا

 cu  -ب

 REGISTER -ج

 CACHE -د

216- E-Learning  از موارد زیر می باشد؟کدام یک 

 یکیالکترون پست -لفا

 یکیالکترون تجارت -ب

 یکیآموزش الکترون  -ج

 یکیلکترونداري ا نکبا -د

 کدام گزینه به معنای تجارت الکترونیکی می باشد؟-217

 E - commerce -لفا

 E-Learning -ب

 E-Government -ج

 E-Library -د

 ؟ نیستر سلامتی هنگام کار با کامپیوتر مربوط کدام یک از عبارت های زیر به امو-218

 یم بودن ارتفاع صندلینان از تنظیاطم -لفا

 ر اتاقسب بودن نونانان از میاطم -ب

 مرتب کار   کردن  ره یذخ -ج

 دور ۀک نقطینگاه کردن به  یگاه -د

 کوچکترین واحد حافظه چیست؟-219

 word -لفا

 kb -ب

 Bit -ج

 byte -د

 ارد زیر باعث کاهش آلودگی های زیست محیطی می شود؟کدامیک ازمو-220

 یکیبه جاي اسناد الکترون ياستفاده ازاسناد کاغذ -لفا

 مصرف شده يافت کاغذ ها و تونر هایو باز يکاغذ يبه جا یکیالکترون از اسناده استفاد  -ب

 يملاقات و جلسات حضور -ج



 زیک پریاد از یعدم گرفتن برق ز -د

 سبت به کامپیوتر چیست؟مزیت انسان ن-221

 انجام محاسبات با دقت بالا -لفا

 انجام محاسبات با سرعت بالا -ب

 ابتکار   و  تیخلاق -ج

 نانیطما تیقابل -د

 از کدام دستگاه زیر جهت چاپ نتایج عملیات و گزارشات بر روی کاغذ استفاده می شود؟-222

 نتریپر -لفا

 اسکنر -ب

 توریمان -ج

 يقلم نور -د

 چیست؟ pasteکلید میانبر فرمان -223

 ctrl+c -لفا

 Ctrl+P -ب

                   Ctrl+V  -ج

 Ctrl+X -د

 ه را انتخاب کرد؟وشچگونه میتوان چند فایل پراکنده یک پ-224

 مورد نظر يلهایفا يک رویبا کل -لفا

 لین حرف نام فاید اولیبا فشار دادن کل -ب

 ن نگه داشت                 ییرا پا CTRLد یمورد نظر کل يهالیفا يک کردن رویهنگام کل  -ج

 ن نگه داشتییرا پا SHIFTد یمورد نظر کل يلهایفا يک کردن رویهنگام کل -د

 های پنجره براساس نوع فایلها از کدام گزینه استفاده می شود؟نمودن آیکنب برای مرت-225

 Name -لفا

                               Type  -ب

 Date -ج

 Size -د

 برای تغییر نام فایلها و پوشه ها از کدام گزینه استفاده می شود؟-226

 Send To -لفا

 Properties -ب

                         Rename  -ج

 Delete -د

 های کاربرجاری  و خروج کامل  باید از کدام گزینه استفاده نمود؟برای بسته شدن پنجره-227

                           start ياز منو log off انتخاب  -لفا

 Shutdown از پنجره Restart انتخاب -ب

 Shutdownاز پنجره  Sleepانتخاب  -ج

 windows down Shutاز پنجره  Restartو  انتخاب  start ياز منو  log offانتخاب  -د

 ؟ شوند می داده اننش قسمت کدام برنامه های در حال اجرا در محیط ویندوز در-228

                              task manager  -لفا

 System tray bar -ب

 toolbar -ج



 Star يمنو -د

 استفاده می شود؟ نهبرای تغییر خصوصیات یک فایل یا پوشه از کدام گزی -229

                                   Properties  -لفا

 Back -ب

 View -ج

 Cut -د

 ؟می دهدهای دیسک سخت را نشان کدام گزینه گنجایش درایو-230

 type -لفا

 free -ب

 backup now -ج

                                    capacity  -د

 ؟می شودچگونه عمل  Recycle Bin محتوای کردن خالی برای-231

 میکنیرا انتخاب م Restoreنه یگز file ياز پنجره آن و از منو -لفا

 میکنیک میرا کل Empty Recycle Bin نهیانتخاب نشده باشد گز یلیکه فا یدر صورت File ياز پنجره آن و از منو -ب

 میکن یک میلک را deleteنه یگز File يه موارد را انتخاب و از منویدر پنجره آن کل -ج

 میکنیک میرا کل Empty Recycle Binه نیانتخاب نشده باشد گز یلیکه فا یدر صورت File ياز پنجره آن و از منو  -د

 م                                                یکن یک میرا کل deleteنه یگز  File يه موارد را انتخاب و از منویا در آن پنجره کلیو  

 پ کرد؟ختم می شود در کادر جستجو چگونه باید تای Tشروع می شود و به  Sیلی که با تجوی فاجسبرای -232

 S ? T~ -لفا

 T ? S~ -ب

                      ~ S * T  -ج

 T * S~ -د

 کدامیک از گزینه های زیر فایل ها و پوشه را همراه با جزئیات نشان می دهد؟-233

 Large Icon -لفا

                             Details  -ب

 List -ج

 Small Icon -د

 می گردد؟ Desktopباعث نمایش یا مخفی شدن آیکنها بروی کدام انتخاب از گزینه ها -234

 Modified -لفا

                           show desktop icons  -ب

 Auto Arrange -ج

 Align to grid -د

 م است؟داکلیدهای میانبر برای بستن پنجره های باز ک-235

 Ctrl+Alt+F4 -لفا

 Alt+F4  -ب

 Ctrl+F4 -ج

 Shift+F4 -د

 فرض برابر است با:افزارهای پیشتعداد نرم number of recent programs to display در کادر-236

 8 -لفا

 10  -ب



 2 -ج

 6 -د

 کدام زا باشد نداشته وجود آنها مجدد بازیابی امکان که طوری به برای حذف قطعی فایل ها Windowsدر -237

 کنیم؟ می استفاده کلیدها

 Alt + Delete -لفا

 Ctrl+Shift+Delete -ب

 Ctrl+ Delete -ج

                            Shift + Delete  -د

 ؟ کند می مرتب آنها تغییر ای ایجاد زمان و تاریخ اساس بر را آنها ها آیکن سازی مرتب روش کدام انتخاب-238

 show desktop icons -لفا

                      modified Date  -ب

 Size -ج

 Type -د

 با ترکیب کدام کلیدها می توان کل محتوای یک پوشه را انتخاب نمود ؟-239

 Alt + C -لفا

 Shift + A -ب

                               Ctrl + A  -ج

 Alt + a -د

 Taskbar and Startای از کادر محاوره ار برای اینکه نتوان محل نوار وظیفه را تغییر داد باید کدام گزینه-240

Menu Properties انتخاب نمود؟ 

                          Lock the taskbar  -لفا

 Auto_ hide the taskbar -ب

 show Quick launch -ج

 Keep the taskbar on top of other windows -د

 د؟شوبرای مرتب سازی صعودی از کدام گزینه استفاده می -241

                             Ascending  -لفا

 Descending -ب

 Type -ج

 Date Modified -د

 کلیدهای میانبر جهت باز کردن پنجره چاپ کدام است؟-242

 Ctrl+A -لفا

                              Ctrl+P  -ب

 Ctrl+C -ج

 Ctrl+Z -د

 است ؟ کدام یک از گزینه ها نرم افزار ضد ویروس-243

 Paint -لفا

                           Nod32  -ب

 Wordpad -ج

 Calculator -د

 کدام گزینه در مورد فشرده سازی صحیح است؟-244



 لیکاهش حجم فا يبرا یروش  -لفا

 رساند یب میل آسیبه فا -ب

 پوشه وجود ندارد يبرا يامکان فشرده ساز -ج

 ستیل فشرده قابل انتقال نیفا -د

 ؟نادرست استکدام جمله -245

 ردیگ یقرار م Recycle Binل حذف شده در یفا -فلا

 کرد                          یابیتوان باز یچگاه نمیحذف شده را ه يل هایفا  -ب

 کرد یافت را پر وخالیتوان صندوق باز یم -ج

 پاک کرد ل رایتوان فا یم deleteنه یل وانتخاب گزینام فا يک راست رویبا کل -د

 ................و برای تغییر نام از کلید ................استفاده می شود.....7آیکن در ویندوز د امکان تغییر نام چن-246

 F1-وجود دارد -لفا

                        F5 -وجود ندارد  -ب

 F2 -وجود دارد -ج

 F3-وجود ندارد -د

 روف است؟پست الکترونیک به کدام گزینه مع-247

 E-Mail  -لفا

 Chat -ب

 E-Banking -ج

 E-Commerce -د

 اگر بخواهیم به نامه رسیده ای پاسخ دهیم کدام دکمه را می زنیم؟-248

 Create -لفا

 Reply  -ب

 Answer -ج

 Send -د

 توسط کدام گزینه می توانیم صفحات وب سایتهای مشاهده شده قبلی رامشاهده کنیم؟-249

 Forward -لفا

 Favorites -ب

 History  -ج

 Back -د

 شخصی کدام گزینه است؟ ترنت بر روی سیستمینذخیره فایل از ا-250

 Download  -لفا

 Forward -ب

 Upload -ج

 Explode -د

 نامه چه می نویسیم؟ Subjectدر قسمت -251

 رندهیآدرس گ -لفا

 یرنده مخفیآدرس گ -ب

 موضوع نامه  -ج

 متن نامه -د

 کدامیک از عبارت های زیر یک مرورگر وب می باشد؟-252



 Word Wide Web -لفا

 Network -ب

 Uniform Resource Locator -ج

 Internet Explorer  -د

 از چه طریقی میتوان به همراه نامه الکترونیکی یک فایل ضمیمه کرده و ارسال کرد؟-253

 Subject -لفا

 Signature -ب

 Body -ج

 Attach File  -د

 ؟نیستکدامیک از گزینه های زیر یک مرورگر وب -254

 Opera -لفا

 IE -ب

  mamma -ج

 fire fox -د

 کنیم؟ می استفاده گزینه کدام برای تنظیم صفحه خانگی در مرورگر اینترنت اکسپلورر از-255

 Security -لفا

 Home Page  -ب

 Compose -ج

 Send -د

 وق پستی به چه نامی مشهورند؟پیغام های ناخواسته در صند-256

 Noise -لفا

 Spam  -ب

 Virus -ج

 لیمیا -د

 ام گزینه زیر استفاده می شود؟کدجهت قطع ارتباط با اینترنت از -257

 Disconnect  -لفا

 Disable -ب

 Enable -ج

 Stop -د

258-ISP چیست؟ 

 اطلاعات و ارتباطات يفناور -لفا

 نترنتیس دهنده ایشرکت سرو  -ب

 لیروتکل انتقال دهنده فاپ -ج

 مخابرات -د

 ؟برای ثبت آدرس سایت های مورد علاقه خود از کدام گزینه زیر استفاده می شود-259

 Favorites  -لفا

 Media -ب

 History -ج

 Home Page -د

 برای ذخیره نمودن تصاویر در وب پس از راست کلیک از چه گزینه ای استفاده می شود؟-260



 Go to my picture -لفا

 Show picture -ب

 Load as picture -ج

 Save picture as  -د

 ستفاده می شود؟گزینه ا اماز کد Yahooبه منظور ورود به محل ایمیل شخصی در سایت -261

 Receive -لفا

 Sign in  -ب

 Check mail -ج

 Sign out -د

 exercise accessدرعبارت جستجو نباشدعبارت  exerciseاگر بخواهیم صفحاتی جستجو شود که کلمه -262

 نمود؟ searchرا چگونه می توان 

 exercise and access -لفا

 access + exercise -ب

 access not exercise  -ج

 exercise or access -د

 بطور اتوماتیک نمایش داده می شود چه نامیده می شود ؟ IEصفحه ای که در هنگام اجرای -263

 home page  -لفا

 last page -ب

 startup page -ج

 final page -د

 باشد؟ زیرمی ی گزینه کدام پسوندسایت های سازمان های غیرانتفاعی-264

 com -لفا

 Org  -ب

 GOV -ج

 Net -د

 ؟باید کلیک نمود IEبرای برگشتن به صفحه ی قبلی ملاحظه شده روی کدام دکمه در -265

 Home -لفا

 Back  -ب

 Forward -ج

 Refresh -د

 دامنه ی مراکز آموزشی درسایت های اینترنتی کدام است؟-266

 Edu  -لفا

 Com -ب

 Gov -ج

 Org -د

 می باشد.؟..پیش فرض برنامه ی مرورگروب، در سیستم عامل ویندوز، ......-267

 Mozilla Fire Fox -لفا

 Opera -ب

 Netscape -ج

 Internet explorer  -د



 کدام گزینه یک پروتکل می باشد؟-268

 url -لفا

 Https  -ب

 Security -ج

 Connect -د

 دکمه ستاره، کدام فرمان زیرا اجرا می کند.  IEدر نوارابزار -269

 Stop -لفا

 Refresh -ب

 Favorites  -ج

 History -د

باخبر باشد آن را در کدام کادر  به فرد دیگر به صورتی که فرد گیرنده اصلی از آنرونوشت نامه  ارسالی برا-270

 مینویسیم؟

 to -لفا

 CC  -ب

 Bcc -ج

 Subject -د

 برای درج جدول از چه گزینه ای استفاده می کنیم ؟-271

 Tableگروه  Viewسربرگ  -لفا

 Tableگروه  Insertسربرگ   -ب

 Tableگروه  Page layoutسربرگ  -ج

 Tableگروه  Fileسربرگ  -د

 رقی از چه گزینه ای استفاده می کنیم ؟برای درج پاو-272

 Headerنه یگز Reviweسر برگ  -لفا

 Footnotesنه یگز Referencesسر برگ   -ب

 Insert Endnoteنه یگز Referencesسر برگ  -ج

 Insert Endnoteنه یگز Referencesو سر برگ  Footnotesنه یگز Referencesسر برگ  -د

 ه صفحه از چه گزینه ای استفاده می کنیم ؟برای اضافه کردن خط کشی ب-273

 Rulerنه یگز Insertسربرگ  -لفا

 Rulerنه یگز Viewسربرگ   -ب

 Rulerنه  یگز Reviewسربرگ  -ج

 Rulerنه  یگز Reviewو سربرگ  Rulerنه یگز Viewو سربرگ  Rulerنه یگز Insertسربرگ  -د

 انتخاب کنیم. ………را از سربرگ  ……د گزینه ها، بایانتخاب قلم مناسب از طریق سربرگ ایبر-274

 insert \ font -لفا

 home \ font  -ب

 page layout \ font -ج

 page layout \ paragraph -د

 کدام کلید ترکیبی میانبر برای کاهش سایز قلم به کار می رود؟-275

  ]+ctrl  -لفا

 <+ctrl -ب

 +)ctrl -ج



 +(ctrl -د

 چهار طرف صفحه کاغذ را به کاربر نشان می دهد؟ wordکدام یک از نماهای -276

 print  layout  -لفا

 web   layout -ب

 outline -ج

 draft -د

 کدام فرمان برای باز کردن یک سند موجود به کار می رود؟-277

 new -لفا

 open  -ب

 save -ج

 save as -د

 ستفاده کرد... ا……کلید ترکیبی  ازبرای رفتن به ابتدای فایل باید -278

 ctrl+click -لفا

 ctrl+home  -ب

 ctrl+end -ج

 ctrl+tab -د

 هر الگو چند بار می تواند توسط کاربر مورد استفاده قرار گیرد؟-279

 کباری -لفا

 دوبار -ب

 سه بار -ج

 ل باشد.یبه هر تعداد که کاربر ما  -د

 ؟می شودنه استفاده کدام گزی ازبرای وارد کردن یک فایل تصویری در محیط سند، -280

 insert \ picture  -لفا

 home \ picture -ب

 view \ picture -ج

 insert \ chart -د

را در حین درگ کردن یک شکل فشار داده و پایین نگه دارید،آن شکل به جای اینکه  ctrlچنانچه دکمه -281

 . می گردد.…. شود …

 جا به جا - یکپ -لفا

 یکپ -جا به جا   -ب

 نهیقر -به جا  اج -ج

 یکپ -نه یقر -د

 دارند؟ قرار )ریبون( زبانه کدام ترازبندی خطوط، تغیر فونت و گزینه های رونوشت و انتقال در -282

 insert -لفا

 home  -ب

 review -ج

 view -د

 کنیم؟پس از رسم جدول، جهت انجام تنظیمات بعدی به کدام سربرگ مراجعه می-283

 home -لفا

 design  -ب



 view -ج

 table -د

 در کدام زبانه قرار دارد ؟ symbolگزینه -284

 insert  -لفا

 home -ب

 review -ج

 view -د

 با چه پسوندی ذخیره می شوند ؟ word 2013فایلهای محیط -285

 doc  -لفا

 dot -ب

 docx -ج

 dotx -د

 از سند به چاپ می رسد ؟کدام بخش  print whatاز لیست  odd pageبا انتخاب گزینه -286

 زوجفحات ص -لفا

 صفحات فرد  -ب

 صفحه اول سند -ج

 صفحه آخر سند -د

 از طریق کدام گزینه می توان متنی را به صورت کم رنگ در پس زمینه سند قرار داد؟-287

 Watermarkنه ی، گزpage background، گروه designسربرگ   -لفا

 Watermarkنه ی، گز page set up، گروهpage Layoutسربرگ  -ب

 page borderنه ی، گزpage background، گروه page Layout سربرگ  -ج

 Watermarkنه ی، گزlink، گروه insertسربرگ  -د

 کلید میانبر باز نمودن سندهای ایجاد شده چیست ؟-288

 Ctrl + O  -لفا

 Alt + O -ب

 Ctrl + P -ج

 Shift +P -د

 می کنیم ؟ اب، کدام گزینه را انتخPrintجاری از کادر محاوره ای  برای چاپ صفحه-289

 Collate -لفا

 Print To File -ب

 All -ج

 Current Page  -د

 جهت نادیده گرفتن غلط املایی، کدام گزینه را باید انتخاب نمود؟ Spelling & Grammarدر پنجره -290

 Change -لفا

 Ignore  -ب

 Change all -ج

 Autocorrect -د

باید انتخاب  Columns ای محاوره درکادر را گزینه شودکدام کشیده هاخطبرای اینکه در بین ستون-291

  ؟نمائیم

 Line Between  -لفا



 Equal Column Width -ب

 Number Of columns -ج

 Right-to-left -د

 داریم؟برای رسم یک مربع باید هنگام رسم آن کدام کلید را پایین نگه -292

 Alt -لفا

 Shift  -ب

 Ctrl -ج

 ستید نین نگه داشتن کلییاز به پاین -د

 کدام گزینه است؟ Replaceید میانبر فرمان لک-293

 Ctrl+F -لفا

 Ctrl+H  -ب

 Ctrl+G -ج

 Ctrl+A -د

 کدام گزینه صحیح است؟ Num lock کلید شدن هنگام فعال-294

 کند.یپ را فعال میاعداد قسمت تا -لفا

 کند.ین حساب را فعال میاعداد قسمت ماش  -ب

 .کندیپ را فعال میقسمت تا یجهت يد هایکل -ج

 کند.ین حساب را فعال میماش یجهت يد هایکل -د

 شیرازه یعنی چه؟-295

 یصحاف يه و شروع متن در کاغذ براین حاشیفاصله ب  -لفا

 یصحاف يوسط کاغذ برا يه هایمتن از حاش یفاصله اضاف -ب

 فاصله متن از چپ و راست کاغذ -ج

 کادر دور متن -د

 . استفاده می کنیم ……برای حذف یک سطر جدول از  -296

 Delete -لفا

 Delete Rowsنه یگز  -ب

 Clean Rows -ج

 Clean Rowsو   Delete Rowsنه یگز -د

 اکسل جزو کدام یک از برنامه های زیر به حساب می آید؟ برنامه-297

 دهرگست صفحه  -لفا

 طلاعاتیا بانک -ب

 نویسی برنامهن باز -ج

 دازپرواژه  -د

 م افزار اکسل در کدام مورد کاربرد دارد؟نر-298

 یر پزشکموا در -فلا

 یاطلاعات ير بانک هاموا بهط مربوي هارکا -ب

 راستارهایو بهط مربوي هارکا -ج

 مالیر موا بهط مربوي هارکاو  مهندسیر مودر ا  -د

 عال در کجا قابل رویت است؟آدرس خانه ف-299

 لفرموار نودر  -لفا



 نیبور خلدر دا -ب

 box nameدرکادر   -ج

 ضیعتو سطردر  -د

 ستون از چه گزینه استفاده می کنیم ؟ ن محتوای یکردای مرتب کبر-300

 Filter & Sort گزینه Editingوه گر Homeگ بر سر  -لفا

 Fill گزینه Editingوه گر Homeگ بر سر -ب

 Sort گزینه Editingوه گر Insertگ بر سر -ج

 Editingوه گر Page layoutگ بر سر -د

 د؟مودر یک خانه چه نوع اطلاعاتی نمی توان وارد ن-301

 متنی -لفا

 نماو ز یخرتا -ب

 ديعد -ج

 تصویر  -د

 ام عملگر دارای پایین ترین اولویت است؟کد-302

 جمع -لفا

 ضرب -ب

 توان -ج

 يبزرگتر -د

 است؟ امکد 2013 اکسل یها فایل وندپس-303

 xelx -لفا

 xplx -ب

 xldx -ج

 xlsx  -د

 ای انصراف از  آخرین عمل انجام شده چه دستوری استفاده می شود؟بر-304

 undo -فلا

 redo -ب

 repeat  -ج

 repeatو  redo -د

 ادغام سلول ها از کدام گزینه استفاده می شود؟ جهت-305

 home- alignment- merge cells  -لفا

 home- alignment-unmerge cells -ب

 home-alignment-split table -ج

 home - alignment-split cells -د

 دهای میانبر زیر استفاده می شود؟ام کلیکداز  pasteو  cutای اجرای فرمان بر-306

 ctrl+y - ctrl+z -لفا

 ctrl+z - ctrl+y -ب

 ctrl+v - ctrl+x  -ج

 ctrl+c - ctrl+v -د

امکان اضافه کردن %  cells formatاز کادر محاوره  numberام یک از گزینه های موجود درزبانه کد-307

 )درصد( را به اعداد می دهد؟



 currency -لفا

 percentage  -ب

 special -ج

 number -د

 ام تابع زیر برای محاسبه میانگین بکار می رود ؟کد-308

 SUM -لفا

 MAX -ب

 AVERAGE  -ج

 IF -د

 چنانچه تقسیم بر صفر انجام شود ، کدام پیغام خطا ظاهر می شود ؟-309

 !VALUE# -لفا

 !REF# -ب

  !DIV/0#  -ج

 !NAME# -د

تفاده می کنیم در کارپوشه را تغییر دهیم از چه دستوری اس ودچنانچه بخواهیم نام یکی از کاربرگهای موج-310

 ؟

 Insert -لفا

 Copy -ب

 Rename -ج

 Delete -د

 چنا نچه بخواهیم قالب متن درون خانه را کپی کنیم کدام مناسب تر است ؟-311

 Format Painter -لفا

 Cut -ب

 Copy -ج

 Copyو    Cut -د

 کدام کلید استفاده می شود؟ز ا excelبرای انتخاب چند سطر غیر همجوار در -312

 shift -لفا

 alt -ب

 ctrl  -ج

 space -د

 برای ثابت نگه داشتن تیتر جداول از کدام دستور استفاده می شود؟-313

 arrange -لفا

 split -ب

 freeze  -ج

 unfreeze -د

 کدام گزینه برای قالب بندی شرطی استفاده می شود؟-314

 Conditional Formatting  -لفا

 Format Cells -ب

 Format -ج

 Format as table -د



 برای درج خودکار سری داده ها از کدام گزینه استفاده می شود ؟-315

 Auto Complete -لفا

 Pick From Drop Down List  -ب

 Auto Fill -ج

 Auto List -د

 ؟ یماعداد به صورت درصد نمایش داده شود ، آن را از چه نوعی تعریف می کن A5برای اینکه در خانه -316

 Percentage  -لفا

 Fraction -ب

 Currency -ج

 Scientific -د

 از کدام کلید استفاده می شود؟ excelبرای انتخاب چند سطر همجوار در -317

 shift  -لفا

 alt -ب

 ctrl -ج

 space -د

 در قسمت خواص فیلد، کدام گزینه زیر برای تعیین الگوی خاصی جهت ورود داده ها در فیلد بکار می رود ؟-318

 Field Size -فلا

 Default Value -ب

 Input Mask  -ج

 Caption -د

319-Decimal Place   ؟ است بوده دسترسی قابل برای کدام نوع داده 

 عددي  -لفا

 یمتن -ب

 خیتار -ج

 ادداشتی -د

 کدام یک از گزینه های زیر برای تغییر ساختار جدول به کار می رود؟-320

 Newدکمه  -لفا

 Openدکمه  -ب

 Design دکمه   -ج

 نمی توان تغییر داد Accessساختار جدول را در  -د

 فیلد سال تولد از چه نوعی باید باشد؟-321

 Text -لفا

 Memo -ب

 Date/Time  -ج

 Number -د

 متنی که می خواهیم  در بالای هر صفحه گزارش تکرار شوند در کدام بخش گزارش قرار می گیرند؟-322

 Detail -لفا

 Page Header  -ب

 Report footer -ج

 Group footer -د



 برای اینکه خروجی جدول بصورت افقی قرار گیرد گزینه ................ را انتخاب می کنیم ؟-323

 LandScape  -لفا

 Portrait -ب

 Vertically -ج

 Horizontally -د

 کدام گزینه زیر یک گزارش به صورت جدولی ایجاد می کند ؟-324

 Auto Report : Columnar  -لفا

 Auto Report : Tabular -ب

 Auto Report : Data Base -ج

 Auto Report : Wizard -د

 کدامیک از گزینه های زیر جزء مشخصات فیلد می باشد؟-325

 لدینام ف -لفا

 لدینوع ف -ب

 فیتوص -ج

 فیلد و توصیلد و نوع فینام ف  -د

 ربوط وارد کرد؟م ک از گزینه های زیر می توان شرط مورد نظر در ستونبه کمک کدامی Queryدر یک -326

 Sort -لفا

 Criteria  -ب

 Table -ج

 Show -د

کدامیک از گزینه های زیر بدنه اصلی فرم را تشکیل  Design Viewدر روش طراحی فرم به صورت دستی-327

 می دهد؟

 Details  -لفا

 Form header -ب

 Page footer -ج

 Form footer -د

 یلد از چه کلید میانبری استفاده می شود؟ف برای جستجو کردن و جایگزین کردن مقدار جدید در-328

 Ctrl+A -لفا

 Ctrl+D -ب

 Ctrl+Z -ج

 Ctrl+H  -د

 رود؟ می کار به ارزی ای پولی کدامیک از انواع داده های زیر برای ذخیره واحد-329

 Currency  -لفا

 Memo -ب

 Text -ج

 Ole Object -د

 می شود؟ه از کدامیک از گزینه های زیر برای مرتب سازی نزولی استفاد-330

 Filter by Form -لفا

 Sort Descending  -ب

 Filter By Selection -ج



 Sort Ascending -د

 برای درج تصویر در فیلد از چه نوع دادهایی باید استفاده کرد؟-331

 Currency -لفا

 Memo -ب

 Text -ج

 Ole object  -د

 می شود؟ه برای در نظر گرفتن نام توصیفی برای فیلدها از کدام مشخصه استفاد-332

 default value -لفا

 caption  -ب

 new value -ج

 input mask -د

برای یک فیلد در نظر گرفته شوند شرط را برای کدام خاصیت از فیلد  <50برای اینکه اعلام کنیم که اعداد -333

 علام نمود ؟باید ا

 Default Value -لفا

 Required -ب

 Validation Rule  -ج

 Validaton Text -د

 عداد متوالی اتوماتیک کدام نوع داده را برای فیلد باید تعریف نمود ؟ولید ات برای-334

 Number -لفا

 Memo -ب

 Autonumber  -ج

 Hyperlink -د

 سازی رکورد به کار می رود؟کدام یک از موارد زیر برای منحصر به فرد -335

  validation rule)ک قانون اعتبار )ی -لفا

 ((Formفرم -ب

 (primary keyه)ید اولیکل  -ج

 (Filter)لتریف -د

 ؟ کرد چاپ و انجام جمع مانند محاسباتی ها داده روی بر توان می .......... از استفاده با-336

 گزارش  -لفا

 فرم -ب

 Query -ج

 Data sheet -د

 می باشد انتخاب می کنید؟ True/Falseکدام نوع داده را برای فیلدی که محتوایش -337

 Date -لفا

 Text -ب

 Number -ج

 Yes/no  -د

 از کدام گزینه برای افزودن جدول به اسلاید استفاده می شود؟-338

 Insert / New Slideنه یگز -لفا

 Insert   /  Table  نه یگز -ب



 Insert /Diagramنه یگز -ج

 د اضافه کردیتوان به اسلا یجدول را نم -د

 ر روی مسیر داد؟ب می توان جلوه حرکت به موضوعات Animation  در کدام  قسمت از سربرگ-339

 Entrance -لفا

 Emphasis -ب

 Exit -ج

 Motion Path  -د

 یر به اسلاید اضافه نمود؟در کدام نما نمی توان متن یا تصو-340

 Note Page -لفا

 Slide   Sorter -ب

 Normal -ج

 Outline -د

 با فشار کدام کلیدها می توان یک کپی از اسلاید را بعد از همان اسلاید ایجاد کرد ؟-341

 Ctrl + C -لفا

 Ctrl + X -ب

 Ctrl + V -ج

 Ctrl + D -د

، کدام گزینه زیر زمان تاخیر برای حرکت موضوع را می   Timingو در  قسمت   Animation در سربرگ-342

 توان وارد کرد؟

 Start -لفا

 Delay  -ب

 Speed -ج

 Repeat -د

 چیست؟ Power Pointبطور پیش فرض نام فایل نمایش در -343

 Book1 -لفا

 Presentation1  -ب

 Slide1 -ج

 Ppt -د

 تصویر و یادداشت به اسلاید اضافه کرد؟ در کدام یک از نماهای زیر می توان متن ،-344

 Slide Sorter -لفا

 Draft -ب

 Normal  -ج

 Slide Show -د

 برای خاتمه دادن به نمایش اسلاید ها کدام کلید را باید فشرد؟-345

 E -لفا

 Ecs  -ب

 Home -ج

 End -د

رداده و روی آخرین اسلاید یدهای هم جوار کلید........را همزمان از صفحه کلید فشاخاب اسلانتجهت ا-346

 کلیک می کنید.



 Shift  -لفا

 Ctrl -ب

 Alt -ج

 Tab -د

 برای ایجاد فایل در پاورپوینت کدام کلیدهای ترکیبی را می فشاریم؟-347

 trl+S -لفا

 Ctrl+F -ب

 Ctrl+N  -ج

 ctrl+O -د

 کنیم؟ گرافیکی کدام گزینه را انتخاب میردن اشیاء و اشکال ک به منظور سه بعدی-348

 Shadow slide -لفا

 D style  -  3 -ب

 Arrow style -ج

 Insert clip art -د

 جهت شماره گذاری اسلایدها چه مراحلی را باید طی کرد؟-349

 Insert/Header and footer/Slide   number -لفا

 View/Zoom -ب

 View/Slide show -ج

 Header and footer/Slide number/ -د

 کدام گزینه برای ایجاد اسلاید در پاورپوینت صحیح است؟-350

 Blank presentation -لفا

 Form design tamplate -ب

 Bullet -ج

 New Slide -د

 در چیدمان اسلاید برای درج..........می باشد.Insert tableاستفاده از دکمه -351

 جدول  -لفا

 لدیف -ب

 رکورد -ج

 نمودار -د

برای چاپ اسلاید از منوی فایل گزینه.......را انتخاب کرده و در پنجره بازشده برای چاپ همه اسلایدها -352

 گزینه........را انتخاب می کنیم؟)از چپ به راست(

 Print/Selection -لفا

 Print / All  -ب

 Print/Current slide -ج

 Print/Custom show -د

 است؟ ام گزینه امکان پذیرکدانتقال اسلاید با عمل -353

 Copy -لفا

 Cut  -ب

 Print -ج

 Delet -د



 چیست ؟ Hide Slideکار گزینه -354

 دیحذف اسلا -لفا

 دیکردن اسلا یمخف  -ب

 دیانتقال اسلا -ج

 دیدرج  اسلا -د

 برای شماره گذاری اسلایدها از کدام گزینه استفاده می شود ؟-355

 Slide   Number -لفا

 Numbering -ب

 Number Slide -ج

 Page Slide -د

 در کدام نما می توان ترتیب اسلاید ها را تغییر داد ؟-356

 notes page -لفا

 normal -ب

 slide   sorter -ج

 slide show -د

 شود؟ اجرای برنامه نمایشی از کدام اسلاید انجام می  from  current  slideبا استفاده از گزینه -357

 د اولیاسلا -لفا

 يد جاریاسلا  -ب

 د آخریسلاا -ج

 یانید میاسلا -د

 از طریق کدام دستور تعداد تکرار صوت مشخص می شود؟-358

 start -لفا

 delay -ب

 speed -ج

 repeat  -د

 کدام یک از مواردزیر،  یک برنامه نمایشی خالی با استفاده ازتنظیمات پیش فرض ایجادمی کند ؟-359

 Autocontent Wizard -لفا

 Template -ب

 Open An Existing Presentation -ج

 Blank   Presentatrion -د

 را چه می نامند؟  power pointفایلهای ایجاد شده در محیط -360

 presentation  -لفا

 book -ب

 document -ج

 chart -د

 مربوط به نمودار باید انتخاب شود ؟با تغییر نوع نمودار در یک اسلاید کدام گزینه از منوی -361

 Chart area -لفا

 Lines -ب

 Chart   Type -ج

 Chart data -د



 با چه دستوری می توان در درون اسلاید یک چهارضلعی ایجاد کرد ؟-362

 Line -لفا

 Oval -ب

 Rectangle  -ج

 Arrow -د

 .......... می شود. هنگام تایپ متن اشاره گر موس تبدیل به-363

                              Curser  -لفا

 پنهان -ب

 دلخواه شکل -ج

 کند ینم يرییتغ -د

 ( چیست؟scroll) پیمایش عمل-364

 شود  یمتن گفته م ییبه عمل  جابجا -لفا

 شود یمتن گفته م یبه عمل  کپ -ب

 دن و رها کردن استیهمان کش -ج

 شود                                        یات  پنجره   گفته  میمشاهده  محتو يوسط  موس  برا  دیبه عمل  چرخاندن کل  -د

 ؟نیستام گزینه کلید تابعی دک-365

 F1 -لفا

 F3 -ب

                        Alt  -ج

 F12 -د

 ؟می شودکدام گزینه شامل کلیدهای کنترلی -366

 Esc Ctrl-Shift-Alt- -لفا

 f12 تا F1 -ب

 Numlock-caps lock-scroll lock -ج

 arrow key -د

 ی کنیم ؟م در ویندوز برای ضبط صدا از کدام نرم افزار زیر استفاده-367

 Cd Player -لفا

 Sound Recorder  -ب

 Enterainment -ج

 Media Player -د

 کدام گزینه صحیح است؟-368

 ت دارد.                یبه حروف کوچک وبزرگ حساسندوز نسبت یکلمه عبور در صفحه ورود به و  -لفا

 رد.یپذ یز میرا ن یتابع يدهایندوز کلیکلمه عبور در صفحه ورود به و -ب

 رد.یپذیندوز فقط حروف را میکلمه عبور در صفحه ورود به و -ج

 ت ندارد.یندوز نسبت به حروف کوچک وبزرگ حساسیکلمه عبور در صفحه ورود به و -د

 مرتب بودن همیشگی آیکن ها از کدام گزینه استفاده می کنیم؟برای -369

 Sort By Name -لفا

 Auto Arrange icons  -ب

 Align To Grid -ج

 Show desktop icons -د



 کدامیک از پرونده های زیر را نمی توان به عنوان تصویر زمینه ویندوز استفاده کرد؟-370

 gif.* -لفا

 bmp.* -ب

 dat.* -ج

 jpg.* -د

 ؟نادرست است Sleepگزینه های زیردرباره  کدامیک از-371

 رد.یگ یوتر در حالت آماده باش قرار مینه کامپین گزیا يک بر رویباکل -لفا

 ابد.ی یبرق کاهش م ين حالت مصرف انرژیادر -ب

 گردد. یبرم يوتر به حالت عادیاحرکت ماوس کامپید ین حالت بازدن کلیدرا -ج

 گردد. یمصرف م يادیم و زمان زیندوز هستیستم ویس يجبور به راه اندازن حالت ما میدرا  -د

 از کدام روش استفاده می کنیم ؟ Folder Optionجهت فعال نمودن -372

 اقدام می نمائیم .               Start | Control Panel | Folder Option ز مسیرا  -لفا

 يدر هر پنجره ا Toolsاستفاده از منوي  -ب

 Desktopبا استفاده از کلیک راست ماوس بر روي  -ج

 File Option -د

عنوان آنها قابل  ارکدام روش مرتب سازی باعث می شود که تمامی پنجره ها روی هم قرارگرفته و تنها نو-373

 مشاهده باشد؟

 SHOW WINDOWS STACKED(ي)به صورت پشته ا -لفا

 SHOW WINDOWS SIDE BY SIDE)به صورت مجاور هم(  -ب

 CASCADE WINDOWS(ي)به صورت آبشار  -ج

 Task Manager -د

ها در یک هانتخاب کدام گزینه باعث می شود تا پوش Generalو تب  Folder Optionدر کادر محاوره ای -374

 پنجره باز شوند؟

 Use Windows Classic Desktop -لفا

 Open Each Folder In The Same Window -ب

 Open Each Folder In Its Own Window -ج

 Enable All Web - Relate Content On My Desktop -د

 ( به چه معنا است؟folderپوشه )-375

 .است لیفا همان -لفا

                      ها برنامه و ها لیفا یسازمانده و ينگهدار يبرا یمحل  -ب

 ها برنامه به حتتررا و عتریسر یدسترس يبرا یکنیآ -ج

 سخت سکید شینما يبرا یکنیآ -د

 به چه معنا است؟ (file)فایل-376

 ند.                              یگو یانه میبه همه اطلاعات موجود در را  -لفا

 ل ها و برنامه هایفا یوسازمانده يرنگهدا يبرا یمحل -ب

 هاعتر و راحتتر به برنامه یسر یدسترس يبرا یکنیآ -ج

 سک سختیش دینما يبرا یکنیآ -د

 های همجوار استفاده می شود؟کدام گزینه برای انتخاب آیتم-377

 Alt -لفا

 Ctrl -ب



 Home -ج

                           Shift  -د

 بینی پیش درمیزکار مختلف اطلاعات آسان و سریع ارائه برای که یکوچک های برنامه 7 ویندوز در-378

 .شوند می نامیده ...... اند،شده

 Taskbar -لفا

 Menu -ب

 Desktop -ج

                           Gadgets  -د

 .گویند..................... کار نوار روی در غیره و بلندگو وضعیت ساعت، نمایش ناحیه به-379

                   Notification -لفا

 Start button -ب

 Gadgets -ج

 Tasks -د

 ای قرار دارند؟های در حال اجرا بر روی چه ناحیهبرنامه-380

                     Taskbar  -لفا

 Menu -ب

 Start -ج

 Gadgets -د

 برای کدام یک از دلایل زیر تهیه نسخه پشتیبان ضروری است؟-381

 اريفزبروز مشکلات سخت ا -لفا

 از دست رفتن اطلاعات -ب

 ه هااجراي کند برنام -ج

 ابیروس ینصب و -د

 برای تهیه نسخه پشتیبان از برنامه  .................  استفاده می شود.-382

 Disk Cleanup -لفا

 Scan Disk -ب

                       Backup  -ج

 Copy Disk -د

 رده سازی استفاده شود؟فشکدامیک از نرم افزارهای زیر می تواند برای -383

 Wordpad -لفا

 Notpad -ب

 Acd See -ج

                     Win Zipو  Win Rar  -د

 برای بستن برنامه های بدون پاسخ کافیست از ترکیب کلید های .................... استفاده نماییم.-384

 Ctrl+alt -لفا

 Ctrl+alt+shift -ب

                     Ctrl+alt+delete  -ج

 Ctrl+shift -د

385-Hibernate .......یعنی 

 شود یگر فراهم مید يندوز با نام کاربری، امکان ورود به ویط کاربر فعلیبدون بستن مح -لفا



 کند. یانه را قفل میرا -ب

 کند. یانه را خاموش میندوز خاتمه داده و رایبندد و به کار ویباز را م يه برنامه هایکل -ج

کند. در صورت روشن کردن  یانه را خاموش میکند و را یره میسک سخت ذخید يدر حال اجرا را بر رو يهاه ه برنامیکل  -د

 دهد.                  یش میرا به همان حالت قبل نما یباز قبل يمجدد، برنامه ها

 ؟می دهدچه کاری انجام  Sleepگزینه -386

 کند.             یم يحافظه نگهدار ردرا  یت فعلیبدون بستن برنامه ها و پنجره ها وضع  -لفا

 شود یگر فراهم مید يندوز با نام کاربری، امکان ورود به ویط کاربر فعلیضمن بستن مح -ب

 کند یانه را قفل میرا -ج

 کند. یم يکند و مجددا راه انداز یانه را خاموش میندوز خاتمه داده و رایبندد و به کار ویباز را م يه برنامه هایکل -د

387-Shut down چیست؟ 

 کند. یم يرا در حافظه نگهدار یت فعلیبدون بستن برنامه ها و پنجره ها وضع -لفا

 شود یگر فراهم مید يندوز با نام کاربری، امکان ورود به ویط کاربر فعلیبدون بستن مح -ب

 کند یانه را قفل میرا -ج

 کند.                           یانه را خاموش میه و راادمه دندوز خاتیبندد و به کار ویباز را م يه برنامه هایکل  -د

 جایی بین پنجره های باز از کلیدهای...... استفاده می کنیم.برای جابه-388

 Alt+f4 -لفا

 Ctrl+Esc -ب

                            Alt+Tab  -ج

 Ctrl+Tab -د

 اده است؟تفویندوز قابل اسکدامیک از فرمتهای فایل زیر برای تصویر زمینه -389

  JPG  -لفا

  Docx -ب

  Pdf -ج

  Dat -د

 تم پیش فرض ویندوز کدام است؟-390

                       Classic Start Menu  -لفا

 Start menu -ب

 Windows Style -ج

 Defaulte Style -د

د کدام انای زمینه، کل صفحه را بپوشبرای اینکه تصویر انتخاب شده بر personalizeدر کادر محاوره ای -391

 باید انتخاب نمود؟ Positionشوی  مورد را از فهرست باز

 Stretch -لفا

 Tile -ب

 Center -ج

 Fill -د

های مخفی باعث می شود تا فایل Folder Optionاز کادر محاوره ای  Viewانتخاب کدام گزینه در تب -392

 مشاهده گردند؟

 Do Not Show Hidden Or System Files -لفا

 Show All Files -ب

 Show Hidden Files And Folder  -ج



 Hide File Extetion For Know File Types -د

 ( را تغییر داد؟Attributesمی توان صفت یک پوشه ) Propertiesاز کدام برگه در پنجره -393

 Sharring -لفا

                          General  -ب

 Customize -ج

 Hidden -د

 ..... می شود .برنامه باعث ...........ن دوبار کلیک بر روی آیک-394

 اجراي برنامه  -لفا

 انتخاب برنامه -ب

 باز شدن منوي میانبر -ج

 افتد ینم یهیچ اتفاق -د

 به عمل حرکت دادن موس در حالی که دکمه سمت چپ آن فشرده است ........... می گویند.-395

 (Click)  کیکل -لفا

 کیراست کل -ب

 ) Drag (دن  یکش  -ج

 (  Double)  کیبارکلدو -د

با انتخاب کدام یک از حالات زیر کامپیوتر در حالت کم مصرف قرار میگیرد و مانیتور و دیسک سخت -396

 خاموش می شوند؟

 Shut Down -لفا

 Sleep  -ب

 Restarting MS-Dos Mode -ج

 Restart -د

 ها باشد؟وارد زیر می تواند جزء خصوصیت فایلکدام یک از م-397

 Archive -لفا

 Read Only -ب

 System -ج

                     Properties  -د

 ؟نیست صحیح هامیانبر مورد در زیر موارد از کی کدام-398

 .شوند یم استفاده ها برنامه عیسر ياجرا جهت -لفا

 .باشند یم فلش علامت کی يدارا انبرهایم -ب

 ند.ینما یجاد میا Desktop  در انبریم کی نصب از پس يبرد کار يها برنامه از یبعض -ج

 با پاک شدن آن برنامه اصلی نیز پاک می شود.                          -د

 است؟ Help-Favorites-View-Fileکدام یک از موارد زیر شامل مواردی مانند  -399

 (Title Barنوار عنوان ) -لفا

 (                     Menuنوار منو )  -ب

 (Address Barنوار آدرس ) -ج

 (Standardوار ابزار )ن -د

 برای بستن پنجره فعال از تر کیب کلید های ...............استفاده می شود؟-400

 Alt+C -لفا

                       Alt+F4  -ب



 Ctrl+C -ج

 Alt+Esc -د

 استفاده می شود؟ Personalizeینه، ازکدام لینک در پنجره برای تغییر طرح زم-401

 Screen Saver -لفا

 Apperance -ب

 Setting -ج

                    Desktop background  -د

 کرد؟ انتخاب را پوشه کی محتوای کل توان می کلید ترکیب کدام با-402

 Alt+C -لفا

 Alt+A -ب

                       Ctrl+A  -ج

 Shift+A -د

 ..... انتخاب نماییم...برای اینکه طرح زمینه انتخاب شده در مرکز صفحه مانیتور را باشد باید ......-403

 Tile -لفا

                      Center  -ب

 Stretch -ج

 Modify -د

سازی را باید  کدام روش مرتب برای نمایش تمام پنجره ها در کنار هم از چپ به راست )بصورت عمودی(-404

 انتخاب نمود؟

              Show Windows side by side  -لفا

 Cascade  Windows -ب

 Show Windows stacked -ج

 Minimal Windows -د

 انتخاب کدام گزینه کامپیوتر را در حالت آماده باش قرار می دهد؟-405

 Shut down -لفا

 Restart -ب

 Switch User -ج

                      Sleep  -د

 را...............گزینه شده باز منوی واز نموده راست کلیک درایو آیکن روی ها درایو خواص مشاهده برای-406

 .کنیم می انتخاب

 Label -لفا

                           Properties  -ب

 View -ج

 Details -د

 کردن داخل آن قرار می گیرد چه نام دارد؟ Cut حافظه موقت مجازی که اطلاعات پس از کپی یا-407

 Copy -لفا

 Paste -ب

 Rom -ج

                            Clipboard  -د

 کنید؟ می انتخاب را مسیر کدام سیستم تاریخ و زمان تنظیم ایبر-408



 Date & Time انتخاب و کار نوار يرو بر راست کیکل -لفا

 Date & Timeو انتخاب  Desktopصفحه  يک راست بر رویکل -ب

 Start/setting/Date&Time -ج

              Control Panel /Date &Time  -د

 .کنیم می استفاده................. گزینه از یشنما صفحه از محافظت برای-409

 Desktop Background -لفا

 Window color -ب

                           Screen Saver  -ج

 Sound -د

 برای چاپ فایلها از.............. استفاده می کنیم.-410

                        File/Print  -لفا

 Edit/Print -ب

 Insert/Print -ج

 View/ Print -د

 گیرد؟ می قرار استفاده مورد ویندوز های پنجره محتویات کدام یک از گزینه های زیر جهت مرور-411

                          Scroll Bar  -لفا

 Menu Bar -ب

 Tool Bar -ج

 Status Bar -د

 چگونه عمل می کنید؟ Desktopجهت فرستادن یک میانبر روی -412

   Desktop(Create Shortcut)نه یو سپس انتخاب گز Send Toنه یو انتخاب گز نکیآ يک رویراست کل -لفا

 Floppyنه یو سپس انتخاب گز Send To  نهیگز انتخاب و کنیآ يرو کیکل راست -ب

  Recipient Mailنهیو سپس انتخاب گز Send Toنه  یکن و انتخاب گزیآ يک رویراست کل -ج

 Mail Recipientنه یو سپس انتخاب گز Send Toنه یگزکن و انتخاب یآ يک رویراست کل -د

 کنیم ؟ یکدام گزینه را انتخاب م  Computerجهت تغییر شکل آیکن -413

 Display -لفا

 Screen Saver -ب

                     Change Desktop Icon  -ج

 Desktop background -د

 کلید معادل فرمان کپی ...........می باشد.-414

                     Ctrl+C  -لفا

 Ctrl+V -ب

 Ctrl+X -ج

 Ctrl+A -د

415-Task Barردد؟به کدام قسمت ویندوز اطلاق می گ 

 پنجره یاصل يمنو ها -لفا

 Desktopن یینوار کار پا  -ب

 تینوار وضع -ج

 نوار مرورگر -د

 شوند؟ داری می اطلاعات حذف شده در کجا نگه-416



 Document  -لفا

 Microsoft Outlook -ب

                     Recycle Bin  -ج

 Cotrol Panel -د

 عبارت است از: ) ازچپ به راست ( پسوند )فرمت( فایلهای صوتی و عکس-417

 Wav-Mpb -لفا

 Doc-Bmp -ب

                   Wav-Bmp  -ج

 Bmp-Doc -د

 کند؟ های پراکنده به ما کمک میکدامیک از دکمه های زیر در انتخاب آیتم-418

 Alt -لفا

                         Ctrl  -ب

 Inc -ج

 Tab -د

419-"Reset" است. کردن همان......... 

 کردن است Turn Off -لفا

 وتریراه اندازي مجدد کامپ -ب

 خاموشمهیانه به حالت نیبردن را -ج

 حالت انتظار است -د

 ( چیست ؟Sceen Saverمنظور از )-420

 يواریکاغذ د -لفا

 ندوزیش ویصفحه نما -ب

 حرکمتش ینما -ج

 ش                    .یمحافظ صفحه نما  -د

 ای می توانیم کلیه درایو ها را مشاهده و مدیریت کنیم؟ورود به چه پنجره با-421

 Computer  -لفا

 Document  -ب

 Network -ج

 Desktop -د

 پسوند )فرمت( فایلهای متنی چیست؟-422

 Txt -لفا

 Wav -ب

 Docx -ج

 Txt & Docx  -د

 ..ی توان ..........م جهت حذف یک فایل-423

 را اجرا نمود View/Deleteک و فرمان یآن کل يبر رو -لفا

 را انتخاب نمود Cutنه ید و گزیل مربوطه و از صفحه کلیفا يکلیک راست بر رو  -ب

 ش درگ نموده و در آنجا رها کردیاز صفحه نما يآن را گوشه ا -ج

 را انتخاب نمود Delete هنید گزیل مربوطه و از صفحه کلیفا يکلیک  بر رو -د

 چه عملی را انجام می دهد؟ Renameفرمان -424



 کردن یکپ -لفا

 لیر فاین مسییتع -ب

 یابیباز -ج

                     ل و پوشه هایمجدد فا ينامگذار  -د

 سازیم؟ ذخیره فایل کی درون را مطالب توانیم می چگونه ویندوز کاربردی های برنامه محیط در-425

 File/Copy -لفا

 Edit/Save -ب

                        File/Save  -ج

 Edit/Exit -د

 کلیپ بورد چیست؟-426

 وتریکامپ یحافظه جانب -لفا

 رد                یگ یکردن درون آن قرار م یوترکه داده ها بعد از کپیاز حافظه موقت کامپ یبخش  -ب

 وتریکامپ یحافظه دائم -ج

 باشد تواند یها م هنیبسته به مورد هر کدام از گز -د

 کنیم.برای مشاهده ظرفیت یک فایل روی آن راست کلیک کرده و  گزینه ................ را انتخاب می-427

 Size -لفا

 Properties  -ب

 Capacity -ج

 Details -د

 در برنامه های ویرایشگر متن برای ایجاد سطر خالی بین دو سطر نوشته شده چه باید کرد؟-428

 میسطر اول بزن يا در انتهار Shiftد یکل -لفا

 میرا بزن Enterبا ماوس خط اول را بلوک کرده و  -ب

 میرا بزن Deleteد یخط اول کل يدر انتها -ج

 میرا بزن Enterد یسطر دوم کل يا ابتدایسطر اول  يدر انتها  -د

 کدام گزینه آیکن های درون پنجره را بر اساس تاریخ آخرین اصلاح مرتب می کند؟-429

 Auto Arrange -لفا

 Name -ب

 Type -ج

 Date Modified  -د

جهت قراردادن سیستم در حالتی که برنامه ها باز بوده ولی سیستم به صورت موقت خاموش گردد، چه -430

 گزینه ای را انتخاب می کنید؟

 Turn Off -لفا

 Standby -ب

 Sleep -ج

 Hibernate  -د

 .....است.کلید معادل فرمان انتقال .........-431

 Ctrl+X  -لفا

 Ctrl+V -ب

 Ctrl+C -ج

 Ctrl+A -د



 اگر محتویات پنجره در فضای پنجره جای نگیرد، باعث ظاهر شدن .........می گردد.-432

 Status Bar -لفا

 Address Bar -ب

 Toolbar -ج

  Scrollbars  -د

 را کرد؟توان به چه روشی آن را اجدر صورت عدم اطلاع از مکان فایل، می-433

 Runدر پنجره  Browseدکمه ز استفاده ا -لفا

 Searchاستفاده از   -ب

 My Computer -ج

 ستین ین کار عملیا -د

 کنیم؟ ازکدام مسیر استفاده می Wordpadبرای قرار دادن تصویر از نرم افزار های دیگر در محیط -434

 View/Object -لفا

 Edit/Object -ب

 Insert/Object  -ج

 File/Object -د

قطع شود و کاربر دیگری وارد سیستم شود بهتر است از کدام  ربر فعلی با کامپیوترکابرای اینکه ارتباط -435

 گزینه استفاده کنیم؟

 Log Offانتخاب   -لفا

 sleepانتخاب  -ب

 Turn Offاز پنجره   down shut انتخاب -ج

 Hibernate -د

 مسیری استفاده می کنیم ؟ از چه Windows Explorerبرای اجرای -436

 Computer رهفقط پنج -لفا

 است یندوز قابل دسترسیو يدر همه پنجره ها  -ب

 Windows Explorerکن یآ -ج

 Cو یق درایفقط از طر -د

مربوط به  Properties ای محاوره کادر در کدام یک از گزینه های زیر نشان دهنده گنجایش کل درایو-437

 دیسک است؟

 Capacity  -لفا

 Type -ب

 Free Space -ج

 Used Space -د

توان در هنگام جستجو بین حروف بزرگ می Word Padافزار در نرم Findخاب کدام گزینه از پنجره انت اب-438

 و کوچک تفاوت قائل شد؟

 Between -لفا

 Advanced -ب

 Case Sensitive  -ج

 During The Previous Day -د

تایپ  جو چگونه بایدست، در کادر جمی شودختم  Sشروع شده و به  M با که حرفیبرای جستجوی فایل سه-439

 کرد؟



 S*M~ -لفا

 M?S~  -ب

 S?M~ -ج

 S*~M -د

 از کادر محاوره ای تنظیمات نوار وظیفه انتخاب کدام گزینه باعث قفل شدن نوار وظیفه می گردد؟-440

 Show Quick Launch -لفا

 Lock the taskbar  -ب

 Auto Hide The Task Bar -ج

 Hide Inactive icon -د

 نها معمولا در کدام منو قرار می گیرد؟ها، آیکن میانبر آه هنگام نصب برنام-441

 Accessories يمنو -لفا

 All Program  -ب

 Accessories ياز منو System يمنو -ج

 File -د

جهت تغییر حاشیه ها، نوع کاغذ و تعیین اندازه کاغذ و نوع کاغذ  Paintک از گزینه ها در نرم افزار کدامی-442

 بکار می رود؟

 Page Setup  -لفا

 Save As -ب

 Print Preview -ج

 Open -د

 ؟انتخاب می کنیم Sort منوی زیر از را مورد کدام شوند، مرتب آنها برای اینکه آیکن ها بر اساس نوع-443

 By Name -لفا

 By Data -ب

 By Item Type  -ج

 Auto Arrange -د

 به منظور تنظیم صدا کدام گزینه صحیح است؟-444

 نوار کار يروا بر صدکن یآ يرو ک بریکل-لفا

 All Program/Accessories/sound recorder -ب

 Computer  -ج

 Setting -د

 شود؟ می کار میز در هاکدام گزینه باعث نمایش یا عدم نمایش آیکن-445

 Auto Arrange -لفا

 Align To Grid -ب

 Date Modified -ج

 Show Desktop Icon  -د

 .......استفاده می شود.ه ...ینگز Startبه منظور سفارشی کردن منوی -446

 Taskbar &start menu Propertiesزکار /یم يک رویراست کل -لفا

 Start/Properties -ب

 Computer  -ج

 Propertiesو انتخاب  Desktop يک راست رویکل -د



 دیگری منتقل شویم کدام گزینه را باید Userبرای اینکه پنجره های فعال بسته نشوند و بخواهیم به -447

 نتخاب کنیم؟ا

 Standby -لفا

 Log Off -ب

 Switch User  -ج

 Restart -د

 .قرار گیرد گزینه .........را انتخاب می کنیم Desktopبرای اینکه تصویر زمینه به صورت کاشی کاری در -448

 Tile  -لفا

 Stretch -ب

 Center -ج

 Position -د

 ستفاده می کنیم؟ا برای اضافه کردن یک زبان دیگر به سیستم از کدام گزینه-449

 Control Panel \ Region And  Language\  Add Language   -لفا

 Setting\Control Panel \mouse -ب

 Control Panel \power option -ج

 Setting\Keyboard \ Language -د

 برای تعیین نحوه نمایش فایلها از کدام گزینه نوار ابزار استفاده می کنیم؟-450

 Forward -لفا

 Back -ب

 View  -ج

 Address -د

 عمل ................ را انجام می دهد. cutفرمان -451

 کپی کردن -فلا

 انتقال دادن -ب

 فراخوانی از حافظه  -ج

 پاک کردن -د

 ؟نداردکدام نرم افزار قابلیت ایجاد فایل را  Windowsدر -452

 notepad -لفا

 Word Pad -ب

 Paint -ج

 Calculator  -د

 از کدام طریق باز می شود؟ Printer پنجره مخصوص نصب-453

 Computer\ Faxes -لفا

 Computer \Printer  -ب

 Document \Printers -ج

 Control Panel \Devices And Printers  -د

 در چیست؟ Applyو  OKتفاوت دکمه های  -454

 شود. ییرات میباعث لغو آن تغ Apply یکند ول ییرات انجام شده را ثبت میتغ Ok -لفا

 بندد. یپنجره را نم ییرات را ثبت ولیتغ Apply یشود ول ییرات را ثبت کرده و بلافاصله پنجره بسته میتغ Ok  -ب

 بندد. ییرات را ثبت و پنجره را میتغ Apply یدارد ول ییرات را ثبت کرده و پنجره را باز نگه میتغOk -ج



 دهند. یک عمل را انجام میهر دو  -د

 .می شودتفاده جدید از گزینه..........اس اربرای اضافه نمودن سخت افز-455

 Control Panel \Devices And Printers  -لفا

 Add\Remove Program -ب

 Folder Option -ج

  Add Hardware نهیو گز Control Panelپنجره   -د

 ویندوز ماهیت چند وظیفه ای دارد به چه معناست؟-456

 دکن اجرا را برنامه يادیز تعداد تواند ینم -لفا

 .کند اجرا همزمان را برنامه يادیز تعداد تواند یم  -ب

 کند رهیذخ یطولان زمان مدت يبرا حافظه در را متعدد فیوظا تواند یم -ج

 کند اجرا هم با یمتن برنامه چند تواند یم فقط -د

 .شود یم استفاده .......................... کلیدهای ترکیب از باز های پنجره بین جاییبهجا جهت-457

 Alt + Esc -لفا

 Ctrl + Z  -ب

 Alt + Tab -ج

 Ctrl + V -د

ختم می شود در کادر جستجو  Sشروع می شود و به  Mبرای جستجوی فایلی که پنج حرفی بوده و با -458

 چگونه باید تایپ نمود؟

 S*M -لفا

 M(S) -ب

 M?S -ج

 M???S~  -د

 کدام است؟ Pasteو  Copyکلید های میانبر فرمان -459

 Ctrl + A   ،Ctrl + Y -لفا

 Ctrl + Y   ،Ctrl + E -ب

 Ctrl +V   ،Ctrl C  -ج

 Ctrl + A   ،Ctrl + V -د

اگر بر روی یک آیکن چپ کلیک را نگه داشته و آن را به سمت دلخواه خود بکشیم و سپس رها کنیم چه -460

 عملی انجام داده ایم؟

 Drag and Drop  -لفا

 Double click -ب

 Right click -ج

 Click -د

 .نماییم می استفاده پنجره کنترل منوی از ...... گزینه از  میزکار در پنجره بجاییبرای جا-461

 Size -لفا

 Move  -ب

 Close -ج

 Restore -د

 باید تایپ نمود؟ Searchبرای جستجوی فایلی صوتی کدام مورد را در برنامه -462

 music.* -لفا



 txt.* -ب

 mp3.* -ج

 jpg.* -د

 گزینه از اند بوده دسترسی قابل ای و شده ایجاد ر ماه گذشته تغییر یافته،د کهجهت جستجوی فایلهایی -463

 نماییم؟ می استفاده .......

 Yesterday -لفا

 Last Month  -ب

 This Month -ج

 Last Week -د

 ....................قرار نگیرد  Recycle Binبرای اینکه اطلاعات حذف شده در -464

 م یدار ین نگه مییرا پا Ctrlد یلدر موقع حذف ک -لفا

 میدار ین نگه مییرا پا Altد یدر موقع حذف کل -ب

 م .یدار ین نگه مییرا پا Shiftد یدر موقع حذف کل  -ج

 ست یر نیامکان پذ -د

برای اینکه نوار وظیفه اتوماتیک آشکارومخفی گردد کدام گزینه را باید  Taskbar Propertiesدر پنجره -465

 نمود؟انتخاب 

 Keep the taskbar on top of other windows -لفا

 Auto hide the taskbar  -ب

 Show Quick launch -ج

 Show the clock -د

 ؟نادرست استکدامیک از گزینه های زیر -466

 کند یندوز را قفل مینوار کار و Lock the taskbar -لفا

 است ستمیس  یاصل ياز پوشه ها Windowsپوشه   -ب

 باشد یندوز میو یا جانبی یفرع يجزو برنامه ها Paint ینقاش ي برنامه -ج

 کند یم یندوز را مخفینوار کار و Lock the taskbar  -د

............... برنامه های کوچکی هستند که عملا به برنامه اجرایی و یا نواحی سیستمی دیسک متصل شده و -467

 د.بر روی آنها اثرات نامطلوب می گذارن

 ییااجر يبرنامه ها -لفا

 روس هایو  -ب

 Binبا پسوند  ییلهایفا -ج

 Comبا پسوند  ییلهایفا -د

 کی از راههای موثر جلوگیری از ورود ویروس به سیستم کدام است؟ی-468

 اب به روزیروس یاستفاده از و  -لفا

 مشکوک يلهایفا حذف -ب

 کباری ساعت هر روسیو ضد يها برنامه ياجرا -ج

 مشکوک ویدرا کردن فرمت -د

 دسترسی پیدا کرد؟ Control Panel پنجره به توان می زیر روشهای از میکادک توسط-469

 Start Menu  -لفا

 Task Bar -ب

 Always On Top -ج



 Auto Hide -د

از طریق کدام گزینه نوار ابزار را جابجا  Task Bar and Star Menu Propertiesدر کادر محاوره ای -470

 می کنیم؟

 Toolbars -لفا

 Taskbar Location on Screen  -ب

 Auto Hide The Task Bar -ج

 Unlock the Taskbar -د

 هنگام نصب برنامه ها، آیکن میانبر آنها معمولا در کدام منو قرار می گیرد؟-471

 Documentاز پنجره  File يمنو -لفا

 All Program يمنو  -ب

 Computerپنجره  از System Tools يمنو -ج

 Computerپنجره  -د

 های زیر باعث نوشته شدن متنی به صورت زیر خط دار می شود؟یک از گزینه م انتخاب کدا-472

 Italic -لفا

 Underline  -ب

 Bold -ج

 Super Scribe -د

 کنیم؟برای اعمال تنظیمات صفحه کلید از چه مسیری اقدام می -473

 Keyboardانتخاب  Control Panelاز پنجره   -لفا

 Keyboardانتخاب  Computer از پنجره  -ب

 Keyboard And Mouseانتخاب    Control Panelاز پنجره  -ج

 Keyboard And Mouseانتخاب    Computer از پنجره  -د

 ( چیست؟Screen Resolutionوضوح صفحه نمایش ) -474

 کیزان حافظه کارت گرافیم -لفا

 شیصفحه نما يکسل هایان تراکم پزیم  -ب

 توریاندازه مان -ج

 شیت صفحه نمایشفاف -د

 یره کردن یک متن با نام جدید چگونه عمل می نماییم؟ذخ تهج-475

 File يدر منو save asاز فرمان   -لفا

 File  يازمنو saveاز فرمان  -ب

 Format يدر منو Fontاز فرمان  -ج

 Edit يدر منو saveاز فرمان  -د

 اکثر تنظیمات سیستم از طریق پنجره .......... قابل انجام است.-476

 Computer -لفا

 Control Panel  -ب

 Document  -ج

 Start -د

 کدام گزینه جهت نمایش آیکن ها با جزئیات بکار می رود؟-477

 Details  -لفا

 Small -ب



 Tile -ج

 Large -د

 ؟کدام یک از جملات زیر صحیح نیست-478

 توانند پسوند داشته باشند یپوشه ها نم -لفا

 ل ها بدون پسوند هستندیفا  -ب

 ندیگو یهم م Documentل یبه فا یگاه -ج

 پوشه همان فولدر است  -د

 اگر بخواهیم نامه رسیده را برای دیگران ارسال کنیم از کدام گزینه استفاده می کنیم؟-479

 Reply -لفا

 Reply To All -ب

 Forwardفرمان  -ج

 Forward To Allفرمان   -د

 : Add To Favoritesهدف  -480

 یاطلاعات يلهایفا یجهت کپ -لفا

 Webره(صفحات ی)ذخ يجهت نگهدار -ب

 یاطلاعات يفهرستها یجهت کپ  -ج

 علاقه مورد يها تیست سایاضافه کردن به ل -د

 ؟ مکنی می استفاده گزینه کدام از وب صفحه کی کردن ذخیره برای-481

 File/Save As  -لفا

 Edit/Save Picture As -ب

 File/Save -ج

 File/Save As Picture -د

 در کدام پوشه قرار دارند؟ Outlook Expressپیغامهای دریافت شده در -482

 Outbox -لفا

 INBOX  -ب

 Sent -ج

 Draft -د

 ؟ لازم نیستبرای برقراری اینترنت کدام تجهیزات -483

 مودم -لفا

 خط تلفن -ب

 نترنتیکد اشتراک استفاده از ا -ج

 کارت صدا  -د

 پسوند یک سایت آموزشی کدام است ؟-484

 Edu  -لفا

 Net -ب

 Mit -ج

 Com -د

 انی صفحه وب از کدام گزینه استفاده می شود؟روز رسب برای-485

 Back -لفا

 Forward -ب



 Refresh  -ج

 Home -د

 معرف چیست ؟ Http، عبارت   Http://Www.Yahoo.Comدر آدرس -486

 Second Level Damain -لفا

 Top Level Domaim -ب

 پروتکل  -ج

 د توسط مرورگر نشان داده شودینام صفحه وب که با -د

 نه های زیر معرف سازمان دولتی  است ؟از دام یککدام -487

 Com -لفا

 Edu -ب

 Gov  -ج

 Org -د

ازتمام سایتهایی راکه در روزهای اخیرمشاهده کرده اید نشان می  فهرستی  IEکلیک بر روی کدام دکمه -488

 دهد؟

 Search -لفا

 Favorites -ب

 Mail -ج

 History  -د

 ره سازی را باید انتخاب کرد ؟خیبرای ذخیره تنها متن های وب کدام نوع  ذ-489

 web Page , Complete -لفا

 Web Art -ب

 Web Page , Html only -ج

 Txt File  -د

چه  Generalدر بخش   Use Currentکلیک بر روی دکمه   Internet Optionدر کادر محاوره ای -490

 عملی انجام می شود؟

 رد .یگ یر منظدر  Home Pageرا به عنوان صفحه  يآدرس صفحه جار -لفا

 دهد . یقرار م  Home Pageار داده شده است را به عنوانقر  Home Pageبعنوان  Ieکه در هنگام نصب  یصفحه وب -ب

 دهد . یقرار م یرا صفحه وب خانگ Blank -ج

 رد .یگ یدرنظر م  Home Pageش فرض را به عنوان صفحه یآدرس صفحه پ  -د

 بر روی کدام  دکمه  باید کلیک کرد ؟ دهبرای برگشتن به صفحه قبلی ملاحظه ش-491

 Refresh -لفا

 Forward -ب

  Back  -ج

 Home -د

 متوقف کنیم چه دکمه ای را از نوار ابزار کلیک می کنیم ؟ IEاگر بخواهیم باز شدن صفحه ای را در -492

 Stop  -لفا

 Refresh -ب

 End -ج

 Back -د

تور جستجو قرار می دهد و نتایج جستجوی موموتور جستجویی که واژه مورد جستجوی شما را در چند -493



 ای شما لیست می کنند چه نامیده می شوند ؟آنها را بر

 Directionary Sites -لفا

 Search Engines -ب

 Meta Search Engines  -ج

 Search Dictionary -د

 کدام یک از نرم افزارهای زیر مرورگر صفحات وب  است ؟-494

 Internet Explorer  -لفا

 Add To Favorites -ب

 Creat In -ج

 Put In -د

 شود ؟ کند چه گفته می سرویس شبکه که امکان ارسال و دریافت نامه را میسر می به-495

 E-Marketing -لفا

 E-Commerece -ب

 E-Mail  -ج

 E-Banking -د

 به فرآیندی که فایلی را از اینترنت بر روی کامپیوترخود قرار می دهیم چه می گویند ؟-496

 Download  -لفا

 Upload -ب

 Upgrade -ج

 Turboload -د

 جهت انصراف از بازدید یک وبسایت در خواست شده از کدام کلید استفاده می کنیم ؟-497

 History -لفا

 Back -ب

 Stop  -ج

 Home -د

 برای حذف سوابق صفحات ویزیت شده از کدام دکمه استفاده می کنیم ؟-498

 Clear Address -لفا

 Clear History  -ب

 Clear Favorites -ج

 Clear  Cookie -د

 برای فراخوانی مجدد صفحه وب کنونی از کدام دکمه استفاده می کنیم ؟-499

 History -لفا

 Refresh  -ب

 Favorites -ج

 Search -د

 دکمه ............ به منظور صرف نظر نمودن از انتقال کامل صفحه وب به کامپیوتر شما می باشد ؟-500

 Stop  -لفا

 Back -ب

 Forward -ج

 Home -د



 انتخاب کدام گزینه ها موجب می شود صفحه خانگی یک صفحه خالی باشد ؟ Internetدرپنجره -501

 Clear History -لفا

 Use Blank  -ب

 Use Default -ج

 Use Current -د

 یم ؟های مشاهده شده قبلی را مشاهده نمای سایت صفحات وب کلیهتوسط کدام گزینه می توانیم -502

 Home -لفا

 Back -ب

 Forward -ج

 History  -د

 کدام یک از نرم افزارهای زیر برای کار با اینترنت لازم است ؟-503

 Internet Explorer  -لفا

 Windows Explorer -ب

 Documents  -ج

 Control Panel -د

 کدام یک از گزینه های زیر به معنی قطع ارتباط با اینترنت می باشد ؟-504

 Disconnect -لفا

 Connect -ب

 Stop -ج

 Shut Down -د

شرکتی که در مقابل دریافت وجه امکان دست یابی به اینترنت را برای مشترکانش فراهم می کند ................ -505

 نام دارد؟

 URL -لفا

 Server -ب

 FIP -ج

 ISP  -د

 چه چیزی را نشان می دهد ؟Historyنوار -506

 (Mediaرسانه ) ينه هایگز -لفا

 ره شدهیآدرس وب ذخ -ب

 (Searchجستجو ) يتمهایآ -ج

 د شده اندیکه قبلا بازد ییتهایوب سا  -د

 نام سایتی که وارد آن شده ایم در کجا مشاهده می شود؟-507

 شود یمشاهده م Downloadsدر  -لفا

 شود یمشاهده م Home pageدر  -ب

 شود یمشاهده م Bookmarksدر  -ج

 شود یوار آدرس مرورگر مشاهده مدر ن  -د

 دهد ؟ زشی بودن سایت را نشان مینه های زیر آموامکدام یک از د-508

 Net -لفا

 Org -ب

 Mil -ج



 Edu  -د

جهت مشخص نمودن سایت های تجاری ،کمپانی، موسسات وسازمانهای تجاری ازدامنه با نام ....... استفاده -509

 میکنیم؟

 Gov -لفا

 Com  -ب

 Net -ج

 End -د

 ؟ نمی باشدکدامیک از مزایای  پست  الکترونیکی -510

 د در مقصد حضور داشته باشد .یغام حتما در حال ارسال نامه بایرنده پیگ  -فلا

 ر است .یامکان پذ یکیالکترون يبه همراه نامه ها يری،تصو یصوت يلهایارسال فا -ب

 باشد . یارزانتر م گرید يس دهنده هاینسبت به سرو ياز نظر اقتصاد -ج

 طرف مقابل. یدوق پسته صنب امینان از انتقال پیب اطمیسرعت بالا و ضر -د

 را بجز COM فشردن کدام یک ازکلیدهای ترکیبی زیرقسمتهای مورد نیاز یک آدرس اینترنتی با پسوند-511

 نماید؟ نام آدرس اضافه می

 Alt + Home -لفا

 Alt + Eter -ب

 Ctrl + Enter  -ج

 Home -د

 ...... از هم جدا شده استت در آدرس پست الکترونیکی نام کاربری و نام سرویس دهنده توسط علام-512

 ! -لفا

 )( -ب

 اسلش -ج

                    @  -د

 کدامیک از موارد زیر جزء احتمالات عدم دسترسی به یک وب سایت نیست ؟-513

 از کار افتاده باشد . ISPنترنت یا -لفا

 ت دچار مشکل شده باشد .یب ساو -ب

 ده باشد .یان رسینترنت به پایاشتراک ا -ج

 تیش از حد در وب سایر بیتصاون داشت  -د

 عملیات بروز رسانی یک صفحه وب مشاهده شده توسط چه ابزاری  امکان پذیر است ؟-514

 در نوار ابزار Backدکمه  -لفا

 در نوار ابزار Historyدکمه  -ب

 F9د یکل -ج

 F5  -د

 زبان استاندارد طراحی صفحات کدام یک از موارد زیر است ؟-515

 Hyper Language -لفا

 Html  -ب

 Http -ج

 word -د

 از کدام سایتها نمی توان استفاده کرد ؟ IEبرای انجام عمل جستجو در اینترنت توسط -516

 Yahoo -لفا



 Googel -ب

 Msn -ج

 Blogfa  -د

 خط تلفن به کدام قسمت کامپیوتر متصل می شود ؟  با اینترنت برای برقراری ارتباط-517

 مودم -لفا

 کارت شبکه  -ب

 کیکارت گراف -ج

 ت صداکار -د

 کار کدام دستگاه به این صورت است: -518

 شود یق خط تلفن ارسال میشود ابتدا اسکن شده و بعد از طر یکه وارد دستگاه م ياغذک

 تلکس -الف

 ISDN -ب

 مودم -ج

 فاکس  -د

 کدام یک از گزینه های  زیر نادرست می باشد؟-519

 کند. یل میا بالعکس تبدیگ الوآن يگنالهایوتر را به سیک کامپیتال یجید يگنالهایمودم س -لفا

 باشد. یم یک شبکه جهانینترانت ، یا  -ب

وسته یباشد که به هم پ یمختلف م يرهااب ، سخت افزار و نرم افزایریوتر ، کابل ، مسیونها کامپیلینترنت ، متشکل از میا -ج

 است.

 ست.ینترنت متصل نیبه ا یشود ول یم داجینترنت ایا ين وپروتکل هایاست که بر اساس قوان ینترانت شبکه خصوصیا -د

 اگر پیوند دو صفحه وب از طریق تصویر یا یک صدا باشد به این پیوند .......... می گویند؟-520

 Hyper Text -لفا

 Hyper Media  -ب

 Hyper Link -ج

 Hyper Sound & Image -د

 ید؟وار ابزارکلیک می نماین بر روی کدام دکمه ازهمه گیرندگان نامه اصلی   برای ارسال پاسخ نامه به-521

 send -لفا

 Reply -ب

 Reply All  -ج

 Forward -د

 شود؟ می مشخص قسمت درکدام )کپی( برای ارسال نامه آدرس گیرنده های اضافی-522

 To -لفا

 From -ب

 CC  -ج

 BCC -د

آدرس آن را در کدام  ، از موضوع نامه مطلع شود یرنده اصلیکه گیگر به طوریک نامه به فرستنده دیارسال رونوشت  يبرا

 د؟یکن یوارد مقسمت 

 To -الف

 CC -ب

 From -ج



 BCC  -د

 ظاهرمی گردد؟ کدام علامت در کنار نامه هایی که با اولویت بالا ارسال بشه-523

 ؟ -لفا

 )( -ب

                              !  -ج

 * -د

 ی شود؟م کلیه نامه هایی که به آدرس شما ارسال می گردد در کدام پوشه ذخیره-524

 Outbox -لفا

 Inbox  -ب

 sent Items -ج

 Drafts -د

 استفاده می شود؟ ……برای ذخیره آدرس و مشخصات افراد از -525

 Address Book  -لفا

 Mail Box -ب

 Sent Items -ج

 Inbox -د

 .است اینترنت ازطریق رایانه و ....در اصل پست الکترونیک نوعی تبادل -526

 انسان -لفا

 نیماش -ب

 نامه -ج

 فرستنده -د

 افتد؟ می اتفاقی چه بنویسیم رااشتباه الکترونیک پست کی اگرادرس-527

 شود یده مام مناسب برگشت داینامه باپ  -لفا

 رود ین مینامه ازب یچ اتفاق خاصیبدون ه -ب

 امیبدون پ یولشود یمکباربرگشت داده ی یمعمول يمانند نامه ها -ج

 ردیگ یقرارم out itemدرپوشه  -د

 ونیک درسایت یاهو ازکدام گزینه استفاده می شود؟ت پست الکتراخبه منظورس-528

 Sign out -لفا

 Check mail -ب

 Create new account  -ج

 Receive -د

 کدام جمله درست است؟-529

 ل منحصربه فرد باشدیمیآدرس ا يپسورد برا -لفا

 ک منحصربه فرداستیک آدرس پست الکترونی  -ب

 جاد کندیل ایمیرس اود آدرخکا يتواند برا ینم یتیچ سایه -ج

 دهد یگان رانمیل رایمیجاد ایامکان ا یتیچ سایه -د

 ایی که به هردلیلی به مقصدارسال نشده اند دارای چه عنوانی هستند؟نامه ه-530

 Re notice -لفا

 Return to back -ب

 Failure notice  -ج



 Failure back -د

 رند؟هوپیغام های ناخواسته درصندوق پستی به چه نامی مش-531

 Noise -لفا

 Spam  -ب

 virus -ج

 e-mail -د

 .است.شامل..........outboxپوشه-532

 افت شده استیدر يست نامه هایل -لفا

 ل نشده استیند ارسال انها تکمیاست که هنوز فرا يست نامه هایل  -ب

 حذف شده است يست نامه هایل -ج

 ارسال شده است يست نامه هایل -د

 یک ازپوشه های زیرذخیره می شود؟به عنوان بایگانی درکدام لیک نسخه ازنامه های ارسای-533

  Sent item -لفا

 Out box -ب

 inbox -ج

 draft -د

 برای آنکه رونوشت یک نامه ازسایر گیرندگان پوشیده بماندکدام گزینه را انتخاب می کنید؟-534

 میکن یواردمccآدرس ان رادرقسمت -لفا

 میکن یواردمbccآدرس آن رادرقسمت  -ب

 میکنیواردمtoس ان رادرقسمتادر -ج

 میکن یموارد fromادرس ان رادرقسمت -د

 کدام برنامه زیر می توان بدون اتصال به اینترنت نامه های خود را در آن نوشت ؟-535

 yahoo -لفا

 Google -ب

 Outlook Express  -ج

 msn -د

536-Reدرsubjectچه معنایی دارد؟ 

 دونش ین علامت مشخص میمشکوک باا ينامه ها -لفا

 دیا یستند میس نکه دردفترچه ادر ییادرس ها ين علامت برایا -ب

 میرا بده يم پاسخ نامه ایشود که بخواه یظاهر م ین علامت زمانیا -ج

 دیا یکه دردفترچه ادرس هستند م ییادرس ها ين علامت برایا -د

 تفاده می کنیم ؟اساگر بخواهیم نامه دریافت شده را برای افراد دیگری بفرستیم از کدام دکمه -537

 Forward  -لفا

 Work offline -ب

 Reply -ج

 Send -د

 بعدازاتمام کار با ایمیل برای بستن صندوق پستی حتما باید گزینه .........رابزنید؟-538

 sign in -لفا

 sign out  -ب

 sign up -ج



 Log out -د

 نامه های نیمه تمام یا ناقص در کدام فولدر نگه داری می شود؟-539

 draft  -لفا

 trash -ب

 inbox -ج

 Send -د

 رود؟ می کار به منظوری چه به (نامه )رایاcreate mailدر پنجره  bccکادر -540

 نامه یاصل رندهیگ یکیالکترون پست آدرس -لفا

 فرستادن رونوشت نامه به صورت محرمانه يبرا  -ب

 ارسال رونوشت نامه يبرا -ج

 تیارسال نامه در اولو يبرا -د

ه گذاری شود )برای یادآوری( که درپنجره لیست نامه ها د توسط شما نشانانهر نامه می تو-541

 باعلامت.....مشخص می شود

 پرچم -لفا

 تعجب  -ب

 سوال -ج

 رهیگ -د

 .................................نامه حذف کنیم آن delete itemنامه ای ازپوشه ی  اگر-542

 ستین یابیقابل باز  -لفا

 است یابیقابل باز -ب

 است خواندنابل ق -ج

 ستیقابل حذف ن -د

 کدام فرمان برای ارجاع پیام دریافت شده به همراه برخی توضیحات به شخص ثالث قابل استفاده است ؟-543

 Reply -لفا

 Reply To All -ب

 Forwardفرمان  -ج

 Forward To Allفرمان   -د

 ......نام دارد. به طور اتوماتیک نمایش داده می شود IEصفحه ای که در هنگام اجرای -544

 Home Page  -لفا

 Start Up Page -ب

 Last Page -ج

 Final Page -د

 کدام یک از نرم افزارهای زیر برای کار با اینترنت لازم است ؟-545

 Internet Explorer  -لفا

 Windows Explorer -ب

 Documents -ج

 Control Panel -د

 چه چیزی را نشان می دهد ؟Historyنوار -546

 (Mediaرسانه ) يها هنیگز -لفا

 ره شدهیآدرس وب ذخ -ب



 (Searchجستجو ) يتمهایآ -ج

 د شده اندیکه قبلا بازد ییتهایوب سا  -د

 جهت مشاهده مجدد صفحات وب ویزیت شده در هفته پیش از چه دکمه ای استفاده می کنیم ؟-547

 History  -لفا

 Back -ب

 Favorites -ج

 Home -د

بخش توسط علامت ...... ازدیگری جدا ا تشکیل شده است و هر جزسایت از چندین بخش مآدرس  یک -548

 شده است؟

 ! -لفا

 )( -ب

 اسلش -ج

  .  -د

 کدام یک از دستگاه زیر ترکیبی از مودم و دستگاه اسکنر می باشد ؟-549

 تلکس -لفا

 ISDN -ب

 مودم -ج

 فاکس  -د

 ؟می شودرکدام  قسمت مشخص در هنگام ارسال نامه، آدرس گیرنده راد-550

 To  -لفا

 From -ب

 C -ج

 Bcc -د

 برای ارسال نامه آدرس گیرنده های اضافی درکدام قسمت مشخص می شود؟-551

 To -لفا

 From -ب

 CC  -ج

 BCC -د

 نامه های پیش نویس درکدام پوشه قرار می گیرد؟-552

 Inbox -لفا

 Out box -ب

 Sent items -ج

 Draft  -د

 .......است...ال فایل ضمیمه دارای محدودیت..................ارس-553

 یل ارسالیحجم فا  -لفا

 یزمان -ب

 یمکان -ج

 سرعت ارسال -د

 کدام یک از گزینه های زیر ازویژگیهای پست الکترونیک نمی باشد؟-554

 و ......باشد. یل صوتیر و فایک متن تا تصویتوان شامل  یم یکیک نامه الکترونی -لفا



 شند.اشته باد حضور يرنده ایشخص گ یکیهنگام ارسال پست الکترون  -ب

 م.یاستفاه کن یکیک نرم افزار پست الکترونیافت نامه از یارسال و در -ج

 ارزان و به صرفه است. یکیارسال نامه به صورت الکترون -د

 ....رابزنید؟بعدازاتمام کار با ایمیل برای بستن صندوق پستی حتما باید گزینه .....-555

 sign in -لفا

 sign out  -ب

 sign up -ج

 Log out -د

 نامه های نیمه تمام یا ناقص در کدام فولدر نگه داری می شود؟-556

 draft  -لفا

 trash -ب

 inbox -ج

 Send -د

 کدامیک از مسیرهای زیر را باید طی کنیم؟ Outlook Expressبرای ایجاد یک نامه در برنامه -557

 create mailنوار ابزار  يک بر رویکل  -لفا

 edit/new/mail message -ب

 file/message/new message -ج

 Edit -د

 )یا نامه( به چه منظوری به کار می رود؟create mailدر پنجره  bccکادر -558

 نامه یرنده اصلیگ یکیآدرس پست الکترون -لفا

 نهفرستادن رونوشت نامه به صورت محرما يبرا  -ب

 ارسال رونوشت نامه يبرا -ج

 تیارسال نامه در اولو يبرا -د

ه نامه از دکمه ی...........در نوار ابزار استاندارد پنجره نامه می توان یا پیوست به همرا مهبرای فرستان ضمی-559

 استفاده کرد.

 Attach  -لفا

 check -ب

 spelling -ج

 Priority -د

 کدام گزینه را انتخاب می کنیم؟برای بازکردن کتابچه آدرس -560

 View/Address -لفا

 Tools/Address book  -ب

 Edit/Message -ج

 Tools/Replay -د

 ؟می شودبرای چه منظوری استفاده Imapپرتکل-561

 لیمیارسال ا -لفا

 لیمیافت ایدر  -ب

 لیمیافت ایارسال ودر -ج

 لیافت فایدر -د

 حذف کنیم ان نامه................................. delete itemاگرنامه ای ازپوشه ی-562



 ستین یابیقابل باز  -لفا

 است یابیقابل باز -ب

 قابل خواندن است -ج

 ستیقابل حذف ن -د

 برای حذف نامه ها می توانیدازچه کلیدی درصفحه کلید استفاده کنید؟-563

 Cntrl+f1 -لفا

 Delete  -ب

 Space -ج

 Ctrl+shift -د

 هرفایل ارائه مطلب از چندین صفحه تشکیل شده است که به هر یک از این صفحات .......می گویند.-564

 هیلا -لفا

 دیاسلا  -ب

 سند -ج

 کاربرگ -د

 هرفایل ارائه مطلب حداقل.......اسلاید دارد.-565

 2 -لفا

 3 -ب

 1  -ج

 4 -د

 مشخصات و نوع فایل را نشان می دهد. بالاترین نوار در نرم افزار نوار..........است که-566

 نوار آدرس -لفا

 نوار عنوان  -ب

 بونیر -ج

 عیسر ینوار ابزار دسترس -د

ه وسیله آن می توان به امکانات لازم برای ی نرم افزار باز می شود که بنوبا کلیک بر روی این دکمه م-567

 مدیریت فایل ها دسترسی پیدا کرد.

 Office -لفا

 File  -ب

 Home -ج

 Options -د

 است.Power Pointاین نوار ابزار شامل دستورات پرکاربرد نرم افزار-568

 نوار عنوان -لفا

 عیسر ینوار ابزار دسترس  -ب

 بونیر -ج

 یکنترل يه هادکم -د

 ریبون شامل تعدادی...........است که در هر یک از آنها تعدادی ابزار مرتبط به هم دسته بندی شده اند.-569

 Tab  -لفا

 Group -ب

 Tools -ج

 Slide -د



 از این نوار برای بستن وکوچک کردن نرم افزار استفاده می شود.-570

 شیماینوار پ -لفا

 عیسر ینوار ابزار دسترس  -ب

 یکنترل يهاکمه د -ج

 دیش اسلایرایه ویناح -د

ن بزرگتر از اندازه ی پنجره است در راستای با استفاده از..........می توانیم اسلاید ها در زمانی که محتوای آ-571

 عمودی و افقی پیمایش کنیم.

 شیمایپ ينوارها  -لفا

 نوار عنوان -ب

 دیش اسلایرایه ویناح -ج

 تینوار وضع -د

 توانیم آن را اصلاح کنیم؟اسلاید فعال می  ازدر کدام ناحیه -572

 ندهیه اضافه کردن نکات گویناح -لفا

 دیش اسلایرایه ویناح  -ب

 نرم افزار يکار يفضا -ج

 د هایست اسلایل -د

قرار دارد. و لیستی از  power point..........به صورت عمودی در سمت چپ یا راست پنجره ی نرم افزار -573

 ایل ارائه مطلب را نشان می دهد.ف اسلاید ها ی موجود در

 دینواراسلا -لفا

 شیماینوار پ -ب

 دیش اسلایرایه ویناح -ج

 تیار وضعنو -د

 از ابزار..........برای بزرگنمایی یا کوچک نمائی اسلاید استفاده می شود.-574

 Zoom  -لفا

 Undo -ب

 Redo -ج

 Save -د

 بل ورفتن به اسلاید بعدی استفاده می شود.ق ابزارهای..........و..........برای بازگشت به اسلاید-575

 Next Slide -لفا

 Previous slide -ب

 Comments -ج

   previous   slide  و   Next   slide -د

 استفاده می شود؟ slideبرای ایجاد..........در قسمت های مختلف  commentsاز ابزار -576

 اداشتی  -لفا

 یسیفرمول نو -ب

 یپاورق -ج

 دیلاش اسیرایو -د

 استفاده می شود. power pointسلاید ها در از نمای.......... برای جابجایی و مدیریت کردن ا-577

 Slide Sorter  -لفا

 Normal -ب



 Reading view -ج

 Slide show -د

از نمای ................. در نرم افزار می توان برای نمایش اسلاید های طراحی شده به شرکت کنندگان در جلسه -578

 ده کرد.فااست

 Slide Sorter -لفا

 Normal -ب

 Reading view -ج

 Slide   show -د

 های طراحی شده می توان استفاده کرد. slideاز نمای........برای خواندن -579

 Normal -لفا

 Slide show -ب

 Reading   view -ج

 Slide sorter -د

 ؟وداز چه کلید های ترکیبی استفاده می ش fileبرای باز کردن منوی -580

 Alt +f  -لفا

 Alt +f1 -ب

 Ctrl +f -ج

 Shift +f -د

 نمی شود؟از کدام یک از گزینه های زیر برای ذخیره کردن فایل ارائه مطلب استفاده -581

 Saveنه یو انتخاب گز File ياز دکمه  -لفا

 عیسر یاز نوار دسترس Saveنهیاستفاده از گز -ب

 Ctrl+ S یبیترک يد هایاستفاده از کل -ج

 Saveنه یگز  Homeبونیر از  -د

 برای تغییر نام کاربر استفاده کننده از نرم افزار، عملیات ....... را انجام می دهیم؟-582

 User nameنه یگز Generalو قسمت  optionsنه یگز fileاز منو دکمه   -لفا

 User nameنه یگز proofingو قسمت  optionsنه یگز fileاز منو دکمه  -ب

 User nameنه یگز Advancedو قسمت  optionsنه یگز fileاز منو دکمه  -ج

 User nameنه یگز languageو قسمت  optionsنه یگز fileاز منو دکمه  -د

 کدام راه برای باز کردن یک فایل ارائه مطلب مناسب است؟-583

 openنه یگز fileاز منو دکمه   -لفا

 saveنه یگز fileاز منو دکمه  -ب

 New نهیگز fileاز منو دکمه  -ج

 shereنه یگز fileاز منو دکمه  -د

 چیست؟ Power pointسریع ترین راه برای باز کردن یک فایل ارائه مطلب در نرم افزار -584

 Ctrl+s -لفا

 Ctrl+m -ب

 Ctrl+o  -ج

 Ctrl+c -د

 کدام گزینه مناسب است؟ Power point 2013جهت خروج از نرم افزار -585

 Alt+F3 یبیترک يد هایکل -لفا



 Exitنه یگز File دکمه -ب

 Ctrl + W یبیترک يدهایکل -ج

 ALT + F4 یبیترک يدهایکل -د

 جدید به سربرگ........ وگروه........ گزینه......... را انتخاب می کنیم؟ Slideبرای ایجاد یک -586

 HOME  >  SLIDE  >  NEW SLIDE  -لفا

 HOME   >   NEW   >   SLIDE -ب

 View   >   SLIDE   >   NEW SLIDE -ج

 DESIGN   >   NEW   >   NEW SLIDE -د

 فشردن چه کلیدهایی است؟ slideسریع ترین راه برای ایجاد یک -587

 CTRL +N -لفا

 ALT +M -ب

 CTRL +M  -ج

 SHIFT +M -د

 ی شود.عنوان و زیر عنوان است استفاده م با قالب از .......به منظور ایجاد اسلاید  slideدر چیدمان -588

 TITLE SLIDE  -لفا

 TITLE AND CONTENT -ب

 SELECTION HEADER -ج

 TITLE ONLY -د

 ها از چیدمان....... برای نگهداری عنوان و نگهداری محتوای غیرمتنی استفاده می شود؟slideدر چیدمان -589

 Title slide -لفا

 Title and content  -ب

 Title only -ج

 Section heather -د

 نوان و نگهداری متن استفاده می شود؟... برای نگهداری ع..ها از چیدمان .. Slideدر چیدمان -590

 Title slide -لفا

 Title and content -ب

 section   header -ج

 Two content -د

 استفاده می شود.این چیدمان شامل یک نگهدارنده عنوان است و معمولا برای اسلاید شروع ارائه -591

 Tow content -لفا

 Comparison -ب

 Title only  -ج

 Title slide -د

 این چیدمان شامل یک نگه دارنده عنوان ویک نگه دارنده متن ویک نگه دارنده غیر متنی است.-592

 Content   with   caption -لفا

 Comparison -ب

 Title only -ج

 Two content -د

 امل یک نگه دارنده تصویر یک نگه دارنده عنوان یک نگه دارنده متن است.این چیدمان ش-593

 Blank -فلا



 Content and caption -ب

 Title only -ج

 Picture   with   caption -د

 و می توانیم به صورت دلخواه طراحی کنیم. نیستاین چیدمان شامل هیچ نگه دارنده ی -594

 Title only -لفا

 Blank  -ب

 Title slide -ج

 Two content -د

 ده کرد؟فابرای انتخاب چند اسلاید از چه دکمه ای میتوان است-595

 م.یکن یک مید کلیآن در پنل اسلا يد بر روید فقط بایک اسلایانتخاب  يبرا -لفا

 م.یکن یک مید مورد نظر کلین اسلاین و آخریاول يرا نگهداشته و رو CRTL ید متوالیانتخاب چند اسلا يبرا -ب

 م.یکن یک میمورد نظر کل ياه دیاسلا يرا نگهداشته و رو Shiftد یکل یر متوالید غیانتخاب چند اسلا يبرا -ج

 م.یکن یک مید مورد نظر کلین اسلاین و آخریاول يرا نگهداشته و رو Shift ید متوالیانتخاب چند اسلا يبرا  -د

 کدام روش برای حذف یک اسلاید مناسب است؟-596

 م.یزن یرا م Eraseنه یم و گزیکن یک مید مورد نظر راست کلیاسلا يد ها رویدر پنل اسلا -لفا

 م.یفشار یبورد را میک Endم و دکمه یکن یک مید مورد نظر کلیاسلا يد ها رویپنل اسلادر  -ب

 م.یفشار یرا م Deleteنه یگز slideو گروه  Homeدر سربرگ  -ج

 م.یفشار یبورد را میک Deleteم و دکمه یکن یک میمورد نظر کل دیاسلا يد ها رویدر پنل اسلا  -د

 نیست؟ام راه مناسب د های کپی و یا بریده  شده کدیبرای چسباندن اسلاید یا اسلا-597

 Pasteنه یو زدن گز Slide sorterا ی Normal يد ها در نمایاسلا یخال يک در فضایراست کل -لفا

 Pasteنه یو انتخاب گز clipboardگروه  Homeرفتن به سر برگ  -ب

 ctrl+v یبیترک يد هایاستفاده از کل -ج

 Replaceنه یو انتخاب گز clipboardوه گر Homeرفتن به سر برگ   -د

در صورتی که بخواهیم تم انتخابی  را روی همه اسلاید ها اعمال کنیم با راست کلیک بر روی تم مورد نظر -598

 گزینه  مناسب است؟کدام

 Apply to all slides  -لفا

 Apply to selected -ب

 Set as  default theme -ج

 Add gallery to quick access toolbar -د

 کدام گزینه مناسب است؟در صورتی که بخواهیم تم های انتخابی  را به عنوان تم پیش فرض تعیین کنیم-599

 Apply to all slide -لفا

 Apply to selected slides -ب

 Set as default theme  -ج

 Add gallery to quick access toolbar -د

های انتخابی اعمال شود کدام گزینه مناسب  Slideبر روی  ط در صورتی که بخواهیم تم انتخاب شده فق-600

 است؟

 Apply to all slide -لفا

 Apply to selected slide  -ب

 Set as default theme -ج

 Add gallery to quick access toolbar -د



نتخاب می ا در صورتی که بخواهیم گالری تم ها به نوار ابزار دسترسی سریع اضافه شود کدام گزینه را-601

 کنیم؟

 Apply to all slide -لفا

 Apply to selected slide -ب

 Add gallery to quick  access  toolbar  -ج

 Set as default theme -د

 برای تغییر رنگ پس زمینه اسلاید از سربرگ ....... گروه ....... و زیر گروه ....... را انتخاب می کنیم؟-602

 Design   >   Variants   >   Colors -لفا

 Design >  Variants > background styles  -ب

 Design   >   Customize   >   format background -ج

 Design   >   Themes -د

 Formatدر صورتی که بخواهیم رنگ پس زمینه با ترکیب دو رنگ متفاوت باشد گزینه ....... را در پنجره ی -603

background فعال می کنیم؟ 

 Slide fill -فلا

 Gradient fill  -ب

 Pattern fill -ج

 Picture and texture fill -د

 چه زمانی استفاده می شود؟ Format backgroundدر پنجره ی  Pattern fillاز گزینه -604

 نهیرنگ پس زم ياستفاده از تک رنگ برا يبرا -لفا

 نهیخاص نرم افزار در رنگ پس زم ياستفاده از الگوها يبرا  -ب

 نهیرنگ پس زم يب دو رنگ متفاوت برایترک يراب -ج

 نهیل دلخواه به عنوان پس زمیر و فایاستفاده از تصو يبرا -د

 به چه منظور استفاده می شود؟ Format backgroundدر پنجره ی  Transparencyخاصیت -605

 نهیر مکان پس زمییتغ -لفا

 نهیت پس زمیر شفافییتغ  -ب

 نهیر رنگ پس زمییتغ -ج

 نهیر ابعاد پس زمییغت -د

 .می توانیم........ Slide masterدر طراحی اسلاید اصلی  در ابزار -606

 م.یل ارائه مطلب را مشخص کنیفا يد ها ینه اسلایت عناصر و پس زمی، موقعيظاهر ينما  -لفا

 د.رو ین در جلسه به کار میحاضر يل ارائه مطلب برایفا يد هایاسلا ینسخه چاپ يالگو یطراح يبرا -ب

 م.یده یل ارائه مطلب مورد استفاده قرار میفا يد هاینکات ارائه دهنده اسلا يظاهر ين نماییتع يبرا -ج

 جاد کردیتوان ا ینم يرییچ تغیه ید اصلیاسلا یدر طراح -د

در طراحی اسلاید ها کدام گزینه برای طراحی الگوی نسخه چاپی اسلاید های فایل ارائه مطلب برای -607

 ه کار می رود؟ب حاضرین در جلسه

 Slide master -لفا

 Master view -ب

 Handout master  -ج

 Note master -د

برای تعیین نمای ظاهری نکات ارائه دهنده ی اسلاید های فایل  master viewکدام یک از ابزارها در گروه -608

 ارائه مطلب مورد استفاده قرار می گیرد؟



 Slide master -لفا

 Note master  -ب

 Handout master -ج

 Master view -د

ازنشانی تمام تنظیمات یک اسلاید استفاده می به منطور ب Slidesگروه  Homeاز این ابزار در سربرگ -609

 شود؟

 Reset  -لفا

 Layout -ب

 Selection -ج

 New slide -د

 برای بخش بندی اسلاید ها استفاده می شود؟ Slideو گروه  Homeاز این ابزار در سربرگ -610

 Reset -لفا

 Layout -ب

 Section  -ج

 New slide -د

 وه برای تنظیمات نوع فونت نوشتاری و سایز و رنگ متن استفاده می شود.از این گر  Homeدر سربرگ -611

 Font  -لفا

 Paragraph -ب

 Drawing -ج

 Editing -د

 به چه منظور استفاده می شود؟ Fontدر گروه  Text shadowاز ابزار -612

 ه داریساجاد متن یا  -لفا

 ر خط داریجاد متن زیا -ب

 یمتن ين کاراکترهایفاصله ب -ج

 یکیگراف يجاد متن هایا -د

تمام تنظیمات مربوط به متن از قبیل رنگ و سایز و فونت متن را به حالت پیش  Fontاین ابزار از گروه -613

 فرض و اولیه برمی گرداند.

 Clear all formatting  -لفا

 Reset -ب

 Text shadow -ج

 Align text -د

 استفاده می شود؟  Paragraphز کدام ابزار گروه برای ایجاد یک لیست علامت گذاری شده ا-614

 Bullets  -لفا

 Numbering -ب

 Right to left text direction -ج

 Arrange -د

 به چه منظور استفاده می شود؟ Change caseازابزار -615

 وچکک این نوشتن متن با حروف بزرگ ییتع يبرا  -لفا

 h2oس ین متن به صورت اندییتع -ب

 (X2متن به صورت توان  ) نییتع -ج



 متن ين کاراکتر هاین فاصله بییتع -د

 کدام ابزار برای ایجاد لیست شماره گذاری مورد استفاده قرار می گیرد.-616

 Bullets -لفا

 Numbering  -ب

 Right to left text direction -ج

 Arrange -د

 به چه منظور استفاده می شود؟  line spacingاز ابزار  -617

 یمتن ين کاراکتر هاین فاصله بییتع -لفا

 یمتن ين تعداد ستون هاییتع -ب

 ن خطوطین فاصله بییتع  -ج

 متن يها ين تراز بندیییتع -د

 برای تعیین جهت متن در کادر متنی استفاده می شود؟ Paragraphاز این ابزار در گروه -618

 Text direction  -لفا

 Text align -ب

 Increase list level -ج

 Decrease list level -د

 می توانیم ....  Convert to smart artبا استفاده از ابزار -619

 میل کنیتبد یرا به کادر اشکال هندس یکادر متن -لفا

 میل کنیر هوشمند تبدیرا به کادر تصاو یکادر متن  -ب

 میل کنیرا به جدول تبد یکادر متن -ج

 میل کنیر تبدرا به کادر نمودا یمتن درکا -د

 در هنگام درج نمودار دو سربرگ وابسته ............. و .......... نیز به سربرگ دستورات نرم افزار اضافه می شود.-620

 Home - insert -لفا

 Home - format -ب

 Design   -   format -ج

 Insert - home -د

 چیست ؟ Findسریع ترین راه برای باز کردن پنجره -621

 Ctrl + F  -فلا

 Ctrl + v -ب

 Ctrl + e -ج

 Alt +ctrl +F -د

 در صورتی که بخواهیم قفط لغات مستقل در کادر جستجو پیدا شوندکدام گزینه را فعال می کنیم ؟-622

 Match case -لفا

 Find whole words only  -ب

 Use wildcards -ج

 Match kashida -د

یافت شده از نظر بزرگی و کوچکی حروف باعبارت مورد جستجو یکسان  ایدر صورتی که بخواهیم عبارت ه-623

 باشد کدام گزینه را فعال می کنیم؟

 Match case  -لفا

 Find whole words only -ب



 Use wildcards -ج

 Match kashida -د

 این گزینه در کادر جستجو عبارتهای کشیده شده را نیز جستجو می کند.-624

 Match case -لفا

 Find whole words only -ب

 Use wildcards -ج

 Match kashida  -د

 از کدام دستور برای جایگزین کردن عبارتی با عبارت دیگر مورد استفاده قرار می گیرد؟-625

 Find -لفا

 Replace  -ب

 Save -ج

 Undo -د

. مراجعه کرده و ابزار را ................ گروه ......... به سربرگ  Replaceبرای استفاده از دستور جای گرینی یا -626

 می کنیم.انتخاب 

 HOME ( EDITING ) REPLACE  -لفا

 INSERT ( EDITING ) REPLACE -ب

 DESIGN ( EDITING ) REPLACE -ج

 EDITING ( HOME  ) REPLACE -د

 است . .................. و ................کلید های ترکیبی  Replaceسریع ترین راه برای فراخوانی دستور -627

 Ctrl + F -لفا

 Ctrl + w -ب

 Ctrl +h  -ج

 Ctrl + r -د

 در صورتی که بخواهیم عنصری در یک اسلاید انتخاب شود کدام گزینه مناسب تر است ؟-628

 Select -لفا

 Select all -ب

 Select object  -ج

 Select pane -د

 به چه منظور استفاده می شود؟ Selection paneاز ابزار -629

 کردن آن یا مخفیک نگهدارنده ی ابانتخ  -لفا

 د هایاتنخاب کل متن اسلا -ب

 دیک عنصر از اسلایانتخاب  -ج

 ریاتنخاب تصاو -د

 برای ایجاد یک جدول با تعداد سطر و ستون دلخواه کدام گزینه را انتخاب می کنیم؟-630

 Insert table  -لفا

 Draw table -ب

 Excel spread sheet -ج

 Table -د

 دستی طراحی کنیم کدام گزینه را انتخاب می نماییم ؟ واهیم جدولی رابخدر صورتی که -631

 Insert table -لفا



 Draw table  -ب

 Excel spread sheet -ج

 Table -د

کنیم کدام گزینه  Power pointافزار  وارد نرم Excelدر صورتی که بخواهیم جدولی را از محیط نرم افزار -632

 را انتخاب می کنیم؟

 Insert table -لفا

 Draw table -ب

 Excel spread sheet  -ج

 Table -د

 درصورتی که بخواهیم یک تصویری از اینترنت وارد اسلاید کنیم کدام ابزار مناسب است؟-633

 Pictures -لفا

 Online   pictures -ب

 Screen shot -ج

 Photo album -د

 گیرد؟ میاز کدام ابزار برای ایجاد یک آلبوم تصاویر مورد استفاده قرار -634

 Pictures -لفا

 Online pictures -ب

 Screen shot -ج

 Photo   album -د

 کدام گزینه برای اضافه کردن اشکال هندسی مناسب است؟-635

 Shapes  -لفا

 Smart Art -ب

 Chart -ج

 Hyper link -د

 جهت اضافه کردن تصاویر گرافیکی هوشمند استفاده می شود؟  insertکدام ابزار در سربرگ -636

 Shapes -فلا

 Smart   Art -ب

 Chart -ج

 Hyper link -د

 جهت اضافه کردن نمودار استفاده می شود؟  insertکدام ابزار در سربرگ -637

 Shapes -لفا

 Smart Art -ب

 Chart  -ج

 Hyper link -د

 جهت درج یادداشت  بر روی اسلاید ها مناسب است ؟  insertکدام ابزار در سربرگ -638

 Word art -لفا

 Header and footer -ب

 Text box -ج

 Comment  -د

 جهت درج یک محل تایپ متن بر روی اسلاید ها مناسب است ؟  insertکدام ابزار در سربرگ -639



 Word art -لفا

 Header and footer -ب

 Text box  -ج

 Comment -د

 ست ؟ا جهت درج سر صفحه و پا صفحه بر روی اسلاید ها مناسب  insertکدام ابزار در سربرگ -640

 Word art -لفا

 Header   and   footer -ب

 Text box -ج

 Comment -د

 به چه منظور استفاده می شود؟ Word artاز ابزار -641

 یکیر گرافیجاد تصاویا -لفا

 یکیجاد متن گرافیا  -ب

 ادداشتیجاد یا -ج

 جاد سر صفحه و پا صفحهیا -د

 ؟به چه منظور استفاده می شود Date and timeاز ابزار -642

 خ و زمانیدرج تار  -لفا

 یکیدرج متن گراف -ب

 ادداشتیدرج  -ج

 درج سر صفحه و پا صفحه -د

 تفاده می شود؟به چه منظور اس slide numberاز ابزار -643

 ریدرج تصو -لفا

 درج اشکال هوشمند -ب

 دیدرج شماره اسلا  -ج

 خ و زمانیدرج تار -د

 .……به منظور objectاز ابزار -644

 ر مرتبطیغ ينرم افزار ها يل هایل فایسک سخت از قبیاز داخل حافظه د  ییل هایدرج فا  -لفا

سک سخت قرار ید يل بر رویجاد شده اند و به صورت فایتال ایجید ين هایکه توسط نرم افزار ها و دورب يریدرج تصاو -ب

 دارند

 يو سه بعد یکیدرج متن گراف -ج

 درج نمودار -د

 قرار می گیرد. رج..... مورد استفادهد در نرم افزار برای symbolاز ابزار -645

 ژهیم ویدرج کاراکتر ها و علا -لفا

 یاضیدرج معادلات ر -ب

 ریدرج تصاو -ج

 یج اشکال هندسدر -د

 .. مورد استفاده قرار می گیرد.…در نرم افزار برای درج equationاز ابزار -646

 ژهیم ویدرج کاراکتر ها و علا -لفا

 یاضیدرج معادلات ر  -ب

 ریاوتصدرج  -ج

 یدرج اشکال هندس -د



 گیرد از این ابزار برای درج ویدیو از طریق اینترنت به اسلاید مورد استفاده قرار می-647

 Picture -لفا

 Online   video -ب

 Text box -ج

 Audio -د

 از این سربرگ برای طراحی اسلاید ، تنظیم رنگ پس زمینه ،و سایز اسلاید وغیره استفاده می شود.-648

 Transition -لفا

 Insert -ب

 Design  -ج

 Home -د

 ی شود.. جهت انتخاب حالت های عبور اسلاید استفاده م…از سربرگ-649

 Transition  -لفا

 Insert -ب

 Design -ج

 Home -د

پیش نمایشی از حالت های عبور انتخاب شده در اسلاید موردنظر   transitionدر سربرگ  ……از ابزار-650

 مشاهده می شود؟

 Timing -لفا

 Effect option -ب

 Transition to this slide -ج

 Preview  -د

.. گزینه ……اسلاید صدای مورد نظر خودمان را اضافه کنیم از ابزار Transition در صورتی که بخواهیم به-651

 .. را انتخاب می کنیم……

 Sound ( other sound  )-لفا

 Audio ( other audio) -ب

 Sound ( loop unit next sound) -ج

 Audio ( loop unit next sound) -د

شدن  يد که پس از سپریف کنیبرنامه تعر يد برایتوانیم timingگروه  transitionنه در سربرگ ین گزیبا انتخاب ا-709

 برود. يد بعدیمدت زمان مشخص شده  به صورت خودکار به اسلا

 Apply to all -الف

 After  -ب

 Sound -ج

 Duration -د

 می شود.بر روی عناصر دیگر اسلاید ها استفاده  Animationدن برای کپی کر اراز این ابز-652

 Trigger -لفا

 Start -ب

 Animation pane -ج

 Animation painter  -د

 چیست؟ Animationدر سربرگ  Startعملکرد گزینه -653

 کند یشن را مشخص میمینحوه آغاز شدن ان  -لفا



 کند یمشخص ما ر Animationا کاهش زمان پخش یش یافزا -ب

 ر انداخت.یرا به تاخ Animationتوان پخش  یبا درج زمان مورد نظر م -ج

 کند یمشن را پخش یمیان -د

 را نشان می دهد؟ Animationکدام یک از ابزار های زیر طول مدت زمان نمایش -654

 Trigger -لفا

 Start -ب

 Duration  -ج

 Delay -د

 شود؟ نیمیشن میدر کادر عددی آن موجب تاخیر در نمایش ای کدام یک از ابزار های زیر با مقدارده-655

 Trigger -لفا

 Start -ب

 Duration -ج

 Delay  -د

را   Startدرصورتی که بخواهیم انیمیشن ایجاد شده بر روی عنصر با کلیک ماوس اجراشود کدام گزینه از -656

 انتخاب می کنیم؟

 Start -لفا

 With previous -ب

 On click  -ج

 After previous -د

ایجاد شده بر روی عنصرهمراه با انیمیشن قبل از خود اجراشود کدام گزینه درصورتی که بخواهیم انیمیشن -657

 را انتخاب کنیم ؟

 Start -لفا

 With previous  -ب

 On click -ج

 After previous -د

راشود کدام گزینه اجدرصورتی که بخواهیم انیمیشن ایجاد شده بر روی عنصر بعد ازانیمیشن قبل از خود -658

 م؟انتخاب می کنی

 Start -لفا

 With previous -ب

 On click -ج

 After previous  -د

 سریع ترین روش برای نمایش اسلاید ها از اسلاید نخست چیست ؟-659

 F5  -لفا

 Shift + F5 -ب

 Ctrl + F5 -ج

 Alt + F5 -د

 ه می شود.اداز این ابزار به منظور نمایش اسلاید ها از اسلاید جاری استف-660

 Present online -لفا

 From beginning -ب

 From current slide  -ج



 Custom slide show -د

 می توانیم به ایجاد یک اسلاید شو سفارشی بپردازیم. slide showبا استفاده از این ابزار در سربرگ -661

 Present online -لفا

 From beginning -ب

 From current slide -ج

 Custom slide show  -د

 کدام یک از ابزارهای زیر به منظور دسترسی به تنظیمات اسلاید و نمایش آنها استفاده می شود؟-662

 Set up slide show  -لفا

 From beginning -ب

 From current slide -ج

 Custom slide show -د

 می شود . از این ابزار برای مخفی کردن اسلاید ها در حالت نمایش استفاده-663

 Hide slide  -فلا

 Setup slide show -ب

 Record slide show -ج

 From current slide -د

 کدام یک از ابزار های زیر به منظور زمانبندی هر انیمشین و اسلاید به کار می رود؟-664

 Hide slide -لفا

 Setup slide show -ب

 Record slide show -ج

 Rehearse timing  -د

 به چه منظور استفاده می شود؟ start recording from beginningز ابزار ا-665

 د هایاسلا يضبط صدا بر رو -لفا

 دین اسلاین تا آخریاول يضبط صدا بر رو  -ب

 يجاد زمانبندیا -ج

 صدا یکنترل يش دکمه هاینما -د

 غلط هایی برطرف کردن در صورت وجود غلط های املایی در متن اسلاید ها کدام یک از روش ها برا-666

 ناسب است؟م املایی

 واژه اشتباه يبر رو Double Click -لفا

 Grammerنه یگز Reviewسربرگ  -ب

 spellingنه یگز Reviewسربرگ  -ج

 translateنه یگز Reviewسربرگ   -د

 برای نمایش خطوط راهنما و شبکه ای کدام گزینه ها رافعال می کنیم ؟-667

 Ruler - grid line -لفا

 Grid line- guides  -ب

 Ruler- guides -ج

 Note- Ruler -د

 کدام یک از ابزار های زیر ابعاد اسلاید را هم اندازه صفحه نمایش می کند؟-668

 Fit to window  -لفا

 Zoom -ب



 New window -ج

 Switch window -د

 دسی ترسیم شده کمک می کند؟از ابزار های زیر کدام یک برای جا به جا کردن ترتیب شکل هن-669

 Arrange  -لفا

 Quick styles -ب

 Shape outline -ج

 Shape effect -د

 به چه منظور استفاده می شود؟ arrangeگروه  formatدر سربرگ   Rotateابزار -670

 چرخش عناصر  -لفا

 عناصر يتراز بند -ب

 گروه کردن عناصر -ج

 ر ابعاد طول و عرضییتغ -د

  printیم کدام گزینه را در پنجره  کنرتی که بخواهیم تمام اسلاید های فایل ارائه مطلب را چاپ در صو-671

 انتخاب می کنیم ؟

 Print all slide  -لفا

 Print selection -ب

 Print current slide -ج

 Custom range -د

صفحه چاپ شوند کدام گزینه از در صورتی که بخواهیم در هنگام چاپ اسلاید، اسلاید ها به صورت تمام -672

 م؟را برمی گزینی print layoutکادر 

 Handouts -لفا

 Outline -ب

 Note pages -ج

 Full page slides  -د

در صورتی که بخواهیم اسلاید های فایل ارائه مطلب همراه بانکات آن چاپ شود کدام گرینه را انتخاب می -673

 کنیم ؟

 Handouts -لفا

 Outline -ب

 Note pages  -ج

 Full page slides -د

 تخاب می کنیم ؟ر اسلاید چاپ شود کدام گرینه را انه در صورتی که بخواهیم فقط متن های-674

 Handouts -لفا

 Outline  -ب

 Note pages -ج

 Full page slides -د

 نمی باشد؟کدام یک از گزینه های زیر از مزایای کامپیوتر -675

 ت بالاسرع -لفا

 نان بالایب اطمیضر -ب

 گسترده يقدرت ثبت اطلاعات در حجم ها -ج

 بالا يب خطایضر  -د



 ام گزینه یک کامپیوتر شخصی محسوب می شود؟دک-676

 Desktop  -  Laptop -لفا

 mainframe -ب

 mini computer -ج

 super computer -د

 کدام یک از تعاریف زیر به نظر شما درست ا ست ؟-677

 حمل هستند . قابل    Laptop   يها کــامپیوتر -فلا

 تشکیل شده ا ند . Laptop يوترهایامپک نسبت به ياز اجزاي کوچکتر Desktop يوترهایکامپ -ب

 ستند .یقابل حمل ن  Laptopکامپیوتر هاي  -ج

 است. Minicomputer ینوع PC -د

 .شوند می اطلاق ............... به نتیجه پردازش داده ها -678

 Information -لفا

 Data  -ب

 نرم افزار -ج

 عامل يستمهایس -د

 مخفف چه کلماتی است؟ Pcواژه -679

 Personal   Computer -لفا

 PresetComputer -ب

 Processing -ج

 PrimaryComputer -د

 است؟ Informationکدام یک از تعاریف زیر مصداق کلمه -680

 شود . یم  د یتول داده ها  از پردازش   پس که   ییها یبه خروج -لفا

 خام يداده ها -ب

 شوند یستم مید وارد سیکه توسط صفحه کل یمطالب -ج

 است لیهمان فا -د

681-Cpu مخفف چه کلماتی است ؟ 

 Unit  Control  Processing -لفا

 Cd   Processing  Unit -ب

 Central Processing Unit  -ج

 Cache  Processing  Unit -د

 هر مگابایت معادل چندبایت است؟-682

  1024  *  1024 -لفا

 1024*1024*1024 -ب

 1000 -ج

 1024*1024*1024*1024 -د

 ف صحیح  می باشد؟ریکدام یک از تعا-683

 کمتر است . یاز حافظه جانب یسرعت حافظه اصل -لفا

 کسان است .ی یو اصل یره در حافظه جانبیت ذخیظرف -ب

 ت آن کمتر است .یظرف یشتر ولیب یاز جانب یلسرعت حافظه اص -ج

 است . یکمتر از حافظه اصل یجانب يت حافظه هایظزف -د



 ست؟ا صحیح Romکدام گزینه در مورد حافظه -684

 دار است .یو پا یفقط خواندن  -لفا

 دار است .یو ناپا یفقط خواندن -ب

 دار است .یوناپا یفقط نوشتن -ج

 ت .دار اسیوپا یفقط نوشتن -د

685-Cpu از چه قسمتهایی تشکیل شده است ؟ 

 واحد کنترل -واحد محاسبه و منطق -حافظه پنهان -یحافظه اصل -لفا

 یواحد خروج - یه اصلفظحا -حافظه پنهان -واحد کنترل  -ب

 ثباتها و حافظه پنهان -واحد کنترل  -واحد محاسبه و منطق  -ج

 یحافظه اصل -یواحد خروج -حافظه پنهان -يواحد ورود -د

 هر کیلو بایت معادل چند بایت است؟-686

 128 -لفا

 512 -ب

 1000 -ج

 1024 -د

 شود؟ی برای انتقال تصاویر به حافظه کامپیوتر از چه دستگاهی استفاده م-687

 Mouse -لفا

 Scanner -ب

 joystick -ج

 keyboard -د

 کامپیوتر های شخصی از کدام نوع کامپیوترها هستند؟-688

 Mini Computer -لفا

 Supper Computer -ب

 Main Frame Computer -ج

 Micro Computer  -د

 صحیح می باشد؟ DVDکدام یک از گزینه های زیر در مورد -689

 بانیپشت نوار -لفا

 تالیجید ییویدیو سکید  -ب

 نرم سکید -ج

 سخت سکید -د

 شود؟ می اطلاق یچیز چه به سیلندر ای استوانه دیسک، سطح بندی تقسیم در-690

 کسانیار ها با شعاع یاز ش يمجموعه ا  -لفا

 يسک چند صفحه ایک دیهم شماره در  ياز قطا ع ها يمجموعه ا -ب

 ستندین ک شعاعی يسک سخت که دارایاز د ییارهایمجموعه ش -ج

 ند که به شکل استوانه هستندیگو یسخت م يسکهایبه د -د

 برای اتصال دفاتر یک سازمان در یک شهرصورت می گیرد ؟ کدام یک ازشبکه های زیر معمولاً-691

 man  -لفا

 Lan -ب

 wan -ج

 نترنتیشبکه ا -د



 ؟ دکدامیک از موارد زیر برای نگهداری اطلاعات به صورت موقت یا دائم استفاده می شو-692

 واحدکنترل -لفا

 منطق و واحدمحاسبه -ب

 واحدحافظه -ج

 يمرکز واحدپردازش -د

 به چه صورت است ؟ Ram  حافظه در اطلاعات به دسترسی-693

 یبیترت -لفا

 یتصادف  -ب

 موازي -ج

 يسر -د

 حافظه فلش یک دستگاه ...................است؟-694

 يورود -لفا

 یخروج/يورود  -ب

 یخروج -ج

 حافظه -د

 شود؟ می تقسیم................ نام به مساوی قسمتهای به شیار هر سکدی درسطح-695

 لندریس -لفا

 VGA-ب

 شکاف توسعه -ج

 قطاع  -د

 . باشند می .................... دستگاههای جز کدام هر بلندگو - کلید صفحه-696

 یخروج- يورود-لفا

 يورود-يورود -ب

 یخروج-یخروج -ج

 يورود -یخروج -د

 :ای دیگر خدمات ا رائه می دهندامپیوتر همحیط شبکه به ک دررایانه ای که -697

 نالیترم -لفا

 ســرور -ب

 Client-ج

 Node -د

 شود. به شبکه های بی سیم ......گفته می-698

 SATELLITE -لفا

 WIRELESS -ب

 NETWORK -ج

 LNB -د

 کدامیک از گزینه های زیر به معنی شبکه می باشد؟-699

 LNB -لفا

 WIMAX -ب

 Network  -ج

 WIRELESS -د



 کدام یک از دستگاههای زیر جهت چاپ نقشه های فنی مهندسی به کار می رود؟-700

 اسکنر -لفا

 پلاتر  -ب

 نتریپر -ج

 چاپگر -د

 کوچکترین عنصر صفحه نمایش چه نام دارد ؟-701

 Pixel  -لفا

 Pin -ب

 Dots -ج

 کاراکتر -د

 ؟نیستکدام یک دلیل استفاده از حافظه ثانویه در کامپیوتر -702

 گریک نقطه به نقطه دیال اطلاعات از نتقا -لفا

 هیثانو ير فرار بودن اطلاعات در حافظه هایغ -ب

 هیحافظه ثانو يت بالایظرف -ج

 هیثانو يحافظه ها يسرعت بالا -د

 کدام یک از حافظه های زیر قابل برنامه ریزی وقابل پاک شدن با اشعه ماوراء بنفش است؟-703

 Rom -لفا

 Prom -ب

 Eprom  -ج

 Eeprom -د

 در دستگاههای زیر چند دستگاه خروجی وجود دارد؟ -704

 بلندگو(-يقلم نور  -اسکنر   -چاپگر  -رسام -ماوس -بورد یک -شیصفحه نما)

 3 -الف

 4  -ب

 5 -ج

 2 -د

 هارد دیسک از نظر روش دستیابی به اطلاعات جزء کدام گروه است؟-705

 میمستق یابیدست -لفا

 یصادفت یابیدست -ب

 یبیترت یابیدست -ج

 یانتخاب یابیدست -د

 کدام یک از حافظه های زیر محل ذخیره موقت اطلاعات است؟-706

 Rom -لفا

 Ram  -ب

 Prom -ج

 Eprom -د

 ؟نیست کدام یک از گزینه های زیر جزء حافظه های جانبی -707

 یسیسک مغناطیهارد د -لفا

 یفلاپ -ب

 Rom  -ج



 یسینوار مغناط -د

 ؟نیستکدام یک جزء نرم افزارهای سیستم -708

 ستم عاملیس -فلا

  يکاربرد  يبرنامه ها -ب

 سودمند يبرنامه ها -ج

 مترجمها -د

 اصلی ترین نرم افزار در کامپیوتر ..................... است.-709

 عامل ستمیس -لفا

 يکاربرد يبرنامه ها -ب

 مترجمها -ج

 یسیبرنامه نو يزبانها -د

فظه ای استفاده می کند و سیستم عامل را لود حاکامپیوتر هنگام بالا آمدن از اطلاعات ذخیره شده از چه -710

 کند؟ می

 Ram  -لفا

 Prom -ب

 CMOS -ج

 EPROM -د

 تر است ؟ دسترسی به اطلاعات از طریق کدام روش سریع-711

 یبیترت -لفا

 به نوع حافظه دارد یبستگ -ب

 میمستق  -ج

 کند ینم یفرق -د

 ؟نیست CPUکدام یک جزء اجزای داخلی -712

 ثبات -لفا

 نهاحافظه ن -ب

 Ram  -ج

 واحد کنترل -د

 به عهده کدام قسمت است ؟ CPUکنترل داده ها  در  -713

 Alu -لفا

 Cu  -ب

 Cache -ج

 ثبات -د

 اطلاعات چیست ؟-714

 م .یکن یوتر میپردازش وارد کامپ يکه برا ییفاکتور ها -لفا

 رد .یگ یداده ها انجام م يکه بر رو یاتیعمل -ب

               رد .یگ یجام مانکه از پردازش داده ها  يجه اینت  -ج

 میده یبه کامپیوتر م يکه از دستگاه ورود ییدادها -د

 کامپیوتر های یک دفترکار از چه شبکه ای استفاده می کنند ؟-715

 Wan -لفا

 Lan  -ب



 Man -ج

 Yahoo -د

 م یک از سیستم عاملهای زیر تک کاربره است؟کدا-716

 Singl  User -لفا

 DOS -ب

 Windows Xp -ج

 Windows -د

 کدام گزینه تعریف سخت افزار است؟-717

 ستم کامپیوتریک سی وقابل لمس یکیزیف ياجزا -لفا

 ستم کامپیوتریک سی یاطلاعات ياجزا -ب

 برنامه ها -ج

 سکیهارد د -د

 از راست به چپ(ی با دسترسی تصادفی و ................حافظه ای فقط خواندنی می باشد.)........حافظه ا-718

 Rom   و   Ram -لفا

 Cacheو   Rom -ب

 Ramو    Rom -ج

 VCDو   DVD -د

 کدام یک از چاپگرهای زیر از نظر کیفیت از بقیه بالاتر است؟-719

 يزریل -لفا

 یحروف -ب

 یسوزن -ج

 جوهر افشان -د

 سرعت کدام حافظه بیشتر است ؟-720

 Ram  -لفا

 Hard -ب

 Cd Rom -ج

 DVD -د

 ق از بین می رود؟براطلاعات کدام یک از حافظه های زیر در نبود -721

 Rom -لفا

 EEPROM -ب

 Cd -ج

 Ram  -د

 در کدام یک از موارد روش دسترسی به اطلاعات ترتیبی می باشد؟-722

 سکیهارد د -لفا

 سکید یفلاپ -ب

 یسیمغناط نوار -ج

 Ram -د

 می شود.ه به ورودی های یک سیستم کامپیوتری .................... و به خروجیهای آن ....................گفت-723

 softwareنرم افزار  -Hardwareسخت افزار  -لفا

 information   اطلاعات - Data    داده  -ب



 Dataداده  - Informationاطلاعات  -ج

 میان افزار - Hardwareت افزار سخ -د

این تعریف مربوط به کدام گزینه زیر می باشد؟) کلیه برنامه ها و دستورالعمل هایی که  باعث -724

 یستم می شود (دسعملکر

 Hard Wareسخت افزار  -لفا

 Software   نرم افزار -ب

 Processپردازش  -ج

 Input يورود -د

 نیاز است ؟ Bitرف(چند برای ذخیره سازی یک کارکتر)ح-725

 1 -لفا

 4 -ب

 8  -ج

 16 -د

 برای خرید یک چاپگر کدامیک از گزینه های زیر بهترین ملاک برای انتخاب است؟-726

 ت چاپیفیک و سرعت -لفا

 ت چاپیفیمارک دستگاه و ک -ب

 وزن و مارک دستگاه -ج

 مارک دستگاه -د

727-1kb معادل چند بایت است ؟ 

 بایت 1000 -لفا

 بایت 8 -ب

 بایت 1024 -ج

 بایت 256 -د

 کدامیک از دستگاه های زیر خروجی است؟-728

 صفحه کلید -لفا

 چاپگر -ب

 اسکنر -ج

 ماوس -د

 ؟ است رکدام یک از حافظه های زیر ناپایدا-729

 Ram  -لفا

 Rom -ب

 Hard -ج

 Cd - Rom -د

 کدامیک از گزینه های زیر شبکه محلی است ؟-730

 Wan -لفا

 Man -ب

 Internet -ج

 Lan  -د

731-CPU  ؟ نمی باشدشامل چه قسمتهایی 

 واحد کنترل -لفا



 يورود   واحد -ب

 ثبات -ج

 ALU -د

 ت؟اسکدام یک از موارد زیر برای ذخیره سازی دائم اطلاعات مناسب -732

 هیثانو حافظه  -لفا

 یحافظه اصل -ب

 يواحد ورود -ج

 یواحد خروج -د

 های زیر از نظر قدرت پردازش ضعیف تر است ؟ کدام یک کامپیوتر-733

 Main Frame computer -لفا

 super computer -ب

 micro computer -ج

 Mini computer -د

 رجیستر به چه معناست ؟-734

 CPU  داخل در  کوچک حافظه -لفا

 ندیرا گو یجانب افظهح -ب

 ندیکامپیوتر را گو یحافظه اصل -ج

 ندیبزرگ را گو اریت بسیحافظه با ظرف -د

 اطلاعات در حافظه کامپیوتر بصورت .....................ذخیره می شوند.-735

 مالیدس -لفا

 مالیهگزا دس -ب

 اکتال -ج

 ينریبا -د

 از چند بایت تشکیل شده است؟ Wordک  ی-736

 تیک بای -لفا

 تیاب 4 -ب

 تیبا 3 -ج

 تیبا 2  -د

 شود؟ می تفادهاس به چه دلیل از حافظه های جانبی-737

 برق قطع هنگام یفرع يها حافظه يمحتوا شدن پاک -لفا

 یاصل يها حافظه بودن ارزان -ب

 هنگام قطع برق ram حافظه يمحتوا شدن پاک -ج

 هنگام قطع برق rom حافظه يمحتوا شدن پاک -د

 عات از پرتو لیزر استفاده می شود؟ا برای دسترسی به اطلاکهدر کدام نوع از دیس-738

 سکید یفلاپ -لفا

  CD -ب

 DVD -ج

 CDو DVD -د

 در صفحه کلید برای تایپ علایم بالای کلید ،کدام کلید را باید پایین نگه داشت ؟-739

 Alt -لفا



 Shift -ب

 Ctrl -ج

 Back Space -د

 یک تبدیل کرده و وارد کامپیوتر می نماید؟و کدام وسیله ورودی می تواند تصاویر را به صفر -740

 پلاتر -لفا

 اسکنر -ب

 نتریپر -ج

 ماوس -د

 کدام یک ازکارتهای زیر مربوط به کیفیت تصویر می باشد؟-741

 ram -لفا

 modem -ب

 sound -ج

 VGA  -د

 است؟ نویسی برنامه ک زبانی کدام -742

 فتوشاپ -لفا

 #C -ب

 اکسل -ج

 نتیپاورپو -د

 دسته کدام جزء و دارد نام چه کند می فراهم را افزار سخت کاربر با ارتباط امکان هک افزاری نرم مهمترین-743

 ؟ افزارهاست نرم از

 یستمینرم افزار س - عامل  ستمیس -لفا

 یستمینرم افزار س - یسیزبان برنا مه نو -ب

 ينرم افزار کار برد -لریکامپا -ج

 نرم افزار سودمند -مفسر -د

744-Plotter است.............. واحد ...........و اسکنر  ههایگا)رسام( جزء دست . 

 يورود - يورود -لفا

 یخروج- يورود -ب

 يورود   -   یخروج -ج

 یخروج - یخروج -د

 منظور از توپولوژی  شبکه چیست ؟-745

 شبکه است . ياتصال گره ها یکیزیش فیدر آرا يشکل ظا هر  -لفا

 در شبکه است . یتعداد کامپیوترها جانب -ب

 شبکه است . ين گره هایب یارتباط يبلهاکا -ج

 ن گره ها است .یب یارتباط ينوع گره ها و کابلها -د

 کدام عبارت صحیح است ؟-746

 شود . یجهت خواندن ونوشتن اطلاعات استفاده مRomحافظه  -لفا

 د .شو یقرار داده مRamمربوط به سخت افزار توسط کار خانه سازنده در  یاز اطلاعات اساس یبخش -ب

 اطلاعات را دارد . یدائم يت نگهداریه قابلیحافظه ثانو  -ج

 است  . یک حافظه دائمیRamحافظه  -د

747-ICT به چه معناست؟ 



 اطلاعات يفن آور -لفا

 ارتباطات  اطلاعات و يفن آور -ب

 کیتجارت الکترون -ج

 کیآموزش الکترون -د

 باشد؟ کدام یک از موارد زیر درست می-748

 شتر است .یب Pc   يکامپیوتر از کامپیوتر ها Miniقدرت پردازش   -لفا

 شتر است .یب  Miniاز کامپیوتر هايPc  يقدرت پردازش کامپیوتر ها -ب

 تک کار بره هستند . Pc يهمانند کامپیوتر ها Mini يکامپیوتر ها -ج

کوچکتر Mini يپیوترهاکاماز لحاظ حجم   کسان هستند امایکسان هستند اما از لحاظ پردازش یاز لحاظ قدرت پردازش  -د

 است .

 ؟ نمی باشندکدامیک از موارد زیر از واحد های ریز پردازنده -749

 Alu -لفا

 حافظه ثبات -ب

 یاصل  حافظه  -ج

 Cache -د

 ؟نمی باشدکدامیک از موارد زیر تعریف ریز پردازنده -750

 باشد  یک کامپیوتر نمین جزء یتر یاساس  -لفا

 ل شده است .یتشک يادیع زجتماست که از مدارات م يشه اترا -ب

 باشد . یم CPUگر آن ینام د -ج

 . شود یم نصب ک مدار جداگانه بنام سوکتی يرو -د

 ؟ است درست گزینه کدام سرعت بیشترین داشتن لحاظ از-751

 CPU > Ram>Hard>  Floppy  -لفا

 CPU >Hard>Ram>Floppy -ب

 Ram> CPU >Hard>Floppy -ج

 Ram> CPU >Floppy>Hard -د

 باشد؟ گزینه درست می دامک-752

 1MB=1024GB -لفا

 1Mb=1024 B -ب

 1MB=1024KB -ج

 1Gb=1024 Kb -د

............ می باشد به همین جهت از حافظه های Ramاز حافظه اصلی  CPUسرعت انتقال داده ها در -753

 .............. استفاده می کنند.

 ثبات - کمتر -لفا

 ثبات -شتر یب -ب

  Cache    -شتریب -ج

 Cache -کمتر  -د

 کدام گزینه در مورد بایت درست می باشد؟-754

 یره قابل آدرس دهین واحد حافظه غیکوچکتر -لفا

 ین واحد حافظه قابل آدرس دهیکوچکتر  -ب

 ره کندیرا در خود ذخ1ا ی0تواند  یفقط م -ج



 دهد یم لیت را تشکیک بیت یبا 8هر   -د

مشخصی به طور آزمایشی ورایگان از آن استفاده می  مدتبه  نرم افزارهایی که مصرف کننده برای یک -755

 کنند ................. گفته می شود؟

 گانیرا ينرم افزارها -لفا

 یاشتراک ينرم افزارها  -ب

 متن باز ينرم افزارها -ج

 یشینما ينرم افزارها -د

 می باشد؟ ستنادرکدام گزینه -756

 سکید يره رویک دایار : یش -لفا

 شود یل میسک از چند قطاع تشکید يروره یقطاع : هر دا -ب

 هم مرکز با شعاع برابر يره هایلندر : دایس -ج

 هم مرکز با شعاع برابر يره هایقطاع : دا  -د

 کدام گزینه درست نمی باشد؟-757

 ت آن کمتر است .یر اما ظرفشتیب یجانب يازحافظه ها یسرعت حافظه اصل -لفا

 شتر است .یبه مراتب ب ینبازحافظه جا یت وسرعت حافظه اصلیظرف  -ب

 شتر است .یبه مراتب ب یاصل ياز حافظه ها یجانب يت حافظه هایظرف -ج

 شتر است.یب یجانب ياز حافظه ها یاصل يسرعت حافظه ها -د

 رود؟کدام یک از موار زیر برای انتقال صوت به کار می -758

 RAM -لفا

 کارت صدا  -ب

 یکیگراف کارت -ج

 مودم -د

759-USER ID .... و ...همان .PASSWORD  .همان ............... است 

 لینام و فام -لفا

 و حفاظت اطلاعات ينام کاربر -ب

 و کلمه عبور ينام کاربر  -ج

 رمز وکلمه عبور -د

 است ؟ 7ز کدامیک از گزینه های زیر از ویژگی های ویندو-760

 تک کاربره -لفا

 یمتن -ب

 فهیتک وظ -ج

 AERO  -د

 های تابعی هستند؟ لیدکدامیک از گزینه های زیر ک-761

 CTRL -لفا

 ALT  -ب

 F 12تا   F1  -ج

 Lock Num -د

 ؟ نمی کندکدام واحد ظرفیت حافظه را بیان -762

 Db  -لفا

 Kb -ب



 Gb -ج

 Mb -د

 .......... گویند.برد اصلی کامیپوتر را .......-763

 CPU -لفا

 Ram -ب

 Hard -ج

 Mainboard  -د

 است ؟ ورتبه کدام صCDدسترسی به اطلاعات دیسکهای  -764

 یبیا ترتیگام به گام  -لفا

 يمواز -ب

 یا تصادفیم یمستق -ج

 ينور -د

 غلطک وسط موس برای چه منظوری است ؟-765

 ک راست استیمعادل کل -لفا

 تک چپ اسیمعادل کل -ب

 ندارد يکاربرد -ج

 ات پنجره هایمرور محتو  -د

766-Boot شدن یعنی چه ؟ 

 نیماش یجانب يز اجزاا یکی یستم بعلت خرابیات سیمتوقف شدن عمل -لفا

 سکید يرو Boot Recordخراب شدن  -ب

 کامپیوتر Romستم توسط برنامه موجود در یس يلهایک فایشدن اتومات Load  -ج

 مختلف يم شدن برنامه هایل مقیلپر شدن حافظه به د -د

 دراصطلاح کامپیوتر، مانیتور های تخت  را ................گویند .-767

 LCD -لفا

 CGS -ب

 CGA -ج

 VGA -د

 ؟ است کدام عهده بر وظیفه کنترل و هماهنگی کلیه عملیات درونی یک سیستم کامپیوتری-768

 يکاربرد يها برنامه -لفا

 یستمیس يبرنامه ها  -ب

 یعموم يس دهنده هایسرو -ج

 مترجم -د

 مخفف چیست؟ Itاصطلاح  -769

 است . یتنترنیا يفناور ياست وبه معناInternet  Technologyمخفف عبارت  -لفا

 اطلاعات است . يفناور ياست وبه معنا Inter Net  Technologyمخفف عبارت  -ب

 ارتباطات است . يفناور ياست و به معنا Information Technologyمخفف عبارت  -ج

 اطلاعات است . يفناور ياست وبه معناInformation  Technologyمخفف عبارت   -د

 تر است؟پیوکدام یک ازگزینه زیر تعریف کام-770

 و منطقی را انجام دهد. یاضیات ریکه قادر است عمل يزیحافظه و قابل برنامه ر ياست دارا یدستگاه -لفا

 دهد. یرا انجام م یو منطق یضیات رایفقط عملاست که  یدستگاه -ب



 دهد . یرا انجام م ینیپ و حروفچیتا ياست که فقط کارها یدستگاه -ج

 ایمد يهال یپخش فا ياست برا یدستگاه  -د

 کدامیک از موارد زیر خصوصیت نرم افزار به شمار می رود؟-771

                       و قابل لمس یکیزیف -لفا

 است یکیو مکان یکیل مدارات الکترونشام -ب

 جهت استفاده از کامپیوتر است . ییشامل دستور العملها  -ج

 فه پردازش اطلاعات را دارد.یوظ -د

 ر های شخصی کدام است ؟یوتاجزای اصلی کامپ-772

 Cpu - Memory - Case - Monitor -لفا

 Cpu -  Ram -  Hard -  Case  -   Monitor-   Keyboard -ب

 Cpu - Memory - In Put Unit - Output Unit -ج

 Cpu - Memory - Keyboard - Case -د

 ؟ نیست کدام یک از گزینه های زیر صحیح-773

 افزار و نرم افزار و کاربر است سختن یستم عامل رابطه بیس -لفا

 ستم عامل ممکن است چند کاربره و تک کاربره باشد .یس -ب

 فه داشته باشدیک وظیا یفه یچند وظ ستم عامل ممکن استیس -ج

 . سخت افزار هاست يراه انداز يستم عامل برایس  -د

 نرم افزار چه کاری را انجام می دهد ؟-774

 زارن کاربر و  سخت افیب رابط -لفا

 رود یم بکار کامپیوتر دستورات نوشتن يبرا -ب

 رود یم کار به خاص يکارها انجام يبرا -ج

 سازد یرا ممکن ملها یت فایریمد -د

 کند ؟ می کامپیوتر وارد و کرده تبدیل کدامیک از دستگاههای زیر عکس را به  سیگنالهای دیجیتال-775

 Touchpad -لفا

 Trackball -ب

 Scanner -ج

 Light Pen -د

 ؟ است مناسب زیر های ازگزینه کی ام کد مگا بایت 500برای جابجایی یک فایل به حجم -776

 يرقلم نو -لفا

 Rom -ب

  Cd -ج

  Floppy -د

 مربوط به فایلهای ................است  Waveمربوط به فایلهای ....................و پسوند Txtپسوند -777

 یصوت -ییاجرا -لفا

 يریتصو - یمتن -ب

 یصوت   -   یتنم -ج

 يریتصو - ییاجرا -د

 ت.قلم نوری یک دستگاه ...........................اس-778

  يورود -لفا

 یخروج -ب



 یخروج - يورود -ج

 یسیسک مغناطید -د

 کدام گزینه از مزایای تجارت الکترونیک می باشد؟-779

  ساعته   24   خدمات -لفا

 تیعدم اعتمادبه وب سا -ب

 لاق کایعدم مشاهده دق -ج

 از کارت يکلاهبردار -د

 شود ؟چه نامیده می  Ramو   Cpuمسیر عبور  اطلاعات بین -780

 Port -لفا

 Slot -ب

 Bus  -ج

 Socket -د

 به رایانه گیرنده اطلاعات  ............ و به  رایانه ای که فرستنده اطلاعات است ................. می گویند .-781

 کانال انتقال Server -لفا

 Server -ال نتقکانال ا -ب

 Server - Clients  -ج

 کانال انتقال -Client -د

 کدامیک  از چاپگرهای زیر سرعت بیشتری دارد ؟-782

 چاپگرهاي سوزنی -لفا

  چاپگرهاي لیزري -ب

 چاپگرهاي ضربه اي -ج

 چاپگرهاي جوهر افشان -د

 ؟ مضر نداردکدام صفحه نمایش تششعات -783

 CRT -لفا

 LCD . CRT -ب

 Plasma . LCD -ج

 CRT   .   Plasma -د

 ؟ نیستدو حالته  کدام یک از کلید های زیر-784

 Caps Lock -لفا

 Num Lock -ب

 Scroll Lock -ج

 Shift -د

 به منظور فعال نمودن اعداد سمت راست صفحه کلید از ................ استفاده می شود.-785

 Caps Lock -لفا

 Scroll Lock -ب

 Num Lock -ج

 Shift -د

 ........... را فعال نمود.بزرگ لاتین باید دکمه........... روفبرای تایپ ح-786

 Caps Lock -لفا

 Scroll Lock -ب



 Num Lock -ج

 Ctrl -د

 با استفاده از دکمه .............  میتوان از صفحه نمایش عکس گرفت.-787

 Caps Lock -لفا

 Print Screen  -ب

 Num Lock -ج

 Scroll Lock -د

 قف.........تو به منبع انرژی غیرقابل-788

 USB -لفا

 POWER -ب

 UPS -ج

 FLASH -د

789-PDA چیست ؟ 

 از انواع کامپیوتر هاي شخصی است که سرعت بسیار بالایی دارد . -لفا

 از انواع کامپیوترهاي شخصی است که ابعاد بسیار بزرگی دارد . -ب

 می شود . زیاد استفادهجم از انواع کامپیوترهاي شخصی است که ابعاد کوچکی دارد و براي کارهاي با ح -ج

 از انواع کامپیوتر هاي شخصی است که ابعاد کوچکی دارد و براي کارهاي با حجم کم استفاده می شود.  -د

 برای تعیین تعداد اعشار ارقام از کدام تب استفاده می کنیم ؟-790

 Insert -لفا

 Edit -ب

 Home-number  -ج

 Format -د

 کدام گزینه را باید انتخاب کرد ؟  Printه ای  ورمحابرای چاپ صفحه کاری جاری از کادر -791

 Selection Print -لفا

 Entire Work Book Print -ب

 Active Sheet Print  -ج

 Print Current Sheet -د

 = چیست ؟Round( 1;435,23نتیجه تابع )-792

 435 -لفا

 435,231 -ب

 435,2 -ج

 435,23 -د

بر روی   جاری استفاده کنیم  Work Bookباز را در Work Bookاز برای اینکه استایل های تعریف شده -793

 چه گزینه ای کلیک کنیم؟

 Modify  -لفا

 table style -ب

 style  Merge  -ج

 add -د

 برای اینکه نمودار در همان صفحه قرار گیرد در کدام مورد باید تعیین شود ؟-794

 As New Sheet -لفا



 object in -ب

 As New Work Book -ج

 File - New -د

 به چه منظور مورد استفاده قرار می گیرند ؟  Pasteو  Copyفرامین  -795

 حذف اطلاعات -لفا

 اطلاعات یکپ -ب

 اطلاعات ییجاجابه  -ج

 ن فرمان و برگرداندن دوبارهیحذف آخر -د

 برای افزایش پهنای یک سطر ..................؟-796

 .میکن ین درگ مییرفه پاآن را به ط ینییمرز پا  -لفا

 م.یکن یآن را به طرفه بالا درگ م ییمرز بالا -ب

 م.یکن یآن را به طرفه بالا درگ م ینییمرز پا -ج

 میکن یآن را به طرفه پایین درگ م ییمرز بالا -د

 ؟می شودبرای ایجاد یک سبک جدید کدام گزینه استفاده   Homeاز سربرگ  Cell Styleاز کشوی -797

 م .یکن یک میکل Addدکمه  يون نام سبک ، بر رییعد از تعب -لفا

 م .یکن ین مییک کرده وسپس نام سبک را تعیکل  new cell styleنه یگز يبر رو  -ب

 م .یکن یک میکل newدکمه   يبر رو -ج

 م .یکن یک میکل Okدکمه   ين نام سبک ، بر روییبعد از تع -د

 ؟ استیک نمودار ستونی کدام مطلب صحیح  در مورد تعداد سری های موجود در-798

 ها برابر تعداد سطر هاست . يتعداد سر -لفا

 ها برابر تعداد ستون هاست . يتعداد سر -ب

 ا برابر ستون ها باشد .یتواند برابر تعداد سطرها  یها بسته به انتخاب کار بر م يتعداد سر  -ج

 ن هاست .ها برابر مجموع  تعداد سطر ها و ستو يتعداد سر -د

 ؟می شودکدام گزینه استفاده از برای مرتب کردن یک لیست -799

 Dataاز تب    Auto filterنهیگز -لفا

 میکنیانتخاب م Dataرا از تب  Formنه یگز -ب

 م.یکن یانتخاب م  Dataرا از تب  Arrangeنه یگز -ج

 م.یکن یانتخاب م  Dataرا از تب  Sortنه یگز  -د

 زیر مجموعه کدام یک از انواع برنامه هاست ؟ Excelبرنامه -800

 واژه پردازها -لفا

 یمیترس يبرنامه ها -ب

 یاطلاعات يبانکها  -ج

 صفحه گسترده يبرنامه ها -د

 کدام سلول به طور پیش فرض فعال خواهد شد؟ Enterو فشار کلید  B1پس از ورود داده در سلول -801

 A1سلول  -لفا

 C1سلول  -ب

 B2سلول   -ج

 A2سلول  -د

 ن یک سلول با خطوط هاشور می شود ؟شد موجب پر Format Cellکدام گزینه از کادر -802

 Gridlines -لفا



 Customize -ب

 Texture -ج

 Pattern  -د

 چه کاری را انجام می دهد ؟   Deleteاز پنجره  Row  Entireگزینه -803

 کند. یسلول انتخاب شده را پاک م -لفا

 کند . یات سلول را پاک میفقط محتو -ب

 د .کن یک سطر را به طور کامل پاک می  -ج

 کند . یک ستون را به طور کامل پاک می -د

 در سلول فعال کدام مورد درست است ؟  C3تا B2برای جمع کردن محتوای سلولهای -804

 B2+C3 -لفا

 B2+C3= -ب

 B2+C2+B3+C3 -ج

 B2+C2+B3+C3=  -د

 ؟نمی باشد  Excelد های کدام گزینه از کاربر-805

 يزیانجام امور نشر روم  -لفا

 يداره دفاتر حسابیته -ب

 یکیه نمودار گرافیته -ج

 فاکتور فروش -د

 به منظور درج)اضافه کردن( کاربرگ از کدام گزینه زیر استفاده می شود ؟-806

 Insert-Column -لفا

 Insert-Work Sheet  -ب

 Insert-Row -ج

 Insert-Delete -د

 ؟ غلط استکدام گزینه -807

 رد.یگ یدر نظر م یاضیات ریدر عمل رکتت شیرا به عنوان عدد با قابل یخیتار ياکسل داده ها -لفا

 ند.یگو یحات( می)توض یادداشت متنیبه متن داخل هر سلول ،   -ب

 کند . یرا با هم جمع مSheet2از    B5تا A5 يسلولها sum(sheet2!A5:B5)=فرمول  -ج

 باشد. یم Work Sheet کی شامل فرض شیپ درحالت 2013در اکسل Work Book یک -د

 چیست ؟ Data Labelsمفهوم گزینه ار در ترسیم نمود-808

 داده ها یش اسامینما  -لفا

 ش جدول داده ها در نمودارینما -ب

 ش شرح نمودارینما -ج

 عنوان نمودار و محورها -د

 چه وظیفه ای دارد؟ Countتابع -809

 انتخاب شده يشمارش سلولها -لفا

 پ شدهیتا يشمارش سلولها -ب

 يعدد يشمارش سلولها  -ج

 یخیو تار يعدد ياولهشمارش سل -د

 کدام یک از گزینه های زیر به عنوان متن در نظر گرفته می شود ؟-810

 4.3 -لفا



 3+2= -ب

 3+2  -ج

 10:30 -د

 ؟می شودینه استفاده برای ترسیم نمودار در یک صفحه جدید کدام گز-811

 Chart Typeنه یانتخاب گز -لفا

 As New Sheetنه یانتخاب گز  -ب

 Place Chartنه    یانتخاب گز -ج

 In  As Objectنه یانتخاب گز -د

 معادل کدامیک از گزینه های زیر است ؟ Sum(A1:A10)/10فرمول =-812

 Round (A1,A10)= -لفا

 Average (A1:A10)=  -ب

 Subtotals (A1:A10)= -ج

 Count (A1:A10)= -د

 ؟ جهت تسریع عمل ورود داده های تکراری در سلولها از کدام گزینه استفاده می کنیم-813

 Auto Correct -لفا

 Auto Format -ب

 Auto Stayl -ج

 Auto Fill  -د

 چیست  ؟ sum(A2:C5;D8)=  وظیفه دستور-814

 D8لول و س C5تا  A2 يمحاسبه مجموع سلولها  -لفا

 D8و سلول  C5با A2 يمحاسبه مجموع سلولها -ب

 D8تا C5 يو سلولها A2محاسبه مجموع سلول  -ج

 D8ات A2محاسبه مجموع سلول  -د

 کدام گزینه صحیح است ؟-815

 A1=A2+A3 -لفا

 =A2+A3 -ب

 A2+A3=  -ج

 A2=A3 -د

 برای ویرایش خانه فعال از کدام کلید میتوان استفاده کرد ؟-816

 F3 -لفا

 F1 -ب

 F2  -ج

 F4 -د

 برای انتخاب یک محدوده مشخص می توان ............؟-817

 را زد . Ctrlخانه اول را انتخاب وسپس -لفا

 م .یریگ یرا م Altخانه  ن یانتخاب اول -ب

 م .یکن یک میرا کل ییرا گرفته و خانه انتها Shiftم و سپس یکن یخانه اول را انتخاب م  -ج

 و انتخاب خانه ها ید جهتیکل -د

 می توان هم ترازی داده ها را  در خانه ها  انجام داد ؟ Format Cellsبا استفاده از کدام تب از -818

 Number -لفا



 Font -ب

 Alignment  -ج

 Border -د

 ؟می دهدچه عملی انجام  Shrink To Fitگزینه  Alignmentاز تب  Format Cellدر کادر -819

 رد .یر اندازه داده شود تا در طول خانه قرار گییتغ يه شده در خانه طورمتن نوشت  -لفا

 ک خانهیشده در  يخانه ها  يب محتوایترک -ب

 رد  .یگ یه متن در خط بعد قرار میبقشتر باشد یاگر طول متن از خانه ب -ج

 کند یده شدن متن تا عرض خانه را پر میکش -د

 و جلو گیری از انجام کارهای تکراری از گزینه ...........؟ برای بالا بردن سرعت انجام کارها-820

 Merge -لفا

 Template -ب

 Style -ج

 Styleو  Template  -د

 ......؟...( از .....Sheetبرای کپی یک صفحه کاری )-821

 م .یکن یرا انتخاب م Insertنه یم و گزیکن یک راست میمورد نظر کل Sheet يرو -لفا

 میکن یرا انتخاب مMove Or Copyنه  یک کرده و گزیورد نظر راست کلم Sheet يرو  -ب

 میکن یرا انتخاب م Sheet  Insert از تب -ج

 میکن یا انتخاب مر ینه کپیم و گزیکن یک راست میمورد نظر کل Sheet يرو -د

 به چه منظور بکار میرود؟ Reviewاز تب  Protect Sheetگزینه -822

 خودکار یابیغلط  -لفا

 يصفحه جار يرو يرمز گذار  -ب

 Work Book  يرو يرمز گذار -ج

 به اشتراک گذاشتن  اطلاعات کاربر -د

نمودارکدام مورد صحیح ای و از لیست اجز Chartبرای قالب بندی فهرست علائم نمودار، در نوار ابزار-823

 است؟

 Chart Area -لفا

 Plot Area -ب

 Legend  -ج

 Series -د

 ر زاویه مشاهده نمودار سه بعدی کدام گزینه صحیح است؟برای تغیی-824

 Chart Typeنه یگز Chartاز تب  -لفا

 Chart Optionنه یگز Chartاز تب  -ب

 D View-3نه  یگز Chartاز تب    -ج

 Locationه نیزگ Chartاز تب  -د

 max(A1,B1,F3)=       باشد حاصل تابع زیر کدام است ؟  F3=4و   A1=Trueو  B1=Khاگر -825

 Khtrue4 -لفا

 صفر -ب

 Error -ج

  4  -د

 کدام دستور می تواند کار  چند تابع را انجام دهد ؟-826



 Sum -لفا

 Subtotals -ب

 Average  -ج

 Form -د

 د ؟باشکلید میان بر برای چاپ کدام مورد می -827

 Ctrl + P -لفا

 Ctrl + L -ب

 Ctrl + X -ج

 Ctrl + M -د

 کدام مورد را باید انتخاب کرد؟ Printبرای چاپ کل سند از کادر محاوره ای -828

 Active Sheet(S (-لفا

 Entire Work Book  -ب

 Selection -ج

 List -د

را برمیگرداند؟ دی باشد تابع روبرو چه عد 24-18-10-16-14-8به ترتیب  d6تا  d1اگر مقادیر-829
=max(d1:d5) 

 24 -لفا

 8 -ب

 16 -ج

 18  -د

 ؟صحیح نیستکدام مورد زیر -830

 که بتوان در آن داده وارد کرد . يهر صفحه ا یعنیکاربرگ  -لفا

 دهد  . یل میرا تشک يک صفحه کاریتقاطع هر سطر و ستون   -ب

 سطر نامند. یمجاور هم را بطور افق يسلولها -ج

 مان نام برد .خ ، زی، تار ی، متن يتوان عدد یسلول را م یلداخر یانواع مقاد -د

 ؟ صحیح نیستدر مورد ذخیره کردن اطلاعات در داخل صفحه کاری کدام مورد -831

 شود . یره میل ذخیک فایدر  يهر صفحه کار  -لفا

 است . Xlsصفحه گسترده  يلهایپسوند فا -ب

 استفاده کرد . officeاز دکمه   Save Asای Saveنه یتوان از گز یم يره سازیذخ يبرا -ج

 از نوار ابزار استاندارد است . Saveانتخاب دکمه  يره سازیذخ ياز روشها یکی -د

 ?.می دهدچه عملی انجام  Shift Cells Downهنگام اضافه کردن یک سلول گزینه -832

 ر خانه ها به راستیانتقال سا -لفا

 ر خانه ها به چپیانتقال سا -ب

 نییخانه ها به پار یانتقال سا  -ج

 خانه ها به بالار یانتقال سا -د

 می توان......؟ Alignmentدر هنگام قالب بندی سلولها با گزینه -833

 ر دادییش متن را تغیشکل نما -لفا

 ر دادیینه را تغیرنگ پشت زم -ب

 ر دادییحروف را تغ يقالب بند -ج

 م کردیمتن را تنظ يترازبند  -د



 ؟ یستچWrap Textمفهوم گزینه -834

 نشان داده شود . يت چند سطربصور یمتن طولان-لفا

 ل شوند .یک سلول تبدیانتخاب شده با هم به  يسلولها -ب

 م شوند .یانتخاب شده به چند سلول تقس يسلولها -ج

 رد .یز شده تا در سلول جا بگیمتن کوچک ور -د

 ؟می شودبرای تغییر رنگ زمینه سلولها از کدام گزینه استفاده -835

 Pattern  -لفا

 Border -ب

 Protection -ج

 Font -د

 ؟می شودبرای نسخه برداری از قالب بندی متن مارک شده از کدام گزینه استفاده -836

 Paste Special -لفا

 Paste -ب

 Format Painter  -ج

 Copy -د

 ؟چه عملی انجام میدهید Sheet3به منظور افزودن یک کار برگ جدید به صفحه کاری جاری و قبل از -837

 م .یکن یرا انتخاب م Insertنه یک کرده و گزیراست کل Sheet2 يبر رو  -لفا

 میکن یرا انتخاب م  Insertنه یک کرده و گزیراست کل Sheet3 يبر رو -ب

 م .یکن یرا انتخاب م Insertنه یک کرده و گزیدوبار کلSheet2 يبررو -ج

 م .ینک یانتخاب م Insertنهیک کرده گزیدوبار کل Sheet3 يبررو -د

 در ارتباط زنده و هم زمان بین سلولها کدام گزینه صحیح میباشد؟-838

 ر کند .ییمقصد تغ يمبدا سلولها ير سلولهاییبا تغ  -لفا

 ر نکند .ییمقصد تغ يمبدا سلولها ير سلولهاییبا تغ -ب

 شوند . یف شده نوشته میر تعریمقاد يانتخاب شده سر يسلولها  يدن ماوس بر رویبا کش -ج

 شوند . یانتخاب شده رمز دار م يولهاسل -د

 اگر بخواهیم چند فایل صفحه گسترده را با موقعیت و اندازه هر کدام در یک پنجره  نمایش دهیم؟-839

 reviewاز تب  Protections نهیگز انتخاب -لفا

 reviewاز تب  Protect Work Bookنه یانتخاب گز -ب

 windowدر قسمت  switch windowنه یش آن ها با استفاده از گزینما -ج

 windowدر قسمت  arrange allنه یمرتب کردن آنها با استفاده از گز -د

 یک عملگر ..... و *  یک عملگر ......  می باشد ؟ andعملگر -840

 یو محاسبات یمنطق  -لفا

 يو رشته ا یمنطق -ب

 يآدرس و رشته ا -ج

 یو منطق یمحاسبات -د

 ه باز شده کدام میباشد؟تردردن فایلهای صفحه گسنحوه مرتب ک-841

 viewاز تب  Arrangeنه یانتخاب گز  -لفا

 reviewاز تب  Arrangeنه یانتخاب گز -ب

 Arrange Iconsک و انتخاب یانجام راست کل -ج

 Arrange Iconsنه یک و انتخاب گزیانجام دوبار کل -د



 ؟می شودام گزینه استفاده برای سفارشی کردن نوار آدرس و فرمول از کد-842

 reviewتب  showاز گروه formula bar -فلا

 Viewتب  showاز گروه   Formula Bar  -ب

 data -از تب   Formula -ج

 dataو تبdata toolsاز گروه  Formula Bar -د

 برای وارد کردن فرمول در یک سلول از کدام فرمان استفاده می کنیم ؟-843

 Formulas -  Function  -لفا

 Insert - Function -ب

  Insert - Formulas -ج

  Formulas- Insert -د

 کدام نمودار زیر از نوع دایره ای می باشد ؟-844

 Pie  -لفا

 Area -ب

 Bundle -ج

 Cone -د

 ؟نادرست است  Roundکدام مورد درباره تابع -845

 اشدب یم يگرد کردن اعداد اعشار ين تابع برایا -لفا

 باشد یح میگرد کردن اعداد صح ين تابع برایا -ب

 باشد یدلخواه م يتا رقمها يگرد کردن اعداد اعشار ين تابع برایا -ج

 باشد یم يشمارش اعداد اعشار ين تابع برایا  -د

 جهت ادغام سلول ها از کدام گزینه استفاده می شود؟-846

 Wrap Text -لفا

 Justify -ب

 Merge Cells  -ج

 Shrink To Fit -د

در بقیه فایلهای بازنیز قابل استفاده باشد ازکدام روش یل های تعریف شده در یک فا Styleبرای اینکه -847

 استفاده می کنیم؟

 میکن یک میکل Add يبررو Cell Style -لفا

 میکن یک میکل Modify يبر رو Cell Styleاز  -ب

 میکن یک میکل Merge يبررو Cell Styleاز   -ج

 میکن یک میکل  Style يبر رو  Cell Style -د

 در یک سلول چیست  ؟ #ت لاممفهوم ظاهر شدن ع-848

 طول عدد نسبت به عرض سلول بزرگتر است .  -لفا

 نسبت به عر ض سلول بزرگتر است . یطول عدد علم -ب

 شده دارد . یمتن يسلول قالب بند -ج

 فرمول است يسلول حاو -د

 ع عملگرها در اکسل کدامند؟انوا-849

 يمقایسه ا - يرشته ا - یمحاسبات - یمنطق يعملگرها  -لفا

 آدرس - یمحاسبات - یمنطق  يعملگرها -ب

 يرشته ا -آدرس - یمحاسبات  يعملگرها -ج



 يرشته ا -آدرس - يسه ایمقا - یمحاسبات يعملگرها -د

 طریقه نوشتن یک تابع در یک خانه چگونه است ؟-850

 min(A1:B5)= -لفا

 min = (A1, B5) -ب

 (X = A1 + b5) min -ج

 C1=A1+B(min) -د

 نمای برنامه از کدام کلید می توان استفاده نمود؟راهبرای فعال کردن -851

 F1  -لفا

 F3 -ب

 F2 -ج

 F4 -د

ا بگیرد کدام در هنگام درج خانه ، برای اینکه خانه انتخاب شده به پایین حرکت کند و خانه جدید جای آن ر-852

 باید انتخاب نمود؟Insertمورد را از کادر محاوره ای 

 Shift Cells Right -لفا

 Shift Cells Down  -ب

 Entire Row -ج

 Entire Column -د

 می توان خطوط کادر خانه ها را تنظیم نمود ؟ Format Cellبا استفاده از کدام تب از کادر محاوره ای -853

 Alignment -لفا

 Font -ب

 Number -ج

 Border  -د

 دهد؟می چه عملی انجام  Fillانتخاب  Alignmentو از تب  Format Cellsدرکادر محاوره ای -854

 رد.یه متن در خط بعد قرار گیشتر باشد بقیشود چنانچه طول متن از خانه ب یباعث م -لفا

 رد.یر اندازه داده شود تا در طول خانه قرار گییتغ يشود که متن نوشته شده در خانه طور یباعث م -ب

 شود یک خانه میانتخاب شده در  يخانه ها يب شدن محتوایباعث ترک -ج

 شود تا عرض خانه را پر کند. یمتن م رارباعث تک  -د

 چیست ؟ IFعملکرد تابع -855

 کند. ین میگزید را جایگذارد و اعداد جد یشرط م یانتخاب يسلولها يبر رو -لفا

 کند. ین میگزید را جایگذارد و اعداد جد یه سلولها شرط میکل يبر رو -ب

 دهد. یام مناسب میشرط پ ودنگذارد ، در صورت درست ب یشرط م یانتخاب يسلولها يبر رو  -ج

 کند. یسلول را پاک م يگذارد و اگر شرط برقرار نباشد .محتوا یشرط م یانتخاب يسلولها يبر رو -د

 ( صفحه کاری را تغییر داد چه باید کرد؟ Cellنتوان محتوای خانه های ) برای اینکه -856

 مییرا انتخاب نماLockedنه یزو گرا فعال کرده Protectionتب  Format Cells ياز کادرمحاوره ا -لفا

ه رمز م و کلمیکن یک میرا کل Protect Sheetنه  یگز Review سربرگ م و سپس ازیکن یم lockedابتدا سلول را   -ب

 م.یده یقرار م

 م.یکنیک میرا کل Protect Workbookک کرده و سپس یرا کل Protectionنه یگز Toolsاز سربرگ  -ج

م و یکن یک میرا کل Protect Workbookنه  یگز Review سربرگ م و سپس ازیکن یم lockedابتدا سلول را   -د

 م.یده یکلمه رمز قرار م

 یانگین داده های عددی یک محدوده از خانه ها بکار می رود؟کدام تابع برای محاسبه م-857



 Sum -لفا

 Count -ب

 Average  -ج

 Round -د

 =Sum (Ali ; A1 ; C1تابع زیر کدام است؟ ) اصلباشد ح A1=5  ،B1=Ali  ،C1=6اگر خانه های -858

 5 -لفا

 11  -ب

 Ali 5 6 -ج

 Name يخطا -د

 باشد . حاصل تابع زیر کدام است؟ C2=Aliو  A1=True  ،B2=Falseاگر مقادیر خانه -859

 (Count ( A1 ; B2 ; C2= 

 2 -الف

  0  -ب

 1 -ج

 3 -د

 است؟ام باشد حاصل تابع زیر کد B1 = Kh  ،A1=True   ،F3=4اگر -860

=IF(a1=kh,"t","f) 

 4 -الف

 F -ب

 Error  -ج

 F3 -د

 کدام گزینه قالب بندی شرطی را انجام می دهد؟-861

 style formatting -لفا

 conditional formatting  -ب

 formatting -ج

 Auto Filter -د

 مجموعه فیلدهای مربوط به یک موضوع یا موجودیت چه نامیده می شود؟-862

 بانک داده -لفا

 ردرکو  -ب

 جدول -ج

 یبانک اطلاعات -د

 ی تواند صورت بگیرد ؟به کدام روش زیر م Access روشهای مشاهده رکوردها در جداول -863

 Table , Data base -لفا

 Form View , Table -ب

 Form View , Data sheet -ج

 Design view ,  Datasheet view  -د

 ی شود ؟ه ممشخصات مربوط به یک موضوع یا موجودیت چه نامید-864

 لدیف -لفا

 رکورد -ب

 جدول  -ج



 یبانک اطلاعات -د

 یک موجودیت ................... نامیده می شود؟ اطلاعات جزئی مربوط به-865

 رکورد -لفا

 جدول -ب

 لدیف  -ج

 یبانک اطلاعات -د

 به مجموعه ای از رکوردها که دارای عناوین فیلد یکسان هستند ................. گفته می شود؟-866

 گاه دادهیپا -فلا

 جدول  -ب

 لدیف -ج

 رکورد -د

 ؟پسوند فایلهای اکسس چیست-867

 mccdb -لفا

 fcdb -ب

 nccdb -ج

 accdb  -د

 برای ویرایش یک رکورد چگونه می توان عمل نمود؟-868

 Formق یاز طر -لفا

 Data Sheetق یاز طر  -ب

 Queryق یاز طر -ج

 Datasheetو  form -د

 .......................  ؟ م یا نام خانوادگی یکسانی هستند بهتر استنا برای تمایز افرادی که دارای-869

 م.یره نمائیجداگانه ذخ يلدهایآنها را در ف -لفا

 م.ی( به جدول اضافه کن Primary Keyه ) ید اولیک کلی  -ب

 م.یآنها رمز قرار ده یا نام خانوادگینام  يبرا -ج

 میجاد کنیآنها فرم جداگانه ا يبرا -د

 صحیح است؟ Tableیک از عبارات زیر در مورد یک ام کد-870

 ندکس باشد.یدو ا يتواند تنها دارا یم Tableک ی -لفا

 ندکس باشد.یک ای يتواند تنها دارا یم Tableک ی -ب

 داشته باشد.  Primary Keyک یتواند تنها  یم Tableک ی  -ج

 باشد.  Primary Keyچند  يتواند حاو یم Tableک ی -د

 شد؟کارکتر می با 255داده حداکثر ع  کدام نو-871

 short Text -لفا

 Text  -ب

 Long Text -ج

 Hyperlink -د

 توسط چه خصوصیت فیلد می توان برای یک عبارت که در فیلدها می خواهد قرار گیرد قانون تعریف نمود؟.-872

 Required -لفا

 Allow Zero -ب

 Validation Rule  -ج



 Caption -د

 رنتی  می تواند باشد؟شامل یک آدرس اینتیر کدام نوع از دادة ز-873

 Currency -لفا

 OLE object -ب

 Memo -ج

 Hyperlink  -د

 در فیلد نداشته باشیم؟ Nullاگر بخواهیم اجازه داشتن ارزش -874

 م.یم کنیتنظ Yes يرا رو Requiredت یخاص  -لفا

 م.یم کنیتنظ No يرا رو Requiredت یخاص -ب

 م.یم کنینظت Yes يرا رو Formatت یخاص -ج

 م.یم کنیتنظ No يرا رو Formatت یخاص -د

 برای ایجاد فیلدی دارای زیر مجموعه از کدام نوع داده زیر استفاده می شود ؟-875

 short text -لفا

 Long Text -ب

 Ole Object -ج

 Lookup Wizard -د

فیلدها  صیت ازصوم خکدا نشودجدول پرشود وهیچ یک خالی رد  اگربخواهیم تمام فیلدها دریک رکورد از-876

 باید فعال شود؟

 Required  -لفا

 Index -ب

 Caption -ج

 Default Value -د

هر چه تعداد رکوردهای جدول بیشتر باشد برای اینکه اکسس بتواند داده ها را سریعتر ، مرتب و جستجو -877

 کند احتیاج به .................. دارید؟

 Primary Key -لفا

 Query -ب

 Filter -ج

 Index  -د

 پرس و جو  بر اساس یک معیار در اکسس چه نامیده می شود؟-878

 query  -لفا

 Form -ب

 Table -ج

 Search -د

 کدام نوع داده برای قیمت کالا مناسب است ؟-879

 Currency  -لفا

 text -ب

 Number -ج

 Memo -د

نام فرد و شماره ر، انند فیلد نام، شهدرجدول های بزرگ که می خواهیم جستجوها براساس چندین فیلد م-880

 انجام شود بهتر است ..................... ایجاد کنیم؟ تلفن



 م.یجاد کنیگانه ایندکس یا -لفا

 م.یجاد کنیندکس ایا چند -ب

 م.یجاد کنیا Primary Key -ج

 م.یقرار ده Yesمذکور را برابر  يلدهایف Requiredخواص  -د

 کدام روش باید استفاده نمود؟از ساختار بانک اطلاعاتی  برای درج یک فیلد در-881

 Design - Insert Rows  -لفا

  Insert - Rows  Database  -ب

  Insert - Rows  Data sheet  -ج

 home - Insert  Rows -د

 برای انتخاب رکوردهایی بر اساس معیار خاص از کدام روش زیر استفاده می کنیم ؟-882

 Query  -لفا

 home - Find -ب

 home - Search -ج

 create -د

 چگونه باید عمل نمود؟ Wizardبرای ایجاد یک فرم از طریق -883

 Create -Form wizardق  یاز طر  -لفا

 Create Form يک بررویو سپس دوبار کل Databaseدر پنجرة  Objectsر مجموعۀ یاز ز Forms يک بر رویکل -ب

by using wizard 
 homeبون یاز ر wizard Formانتخاب  -ج

 Formبون یاز ر  using wizard  Create خابانت -د

کلیک برروی کدام دکمه باعث انتقال تمام فیلدها ازلیست  Form wizardدرهنگام طراحی فرم با -884

Available selected Fields می شود؟ 

 > -لفا

 >>  -ب

 < -ج

 <-- -د

 کدام یک از موارد زیر قرار دارد؟ Queryدر قسمت بالای پنجره -885

 دهد. یلد را نشان میک فیرد که هر کدام دا ییستونها -لفا

 د قراردارد.یکه انتخاب کرده ا یجدول يلدهایست فیل -ب

 شود. یپنجره ظاهر م يدر بالا Datasheetهمانند جدول  یجدول -ج

 Datasheetمانند جدول ه یلدها و جدولیست فیل  -د

 د؟جهت چاپ صفحات فرم یا گزارش از چه کلید میانبری استفاده می شو-886

 Ctrl + P  -لفا

 Alt + P -ب

 Ctrl + Z -ج

 Shift + P -د

کدام گزینه را  Print Rangeودر قسمت   Printجهت چاپ صفحات خاصی از فرم یا گزارش در پنجره -887

 انتخاب می نمائیم؟

 All -لفا

  … Page Form …  To  -ب



 selected Records -ج

 Print To File -د

 ...... ذخیره می شود... درپایگاه داده کلیه اطلاعات در-888

 ERD -لفا

 Data Base   -ب

 DBMS -ج

 DBL -د

 ؟ نمی باشد Accessکدام یک از امکانات نرم افزار پایگاه داده -889

 ره اطلاعاتیذخ -لفا

 ل اطلاعاتیحله وتیتجز -ب

 ادیتعداد کاربران ز یدسترس  -ج

 ت اطلاعاتیریمد -د

 ست ؟. اهر پایگاه داده حداقل دارای یک .............-890

 Field -لفا

 رکورد -ب

 Table  -ج

 ریتصو -د

 بانک اطلاعات چیست ؟-891

 ند .یوسته را گویشده از اطلاعات مرتبط و به هم پ یمجموعه سازمانده  -لفا

 ند .یک نوع گویاطلاعات متعدد از  به -ب

 ند .یگاه داده گویدر پا یبه اقلام محاسبات -ج

 شود یبه فرمولها گفته م -د

 جدول چیست ؟-892

 ند.یباشد گو یکسانی يلدهایف ياز رکوردها که دارا يبه مجموعه ا  -فلا

 باشد. یکسانی ينوعها يلدها که دارایاز ف يبه مجموعه ا -ب

 ند.یلد باشد ، گویف ياز رکوردها که دارا يبه مجموعه ا -ج

 ند.یلدها گویاز ف يبه مجموعه ا -د

 ویند؟ی گکوچکترین عنصر در بانک که حاوی اطلاعات است چه م-893

 رکورد -لفا

 جدول -ب

 لدیف  -ج

 کاراکتر -د

 خواص یک فیلد مشخص کننده چیست ؟-894

 باشد. یلد مینوع ف -لفا

 .باشد یلد میک فیتعداد  -ب

 توان در نظر گرفت. یباشد که م یلد میآن ف يلازم برا يحداکثر فضا -ج

 لد است.یآن ف يلازم برا يلد و فضاینوع ف  -د

د ردیف از ........ و داده های عددی که احتیاج به محاسبات دارند از نوع داده .... اننبرای درج داده هایی م-895

 از راست به چپ((استفاده می کنیم.؟

 Number - Currency -لفا



 Text - Number -ب

 Number - Auto number  -ج

 Text - Auto number -د

 ه می شود؟فادکدام نوع داده برای قرار دادن تصویر در بانک اطلاعات است-896

 OLE  -لفا

 Memo -ب

 Lookup Wizard -ج

 Text -د

 د؟شو می استفاده داده نوع کدام از جهت ذخیره متن های طولانی-897

 Text -لفا

 Comment -ب

 Long Text  -ج

 number -د

 کدام فیلد نوع داده می تواند اعداد ، علائم و حروف را در خود ذخیره کند؟-898

 text  -لفا

 Currency -ب

 Attach َ-ج

 ole -د

 ؟نمی باشدکدام جمله در مورد کلید اصلی درست -899

 است. ید اصلیاز آنها کل یکی یباشد ول يدیلد کلیچند ف يک جدول ممکن است دارای -لفا

 ر منحصر بفرد است.یمقاد يلد باشد که دارایا چند فیاز دو  يتواند مجموعه ا یم ید اصلیکل -ب

 شود. ین جداول استفاده میب جاد ارتباطیا يبرا ید اصلیاز کل -ج

 توان استفاده نمود. ین جداول نمیجاد ارتباط بیا يبرا ید اصلیاز کل  -د

 کدام گزینه را انتخاب می کنیم؟ Data Baseبانک اطلاعاتی در پنجره  لیست جداولبرای مشاهده -900

 Objects -لفا

 Tables  -ب

 Reports -ج

 Open Table -د

 نمود؟ ویرایش و مشاهده را ولجد های داده  ......نمای در-901

 Data base  -لفا

 Data Sheet -ب

  design -ج

 جدول - یدرخت -د

 مکان نما به کجا منتقل می شود؟ Home +  Ctrlبا استفاده از کلیدهای ترکیبی -902

 شود. یلد رکورد اول منتقل مین فیمکان نما به اول  -لفا

 .شود یمنتقل م يلد رکورد جارین فیمکان نما به اول -ب

 شود. یلد اول رکورد آخر منتقل میمکان نما به ف -ج

 شود. یمنتقل م  یتنلد مین فیمکان نما به اول -د

 جهت انتخاب کلیه رکوردها از کدام کلیدهای ترکیبی استفاده می شود؟-903

 Alt + S -لفا



 Ctrl + A  -ب

 Ctrl + R -ج

 Alt + A -د

 ؟باشدمی ن کدام گزینه برای تغییر نام فیلد در جدول صحیح-904

 . ر دادییلد را بتوان تغیتا نام ف Data sheet  يچ به نمایسوئ -لفا

 Data Sheet يد در نمایپ نمودن نام جدیلد و تایعنوان ف يک رویدوبار کل -ب

 Sheet Data يلد در نماینام ف يک راست رویکل  -ج

 Rename Columnنه یلد و انتخاب گزینام ف يک راست رویکل -د

 ترکیبی بانک اطلاعاتی جاری بسته می شود؟ید توسط کدام کل-905

 Alt + F4  -لفا

 Ctrl + F5 -ب

 Ctrl + F4 -ج

 Alt + F5 -د

 جهت انتقال مکان نما به فیلد قبلی از کدام گزینه استفاده می شود؟ Data Sheetدر نمای -906

 Tab -لفا

 Alt -ب

 Ctrl -ج

 دیکل صفحه یجهت يدکمه ها -  shift+tab  -د

 ؟صحیح نیستکدام گزینه  fileاز   ewNهگزین انتخاب با-907

 شود . یجاد مید ایجد یک بانک اطلاعاتیم یتقبه طور مس -لفا

 م .ید را وارد کنیشود تا نام بانک اطلاعات جد یباز م File New Data baseپنجره  -ب

 شود . یم ، ظاهر میم بسازیخواه یکه م يدیفه جهت انتخاب نوع بانک اطلاعات جدیقاب وظ -ج

 گردد. یجاد مید ایک جدول جدی  -د

 ؟نمی باشندای ایجاد جدول در بانک اطلاعاتی کدامیک از روش ه-908

 table wizardجاد جدول با استفاده  یا -لفا

 Data sheetجاد جدول با استفاده از یجاد ایا  -ب

 Table & Borderجاد جدول با استفاده از نوار ابزار یا -ج

 Design Viewجاد جدول با استفاده از یا -د

 چه مقدار است؟ shortText طول پیش فرض فیلدهای متنی -909

 کاراکتر 50  -لفا

 کاراکتر 255 -ب

 کاراکتر 60 -ج

 کاراکتر 128 -د

 بطور پیش فرض ................. برای آن در نظر گرفته می شود.؟ Numberبا انتخاب فیلد -910

 Integer -لفا

 Long Integer  -ب

 Single -ج

 Double -د

 نمی باشد؟مجاز چه مقادیری در فیلد کلیدی  درج-911

 یر متنیمقاد -لفا



 ير عددیمقاد -ب

 ( Null)  یر تهیمقاد -ج

 ( Null)  یر تهیو مقاد ير تکراریمقاد  -د

 فیلد باعث .................. ؟ Indexedاز خاصیت   Yes ( Duplicate Okانتخاب خاصیت ) -912

 باشد. يتواند تکرار یجدول م يالد در رکوردهین فیو ا شود یلد میف يندکس بر رویجاد ایا  -لفا

 باشد. يتواند تکرار یجدول نم يلد در رکوردهاین فیشود و ا یلد میف يندکس بر رویجاد ایا -ب

 شود. یجاد نمیندکس ایت ایلد خاصیف يبر رو -ج

 لدهایندکس در کل فیجاد ایا -د

 .انتخاب می کنیم تب ............ از را   Sortجهت مرتب نمودن داده های جدول گزینه -913

 field -لفا

 home  -ب

 table -ج

 Database Tools -د

 درست است؟ Data sheetکدام گزینه برای حذف فیلد در نمای -914

 م .یده یرا فشار م Delete fieldد یک کرده و پس از انتخاب ستون کلیلد کلیف  يبر رو -لفا

 م .یکن یانتخاب م  homeبونیرا از ر Delete Columnنه یگزک کرده سپس یلد کلیعنوان ف يبر رو -ب

 م .یکن یرا انتخاب م Deleteنه یک راست گزیلد را انتخاب نموده و از کلیف -ج

 میده یرا فشار م Delete fieldد یک راست کرده و سپس کلیلد کلیف  يبر رو  -د

 کدام کاراکتر از علائم مجاز برای نام گذاری فیلدها می باشد؟-915

 نقطه -لفا

 رهیخط ت  -ب

 علامت تعجب -ج

 علامت کروشه -د

 جهت تعیین عبارتی به عنوان قانون جهت ورود اطلاعات کدام یک از قسمتهای زیر تغییر داده می شود؟-916

 Field Size -لفا

 Validation Rule  -ب

 Validation Text -ج

 Caption -د

 ............ هستیم د .اتی نیازمنبرای ایجاد ارتباط بین جداول بانک اطلاع-917

 يدیلد کلیک فی  -لفا

 یلد ارتباطیک فی -ب

 لد کدیک فی -ج

 یخطوط ارتباط -د

 ؟به عنصری از بانک اطلاعاتی که جهت  ورود یا تغییر اطلاعات بکارمی رود چه می گویند -918

 Form  -لفا

 Design -ب

 Dialog Box -ج

 Window -د

 یر یا تعیین ...............؟تغیجره خصوصیات فرم جهت در پن Formatسربرگ -919

 رود . یکنترل بکار م يات قالب بندیخصوص  -لفا



 رود . یکنترل بکار م يات داده هایخصوص -ب

 رود . یداد در فرم بکار مینحوه فعال شدن رو -ج

 کند . یم میات کنترل را تنظیر خصوصیسا -د

 ل می کند ؟فعام ، کنترل را فعال یا غیر کدام امکان در پنجره خصوصیات فر-920

 Format -لفا

 Event -ب

 Enable  -ج

 Other -د

 برای ایجاد یک پرس وجو کدام گزینه مورد استفاده قرار می گیرد؟-921

 Macro -لفا

 Report -ب

 Table -ج

 Query  -د

 اندازه داده نوع متنی چقدر می باشد ؟-922

 تیبا 8 -لفا

 تیبا 64000 -ب

 تیبا 255  -ج

 ندارد یتیمحدود -د

 تصویر در فرم از کدام تب استفاده می کنیم ؟ یک برای درج-923

 Insert -لفا

 Image -ب

 File -ج

 Format  -د

 ؟نمی شود کدام گزینه یک نوع  داده در محیط اکسس محسوب -924

 Text -لفا

 Memo -ب

 Ole -ج

 Form  -د

 گویند؟.............. را باشد می موجودیت کی مورد ر چند سطر که درمع آوری و سازمان دهی اطلاعات د-925

 رکورد -لفا

 لدیف -ب

 داده گاهیپا -ج

 جدول  -د

 ؟...................جهت Tableاز گروه  Design Viewزینه گ-926

 زاردیو بصورت دیجد فرم کی جادیا -لفا

 زاردیو بصورت دیجد جدول کی جادیا -ب

 جدول از استفاده بدون دیجد فرم جادیا -ج

 اردزیود بدون استفاده از یجاد جدول جدیا  -د

 برای ایجاد یک فرم از...................؟-927

 Create-Form Design  -لفا



 Home -Form View -ب

 Insert- Form Design -ج

 Insert -Form View -د

 ؟ شود می استفاده کدام گزینه برای ایجاد گزارش از -928

 Query -لفا

 Report  -ب

 Form -ج

 Table -د

 باط باشد ؟ارتاگر جدول بخواهد با جدول دیگر در -929

 لد داشته باشد .یف10د حد اقل یبا -لفا

 رکورد داشته باشد .10د حداقل یبا -ب

 ه داشته باشد .ید اولیک کلید یبا  -ج

 ن نگه داشت .ییرا پا CTRLد ید کلیبا -د

انتخاب کدام موردباعث می شود که رکوردهای پیدا شده به صورت نزولی  Query درهنگام طراحی یک-930

 ؟مرتب باشند

 Ascending -لفا

 Not Sorted -ب

 Descending  -ج

 Sort By Name -د

 برای چه منظوری گذاشته شده است ؟ Criteriaسطر  Queryدر جدول -931

 Sortبراي تعیین روش  -لفا

 ردها جهت نمایشبراي معیار انتخاب رکو  -ب

 تعیین جدول مورد نظر -ج

 ذکر عناوین فیلدهاي مورد نظر -د

 پرسیده شود تعیین معیار ای سؤالی مبنی بر محاوره توسط یک کادر Queryرایاج برای اینکه هنگام-932

 کدام مورد زیر را می توان قرار داد ؟ criteria درسطر

 { ?}  -لفا

 رد نمایید .{} لطفاً عبارت مورد نظر را وا -ب

 [ ?]   -ج

 / ?/  -د

ر آن اصفهان باشد ، از کدام نوع فیلتر شه اگر بخواهیم رکوردهایی خاص را مشاهده کنیم .به طور مثال فیلد-933

 باید استفاده کنیم ؟

 Filter By Form -لفا

  Filter -ب

 Sort  -ج

 Advanced Filter / Sortو Filter- Selection  -د

 طبق نتیجه مشاهده برای کردیم اعمال را فیلتری Advanced Filter - Sortکه با استفاده ازبعداز این-934

 ؟ مودن لعم باید گزینه کدام

 Filter By Selection -لفا

 Remove Filter - Sort -ب



 Apply Filter -  Sort  -ج

 Save Record -د

 داده صفحه جدول یک سطر مقدار از قسمتی اب که ببینید خواهید همه سطرهایی را ازجدول تان اگر می-935

 کنید؟ استفاده ......... از دارند تطبیق

 Find -لفا

 Replace -ب

 Selection  filter  -ج

 view -د

 تعریف زیر معرف کدام یک از موارد زیر است ؟-936

 "ص شده اند .محدود کردن نمایش اطلاعات بانک اطلاعاتی به رکوردها و فیلدهایی که براي تطبیق مشخ "

 گزارش گیري  -الف

 ارتباطات در بانک -ب

 مرتب کردن -ج

 فیلتر -د

 ؟ نمی باشد t porReکدام یک از موارد زیر از قسمتهای طراحی -937

  Detail -لفا

  Report Header -ب

  Page Header -ج

  Summary  -د

 کدامیک از موارد زیر صحیح می باشد ؟-938

 ي از گزارش ها ساخته می شود .جدول از مجموعه ا -لفا

 به هر یک از اطلاعات مربوط به موجودیت جدول گفته می شود . -ب

 ک موجودیت فرم گفته می شود .ه یبه مجموعه اي از فیلد هاي مربوط ب -ج

 جدول از مجموعه اي از رکورد ساخته می شود . -د

 انجام داد ؟ Data Sheet Viewکدامیک از موارد زیر را نمی توان در -939

 حذف رکورد -لفا

 اصلاح رکورد -ب

 اضافه کردن رکورد -ج

 جاد فرمیا -د

 چپ با جزئیات دیده می شوند ؟مت آیکن های پانل س Data Baseدر کدام حالت نمایش در پنجره  -940

 Small Icons -لفا

 List -ب

 Details -ج

 Large Icons -د

 طلاعاتی چیست ؟معمولاً آخرین مرحله در طراحی بانک ا-941

 طراحی رابط کار -لفا

 رسم روند کار -ب

 مستند سازي -ج

 وارد کردن داده در برنامه و آزمایش و پالایش آن -د

 ام طراحی بانک اطلاعاتی پس از انتخاب فیلد مورد نظر بر روی کدام  دکمه ازهنگبرای تعیین کلید اولیه در -942



 نوار ابزار باید کلیک نمود ؟ 

 Indexes -الف

 Build -ب

 Primary Key -ج

 Data Base Window -د

 را از کدام تب کلیک می کنیم ؟  New Recordبرای اضافه کردن یک رکورد جدید گزینه -943

 home -لفا

 Format -ب

 table -ج

 Insert -د

 کلیک می کنیم ؟createبرای ایجاد گزارش کدام مورد را از تب  -944

 Forms -لفا

 Reports -ب

 Queries -ج

 Table -د

 برای تعیین فیلتر پیشرفته کدام گزینه زیر صحیح است ؟-945

 Filter By Form -لفا

 Sort -ب

 Filter By Selection -ج

 Advanced Filter / Sort -د

رش سر صفحه که یک بار در اول گزارش به عنوان تیتر و یک پاورقی که یکبار در انتهای گزااد برای ایج-946

 انتخاب می کنیم تا متن مورد نظر را در آن قسمتها قرار دهیم ؟ designچاپ شود کدام  مورد را از تب 

 Report Header/ Footer -لفا

 Page Header/ Footer -ب

 Data Base -ج

 Format -د

 ؟ یستن Data Baseهای پنجره   Objectکدام یک جزو  کسسدر ا-947

 Report -لفا

 Table -ب

 Data Base -ج

 Forms -د

 کاربرها برای راحتی کار یا کاربرانی که حرفه ای نیستند برای ایجادفرم ،گزارش و .............. بهتر است ازکدام-948

 روش استفاده نمایند ؟ 

 Desing -الف

 Wizard -ب

 File - New Form -ج

 createt - Form -د

بنا برخواسته خود بصورت دستی آنها را  ............ که طراح می تواند برای طراحی فرم ،گزارش،جدول و-949

 طراحی کند از کدام روش استفاده می شود ؟

 Design -لفا



 Wizard -ب

 File - New Form -ج

 create - Form -د

 ؟ود در اکسس هر ستون از جدول چه نامیده می ش-950

 Cells -لفا

 Fields -ب

 Rows -ج

 Records -د

 های زیر سؤالی از بانک اطلاعاتی می پرسد سپس نتیجه را نشان می دهد ؟ Objectکدامیک از -951

 Tables -لفا

 Reports -ب

 Queries -ج

 Forms -د

 ؟نیست  Accessهای زیر مربوط به  Objectکدامیک از -952

 Tables -لفا

 Queries -ب

 Forms -ج

 Workbooks -د

اضافه کند چه اتفاق می  Queryستاره را از لیست فیلدها به لیست فیلد   Queryطراحی اگر در هنگام -953

 افتد ؟

 می کند .  Sortرکوردهاي جدول را براساس دستوري که تعیین می کند  Query -لفا

 رکوردهاي جدول را بدون نمایش آنها مورد استفاده قرار می دهد . Query -ب

 شامل می شود . ام فیلدهاي جدول راتم Query -ج

 هیچکدام از فیلدهاي جدول را شامل نخواهد شد . Query -د

قرار دهیم باعث خواهد شد که رکوردهایی پیدا شوند که فیلد »  Criteriaکدام یک از موارد زیر را در -954

 است ؟ "Nice "شخصیت « آنها مخالف 

  >Nice  -لفا

 < >”Nice“ -ب

 Is   Nice -ج

 Not Nice -د

 زارش ها و فرمها اطلاعاتشان را از کجا می توانند دریافت کنند ؟گ-955

 Tables -لفا

 Forms -ب

 Queries -ج

 Report -د

 کدام مرحله است ؟ Wizardاولین مرحله در هنگام طراحی فرم یا گزارش از طریق -956

 انتخاب اینکه چگونه گزارش یا فرم قالب بندي شوند . -لفا

 می خواهید در فرم یا گزارش ظاهر شوند .که یی انتخاب فیلدها -ب

 که شما می خواهید گزارش یا فرم براساس آن صورت گیرد . Queryانتخاب جدول یا  -ج

 تا اینکه مراحل ویزارد تمام شوند . Nextخواندن چندین صفحه پشت سر هم و کلیک بر روي  -د



 ؟ داده نیستکدامیک از موارد زیر از انواع -957

 Picture/Graphic -لفا

 Number -ب

 Text -ج

 Date/ Time -د

 در کدام یک از موارد زیر کاربرد دارد ؟ Long Textفیلد از نوع -958

 هستند . 255براي فیلدهایی که داراي کاراکترهاي کمتر از  -لفا

 براي متنهاي طولانی که بیشتر از یک یا چند کلمه هستند . -ب

 و ... Wordه هاي دیگر ایجاد شده اند مانند گرافیک یا فایل نامدر بربراي ذخیره کردن موضوع هایی که  -ج

 ریدرج تصو يبرا -د

 مناسب تر است ؟  Primary Keyکدامیک از فیلدهای زیر برای-959

 فیلد تاریخ -لفا

 number Autoفیلد  -ب

 فیلد شماره عضویت فرد در کتابخانه -ج

 نام فرد -د

 ؟ یستدرست نرد خصوصیت کدامیک از موارد زیر در مو-960

 به صورت اتوماتیک در هنگام ایجاد رکورد جدیددر فیلدها وارد می شود. Defaultمقدار  -لفا

 ( را وارد نمود .-) - -می توان عبارتی به صورت  Requiredدر مقابل خصوصیت  -ب

 تعیین می کند کاربر باید در فیلد مقدار وارد کند یا نه . Requiredخصوصیت  -ج

 می دهد که مقدار فیلد را از یک لیست از مقادیر وارد نمود . ازهاج Look Upفیلد  -د

 ؟صحیح نیست کدامیک از موارد زیر -961

 از تکراري بودن ورودي ها محافظت می کند . Yes(No Duplicates)به صورت  Indexedقرار دادن  -لفا

 به صورت اتوماتیک ایندکس می شود .   Primary Key -ب

 را ایندکس کنید . Text ،Ole Object  ،Hyper Linkز فیلدهاي م اشما می توانید هر کدا -ج

 No  ،Yes(Duplicate Ok)،Yes(Noبه سه حالت می تواند تنظیم شودکه عبارتنداز : Indexخصوصیت  -د

Duplicate) 
 کدام یک نادرست است ؟-962

 است .  255برابر  Memoماکزیمم طول فیلد  -لفا

 تعیین کنید وارد کردن داده به فیلد اجباري است . که به شما اجازه می دهد Required -ب

 تعیین می کند که در هنگام ایجاد رکورد جدید این مقدار به صورت اتوماتیک به فیلد داده می شود . Defaultمقدار  -ج

 ر می رود .براي تعیین ارزیابی مقدار داده وارد شده به فیلد به کا Validation Rule -د

 ؟نمی توان نوشت Queryدر هنگام طراحی  Criteriaر را در مقابل زی کدامیک از موارد-963

 ”Harris“ -لفا

 No Value -ب

 <500 -ج

 Between   1.1.2005    And   12.30.2006 -د

 ؟نیست  Reportکدامیک از موارد زیر از بخشهای یک -964

 Summary Section -لفا

 Detail Section -ب

 Report Header Section -ج



 Page Header Section -د

965-Primary Key  برای .......................؟ 

 ) یکتا ( کردن رکوردهاي جدول Uniqueبراي  -لفا

 کردن رکوردهاي جدول Sort -ب

 فیلد هاي جدول يساز Uniqueبراي  -ج

 جدول يلدهایکردن ف  sortبراي  -د

 کدام نرم افزار زیر یک بانک اطلاعاتی است ؟-966

 Fox pro -لفا

 Access -ب

 Visual Basic -ج

 Word -د

 بزرگ یا کوچک حروف با اینکه مثلاً . کند می مشخص را فیلد نمایش کدام خواص زیر در فیلد ها قالب-967

 ؟ شود داده نمایش

 Caption -لفا

 Indexed -ب

 Format -ج

 Validation Rule -د

 ی باشد ؟خال نمی تواندکدامیک از خواص زیر در فیلد ها نشان می دهد که این فیلد -968

 Precision -لفا

 Scale -ب

 Allow Zero Length -ج

 Required -د

می تواند ذخیره شود درکدام خواص فیلد  Decimalتعداد ارقام اعشاری را دریک فیلد عددی ازنوع -969

 مشخص می شود ؟

 Scale -لفا

 Input Mask -ب

 Decimal places -ج

 Default Value -د

 تصویر در بانک اطلاعاتی استفاده می شود ؟دن کدام نوع داده برای قرار دا-970

 Memo -لفا

 Number -ب

 Ole -ج

 Look Up Wizard -د

در کدامیک ازخواص  Decimalرای اعداد تعداد کل ارقامی که بعد از نقطه اعشار می تواند ذخیره شود ب-971

 فیلد مشخص می شود ؟

 Precision -لفا

 Scale -ب

 Decimal places -ج

 Default Value -د

 دام نوع داده برای متن و یا ترکیب متن و عدد مناسب است ؟ک-972



 Text -لفا

 Number -ب

 Currency -ج

 Auto Number -د

 ؟ندارد ای از نوع متنی است و همچنین از نظر طول فیلد محدودیتی کدام نوع داده زیر برای داده ه-973

 Long Text -لفا

 Text -ب

 Currency -ج

 Auto Number -د

یات فیلدها برای تعیین عبارتی به عنوان قانون جهت ورود اطلاعات برای تشخیص داده صوصکدامیک از خ-974

 ؟است  ، های نامعتبر

 Validation Text -لفا

 Validation Rule -ب

 Input Mask -ج

 Require -د

 ؟ کند می ایجاد بصورت منو کدام نوع داده ، فیلدی شامل اقلام مختلف-975

 Number -لفا

 Look Up Wizard -ب

 Text -ج

 Memo -د

 از کدام قسمت استفاده می شود ؟ Field Propertyجهت تعیین برچسب فیلد در -976

 Validation Rule -لفا

 Field Size -ب

 Caption -ج

 Pages -د

 کدامیک پرسشی است که از داده های ذخیره شده در جدول مطرح می شود ؟-977

 Queries -لفا

 Tables -ب

 Forms -ج

 Pages -د

 می Access در تکراری کارهای جهت شده تعریف قبل برنامه نویسی از استفاده از کد های  رایکدامیک ب-978

 باشد؟

 Pages -لفا

 Macros -ب

 Modules -ج

 Forms -د

 کدام کلید مکان نما را به اولین فیلد رکورد جاری منتقل می کند ؟-979

 Home -لفا

 End -ب

 Page Up -ج



 Page Down -د

( جهت ذخیره سازی اعداد با دقت اعشاری مضاعف استفاده می Number)  ددیکدام نوع اندازه داده ع-980

 شود ؟

 Single -لفا

 Double -ب

 Integer -ج

 Long Integer -د

را جهت کنترل ورود اعداد اعشاری در اختیار ما  Precisionو  Scaleکدامیک از انواع داده عددی خواص -981

 قرار می دهد ؟

 Double -لفا

 Single -ب

 Replication Id -ج

 Decimal -د

 ؟ ستین Indexedکدامیک از مقادیر مختلف -982

 Yes(Duplicate Ok) -لفا

 No -ب

 Yes(No Duplicate) -ج

 code uni -د

 بر روی کدام یک از نوع فیلدها نمی توان ایندکس ایجاد کرد ؟-983

 Number -لفا

 Ole -ب

 Text -ج

 بر روي همه نوع فیلد می توان ایندکس ایجاد کرد . -د

رد کدامیک از انواع داده ای زیر استفاده می + میلیا3میلیارد و  -3ت ذخیره سازی اعداد صحیح بین جه-984

 شود ؟

 Byte -لفا

 Double -ب

 Decimal -ج

 Long Integer -د

 در تمام صفحه گسترده است ؟ Excelکدامیک از روشهای ایجاد فرم شبیه سربرگ -985

 Columnar -لفا

 Tabular -ب

 Data Sheet -ج

 Auto Wizard -د

 ؟Tabularبا ایجاد فرم به صورت -986

 می توانیم فرم را به صورت جدولی از فیلدها در رکوردها داشته باشیم . -لفا

 می توانیم نوعی فرم ستونی ایجاد کنیم . -ب

 می توانیم فرمهاي معمولی ایجاد کنیم . -ج

 نمی توانیم فرمهاي معمولی ایجاد کنیم -د

 ؟نیست رم ی فکدامیک از بخشهای اصل-987



 Detail -لفا

 Form Header -ب

 Form Footer -ج

 Form View -د

 کدام انتخاب نوع فرم را ستونی ایجاد می کند ؟-988

 Tabular -لفا

 Columnar -ب

 Form Wizard -ج

 Data Sheet -د

.. می ...استخراج اطلاعات و داده های خواسته شده از یک بانک اطلاعاتی و ارائه آنها برای استفاده را ...-989

 گویند .

 Table -لفا

 Page -ب

 Query -ج

 Macro -د

 بکار می روند ؟ Query و طراحی   کدامیک از معمولی ترین نماها برای مشاهده-990

 Data Sheet Viewنماي  -لفا

 Design View -ب

 Design Viewو  Data Sheet Viewنماي  -ج

 Data Type View -د

 بانک اطلاعاتی از کدام یک از اشیا زیر استفاده می شود؟ ه درشد جهت استفاده از عملیات تکراری انجام-991

 Tables -لفا

 Reports -ب

 Macro -ج

 Queries -د

نوشته شود،برای دارا بودن هردو شرط عملگر بین آنها ، کدام  Criteriaهنگامی که دو عبارت شرطی در -992

 است ؟

 Not -لفا

 Xor -ب

 And -ج

 Or -د

 ؟ استدی کدام نوع مرتب سازی صعو-993

 Ascending -لفا

 Descending -ب

 Grouping -ج

 Sorting -د

 در هنگام ایجاد گزارش ، چه چیز را تعیین می کنیم ؟ Orientationدر قسمت -994

 صعودي و نزولی بودن رکوردها -لفا

 جهت چاپ گزارش بر روي کاغذ -ب

 گروه بندي رکوردها -ج



 نوع گزارش -د

 میانگین   اعداد را محاسبه می کند ؟ ش ،در طراحی گزارکدام یک از توابع زیر -995

 Count -لفا

 Sum -ب

 Maximum -ج

 Average -د

از چه قسمتی در هنگام ایجاد گزارش  اگر بخواهیم لیست کارمندان بر اساس استان دسته بندی شود،-996

 استفاده می کنیم ؟

 Orientation -لفا

 Group -ب

 Order -ج

 Layout -د

 چاپ می شود ؟در ابتدای گزارش  باریکام ناحیه از گزارش فقط کد-997

 Page Footer -لفا

 Report Footer -ب

 Report Header -ج

 Page Header -د

 کدام کنترل زیر در طراحی گزارش برای نمایش متن فیلدها استفاده می شود ؟-998

 Text Box -لفا

 Lable -ب

 Image -ج

 Line -د

 ستفاده می شود ؟د المات همجوار و پشت سر هم از کدام کلیبرای انتخاب ک-999

 Ctrl -لفا

 Alt -ب

 Tab -ج

 Shift  -د

 برای انتخاب چند خط از کدام گزینه زیر می توان استفاده کرد؟-1000

 یجهت يدهایهمراه با کل Altد یکل -لفا

 دن ماوس به طرف انتهایک کردن بر مبدا و کشیکل  -ب

 Altد یانتخاب کلمات همراه با فشردن کل ک و درگ ماوس ویکل -ج

 یجهت يدهایهمراه با کل Ctrlد یکل -د

 برای تعیین فاصله بین اجزای یک متن، از زبانه ............. از کادر محاوره ............ استفاده می کنیم .-1001

 Fontاز  character spacingزبانه   -لفا

 Paragraphاز   Line and page breaksزبانه  -ب

 Paragraphاز  character spacingزبانه  -ج

 Fontاز  Line and Page Breaksزبانه  -د

 کدام زبانه را انتخاب می کنیم ؟  Symbolبرای درج کاراکترهای ویژه از کادر محاوره ای -1002

 Special Characters -لفا

 Symbol -ب



 Insert  -ج

 Shortcut -د

 تفاده می کنیم؟اس نبر در کادر سفارشی کردن کلید میانبر برای نمادها از کدام دکمهبرای حذف کلید میا-1003

 Assign -لفا

 Reset All -ب

 Remove  -ج

 Close -د

 را می توان: Wordروش های تغییر نما در -1004

 فعال کرد Viewاز زبانه   -لفا

 فعال کرد  Reviewاز زبانه  -ب

 ط نرم افزار قرار دارد فعال کردیچپ  محکه در سمت  ییق دکمه هایاز طر -ج

 ن را فعال کردآ  File يق منویتوان از طریم -د

 توان نماها را در ورد تغییر داد؟از کدام روش می-1005

 قرار دارند Wordط ین و سمت راست محییکه در گوشه پا ییق دکمه هایاز طر  -لفا

 توان فعال کرد یم Showگروه  Viewانه یاز ز -ب

 توان فعال کردیم Insertاز زبانه  -ج

 قرار دارند wordط یت چپ محسم ن وییکه در گوشه پا ییق دکمه هایاز طر -د

 تعریف سبک چیست؟-1006

 ندیگو یسبک م wordموجود در  يه ابزار هایبه کل -لفا

ک نام مشخص یند که با ک کاراکتر مشخص شده هستی يف شده مانند فونت، رنگ، اندازه برایش تعریاز پ يبندقالب  -ب

 شوندیره میذخ

 ندیک سبک گویهر انتخاب را  -ج

 ندیرا گو  wordمتن در ش ینما يروش ها -د

 انتخاب یک سبک از کدام روش صورت می گیرد؟-1007

 Homeاز زبانه  Styleانتخاب   -لفا

 Reviewاز زبانه  Styleانتخاب  -ب

 Designاز زبانه  Styleانتخاب  -ج

 Viewاز زبانه  Style انتخاب -د

 از روی خط کش چگونه عمل می شود ؟  Tabبرای حذف یک -1008

 میکن یرون از خط کش درگ میرا به بظر تب مورد ن  -لفا

 میده یرا فشار م Deleteد یتب مورد نظر اشاره کرده و کل يبر رو -ب

 م یکن یک میکل Createدکمه  يپس از انتخاب تب مورد نظر بر رور Tabs ياز کادر محاوره ا -ج

 م ینیگز یرا بر م Remove Tabنه یگز Tabs ياز کادر محاوره ا -د

 از روی خط کش چگونه عمل می شود ؟  Tabبرای حذف یک -1009

 میکن ید حذف میاز صفحه کل Backspaceد یتب مورد نظر را با کل -لفا

 میهد یرا فشار م Deleteد یتب مورد نظر اشاره کرده و کل يبر رو -ب

 م یکن یک میکل  Clearدکمه  يپس از انتخاب تب مورد نظر بر رور Tabs ياز کادر محاوره ا  -ج

 م ینیگز یرا بر م Remove Tabنهیگز Tabs يمحاوره ا ادراز ک -د

برای اولین کاراکتر تمام واژه های متن انتخاب شده از حروف کوچک  Change Caseکدام گزینه از -1010

 ؟استفاده می کند



 Uppercase -لفا

 Title Case -ب

 Lowercase -ج

 Toggle Case  -د

 اسب است ؟من کدام گزینه Wordبرای اصلاح خودکار متن ها در -1011

 Auto Format -لفا

 Auto Correct  -ب

 Auto Select -ج

 Auto Change -د

 زینه ............................... را انتخاب می کنیم.برای خطایابی املایی و گرامری از سربرگ ........................ گ-1012

 Home > Spelling -لفا

 View > Grammar -ب

 Review > Spelling & Grammar  -ج

   Insert > Spelling & Grammar -د

 هنگامی که در زیر کلمه یک خط قرمز موج دار کشیده می شود برای تصحیح آن می توان :-1013

 ک کرده و خط موج دار را حذف نمودیدوبار کل آن يرو -لفا

 د.ینیانبر بر گزیم يرا از منو يشنهادیپ يهااز واژه یکیک راست نموده و یآن کل يرو  -ب

 مینیگز یرا بر م Formatنه یک راست کرده و گزیکلمه کل يرو -ج

 میفشار یرا م  Deleteم و دکمه یکن یکلمه را انتخاب م -د

 زیر کلمه یک خط قرمز موج دار کشیده می شود برای تصحیح آن می توان:هنگامی که در -1014

 دییک کرده و خط موج دار حذف نمایآن دوباره کل يرو -لفا

 مینیگز یرا بر م Changeنه یراست نموده و گز کیلآن ک يرو -ب

 دینیرگزرا ب  Autocorrectو   Ignore All ينه هایاز لغات گز یکیک راست نموده و یآن کل يرو  -ج

 م .یفشار ید میرا از صفحه کل caps lockکلمه را انتخاب و بعد دکمه  -د

 خط قرمز در زیر کلمه به چه معنی ست ؟-1015

 دارد يامرکلمه مشکل گر -لفا

 دارد يکلمه مشکل نوشتار  -ب

 کلمه مشکل فرمت دارد -ج

 ش است.یرایرقابل ویکلمه غ -د

 ی دارد؟خط آبی در زیر کلمات چه معنای-1016

 دارد يکلمه مشکل گرامر  -لفا

 دارد يکلمه مشکل نوشتار -ب

 کلمه مشکل فرمت دارد -ج

 ش است.یرایرقابل ویکلمه غ -د

1017-Fixed Column Width  حیه نا واقع درAuto fit  چه عملی انجام می دهد؟ 

 م شود.یظتن ینیجدول برابر با طول مع يه سطرهایدهد که طول کل ین امکان را میا -لفا

 م کندیتنظ ینیجدول را برابر با طول مع يه سطرهایکل يدهد که پهنا ین امکان را میا -ب

 م کندیتنظ ینیطول مع با جدول را برابر يه ستون هایدهد که طول کل ین امکان را میا -ج

 م کند.یتنظ ینیجدول را برابر با طول مع يه ستون هایکل يدهد که پهنا ین امکان را میا  -د

 کدامیک از گزینه ها در رابطه با ایجاد جدول به روش ترسیم صحیح است؟-1018



 Tableاز سربرگ  Insertنه یانتخاب گز -لفا

 Homeاز سربرگ  Tableنه یانتخاب گز -ب

 Tableاز سربرگ  Draw Tableنه یگز خابانت -ج

 Tableگروه   Insertاز سربرگ  Draw Tableانتخاب   -د

سطر در  Layout ،5از سربرگ  Insert Belowسطر آخر یک جدول و انتخاب گزینه  5با انتخاب -1019

 ............سطرهای انتخاب شده ایجاد می شود 

 بالا -لفا

 نییپا  -ب

 سمت راست -ج

 سمت چپ -د

سطر در  Layout ،5از سربرگ   Insert Aboveسطر آخر یک جدول و انتخاب گزینه  5تخاب ان با-1020

 ........ سطرهای انتخاب شده ایجاد می شود ..........

 بالا  -لفا

 نییپا -ب

 سمت راست -ج

 سمت چپ -د

......... ...سطر در  Layout ،5از سربرگ  Insert Rightسطر آخر یک جدول و انتخاب گزینه  5با انتخاب -1021

 سطرهای انتخاب شده ایجاد می شود.

 بالا -لفا

 نییپا -ب

 سمت راست  -ج

 چپسمت  -د

سطر در .............  Layout ،5از سربرگ  Insert Leftسطر آخر یک جدول و انتخاب گزینه  5با انتخاب -1022

 سطرهای انتخاب شده ایجاد می شود.

 بالا -لفا

 نییپا -ب

 سمت راست -ج

 سمت چپ  -د

 ی ترسیم جدول با استفاده از مداد از چه دستوری استفاده می شود؟برا-1023

 Insert table -لفا

 Quick Table -ب

 Draw Table  -ج

 Write Table -د

 برای تبدیل نوشته های جدول به نوشته های بدون کادر از کدام دستور استفاده می کنیم؟-1024

 Repeat Header Rows -لفا

 Convert to Text  -ب

 Convert to table -ج

 Convert to Formula -د

 جهت تغییر اندازه یک شکل پس از انتخاب آن شکل صحیح است؟ کدام یک از موارد زیر-1025

 سر 4کان یپ -لفا



 سر 2کان یپ  -ب

 شکل يره بالایدا -ج

 Borderدستور  -د

 جهت چرخاندن اشکال کدام یک از مراحل زیر صحیح است؟-1026

 Insert -> Rotate -لفا

 View -> Rotate -ب

 Home -> Rotate -ج

 Format -> Rotate  -د

 برای شمارش تعداد کاراکترهای متن یک سند از کدام فرمان استفاده می کنیم؟-1027

 View ياز منو Word Countفرمان  -لفا

 Review ياز منو Word Countفرمان   -ب

 Home ياز منو Word Countفرمان  -ج

 References ياز منو Word Countفرمان  -د

 ام پستی روی کدام دکمه کلیک می شود؟برای انتخاب گیرندگان در فرم ادغ-1028

 Edit Recipients -لفا

 Select Recipients  -ب

 Update Labels -ج

 Match Field -د

 کدام است ؟ Subscriptکلید میانبر دستور -1029

 + ( Ctrl -لفا

 + = Ctrl  -ب

 + = Ctrl + Shift -ج

 + ] Ctrl -د

 استفاده کلید ترکیبی ........................ را فشار می دهیم.عات کامل از سبک مورد اطلابرای دیدن -1030

 Shift + F1 -لفا

 Ctrl + Alt + S  -ب

 Ctrl + Shift + S -ج

 Ctrl + S -د

 برای ایجاد سرصفحه و پاصفحه از کدام زبانه می توان استفاده کرد؟-1031

 Home -لفا

 Insert  -ب

 View -ج

 Design -د

با استفاده از قسمت ........ می توان سبک خط دلخواه کادر را  border and shadingای  ادر محاورهر کد-1032

 تعیین نمود.

 Color -لفا

 Art -ب

 Box -ج

 Style  -د

 برای تبدیل صفحه کلید از حالت تایپ فارسی به لاتین از چه کلید ترکیبی استفاده می شود؟-1033



 سمت راست Alt + Ctrl -لفا

 سمت چپ Ctrl + Shift -ب

 ا راستیسمت چپ  Alt + Shift  -ج

 سمت راست  Ctrl + Shift -د

 از کدام کلید ترکیبی برای انتخاب کل سند استفاده می شود؟-1034

 Ctrl + Click -لفا

 Ctrl + Shift + Click -ب

 Ctrl + End -ج

 Ctrl + A  -د

 برای ذخیره سند از کدام کلید ترکیبی استفاده می شود؟-1035

 Ctrl + o -فلا

 Ctrl + Shift + S -ب

 Ctrl + S  -ج

 Ctrl + P -د

 برای وارد کردن فرمول در سند از کدام دکمه استفاده می شود؟-1036

 Symbol -لفا

 Equation  -ب

 Formula -ج

 Comment -د

 می شود؟ برای شکستن متن و رفتن به صفحه بعد با استفاده از صفحه کلید از چه ترکیب کلیدی استفاده-1037

 F2 -لفا

 Ctrl + V -ب

 Ctrl + Enter  -ج

 Ctrl + S -د

 برای تنظیم حاشیه های سند از کدام دکمه استفاده می شود؟-1038

 Column -لفا

 Margins -ب

 Size -ج

 Orientation -د

 برای افزودن کادر به صفحه از کدام گزینه استفاده می شود ؟-1039

 Insert -> Page Break -لفا

 Page Layout -> Page Border -ب

 Design -> Page Border -ج

 Page Setup -> Line number -د

 کدام است؟ Wordنام پوشه پیش فرض برای ذخیره سازی الگوهای -1040

 Templates -لفا

 Documents -ب

 Microsoft Word -ج

 Program File -د

 جدول از کدام دکمه استفاده می شود؟برای ادغام سلول های -1041



 Split Cells -لفا

 Split Table -ب

 Merge Cells -ج

 Merge Table -د

 انتخاب می شود؟ Wrap Textبرای اینکه تصویر پشت متن قرار گیرد کدام گزینه از یخش -1042

 Tight -لفا

 Square -ب

 Behind Text -ج

 Through -د

 زبانه ................... دستور ......................... را اجرا می کنیم.برای درج شماره صفحه از -1043

 Page Number-Design -لفا

 Page Number-Review -ب

 Page Number-Home -ج

 Page Number-Insert -د

 برای نادیده گرفتن خط قرمز زیر کلمه بعد از کلیک راست کدام گزینه را بر می گزینیم؟-1044

 Add to Dictionary -لفا

 Ignore -ب

 Deny -ج

 Cancel -د

 مام کلمات مشابه آن باید کدام گزینه را انتخاب کنیم ؟و تبرای نادیده گرفتن خط قرمز زیر کلمه اشتباه -1045

 Ignore -لفا

 Ignore total -ب

 Ignore All -ج

 Deny -د

1046-Blank page  از گروهPages چه کاربردی دارد؟ 

 کند. یدرج م یحه خالک صفی -لفا

 کند یجاد میسند ا يک کاور برای -ب

 رود یبه صفحه بعد در سند م -ج

 کند. یمجادیک سند الگو ای -د

 چیست؟ Pagesدر گروه  Page Breakکاربرد دستور -1047

 کند. یدرج م یک صفحه خالی -لفا

 کند یجاد میسند ا يک کاور برای -ب

 کند یمسند را قطع  یابقشده و مان بخش انتخابیارتباط م -ج

 کند. یجاد میک سند الگو ای -د

 کنیم؟می چگونه عمل  Wordبرای استفاده از صفحه جلد در نرم افزار -1048

 cover pageدستور editingگروه  Homeزبانه  -لفا

 Cover Pageدستور  Pagesگروه  Insertزبانه  -ب

 Cover Pageدستور  Page Layoutزبانه   -ج

 Cover Pageدستور  Page Borderگروه   Designزبانه  -د

 برای ایجاد متن کمرنگ روی صفجه و پشت نوشته ها کدام دستور مناسب است؟-1049



 Page Color -لفا

 Text Color -ب

 Background Color -ج

 Watermark -د

به صورت شکل و تصویر نمایش دهید از چه برای اینکه بخواهید اطلاعاتی که به هم مربوط هستند را -1050

 استفاده می کنید؟ Wordدستوری در 

 Word Art -لفا

 Screenshot -ب

 Shape -ج

 Smart Art -د

 چه نامیده می شوند؟ Wordار افزها در جدول نرمستون-1051

 Columns -لفا

 Rows -ب

 Cells -ج

 Table -د

 ار دارند چه نامیده می شوند؟سلولهایی که به صورت افقی در جدول قر-1052

 Cells -لفا

 Columns -ب

 Rows -ج

 Table -د

 به هر خانه جدول یک ................... گفته می شود.-1053

 Rows -لفا

 Columns -ب

 Table -ج

 Cell -د

 رای وارد کردن تعداد سطر و ستون جدول در زمان ایجاد به چه روشی عمل می کنیم؟ب-1054

 Insertاز زبانه  Draw Table -لفا

 Insert Tableو انتخاب  Insertاز زبانه  Table يک رویکل -ب

 Insertاز زبانه  Input Table -ج

 Homeاز زبانه  Insert Table -د

 تعداد سطر را وارد می کنیم ؟  Insert Tableدر کدام بخش از کادر محاوره -1055

 Number of Columns -لفا

 Fixed Column width -ب

 Number of Rows -ج

 Number of Cells -د

 بعد از ایجاد یک جدول چه زبانه هایی نمایش داده می شود؟-1056

 Format, Layout -لفا

 Table, Design -ب

 Design, Table -ج

 Design, Layout -د



 ر؟تعیین می کنیم که جدول ما سطر عنوان داشته باشد یا خی Designاز زیانه خش در کدام ب-1057

 Banded Rows -لفا

 Header Row -ب

 Total Row -ج

 Last Row -د

 می توانیم اطلاعات سند را ببینیم؟ Fileدر کدام قسمت زبانه -1058

 INFO -لفا

 SHARE -ب

 EXPORT -ج

 ACCOUNT -د

 ی توان تمام صفحات سند را چاپ کرد؟م Printکدامیک از گزینه های دستور -1059

 Print Preview -لفا

 Print All Page -ب

 Print Selection -ج

 Print Current Page -د

 اگر بخواهیم فقط صفحات زوج چاپ شود چگونه عمل می کنیم؟-1060

 Odd Page -لفا

 Print All Page -ب

 Even Page -ج

 Print Current Page -د

 ی شود؟اپ از کدام دستور استفاده مت چبرای سفارشی کردن صفحا-1061

 Custom Print -لفا

 Print All Page -ب

 Print Selection -ج

 Print Current Page -د

 )توضیحات( در متن....... Commentبرای درج -1062

 View>New Comment -لفا

 Insert>New Comment -ب

 Home>New Comment -ج

 Review>New Comment -د

 از کدام مورد استفاده می کنیم؟ Wordر محیط نرم افزار رگنمایی صفحه دبز برای سفارشی کردن-1063

 Custom -لفا

 Review>Zoom -ب

 View>Zoom -ج

 View>Setting -د

 چیست؟ Fontکاربرد -1064

 مین کنییم اندازه متن را تعیتوان ینه مین گزیبا استفاده از ا -لفا

 میر دهییرا تغ یابم شکل متن انتخیتوان ینه مین گزیبا استفاده از ا -ب

 میر دهییم نوع متن را تغیتوان ینه مین گزیبا استفاده از ا -ج

 م.یکن ین مورد استفاده میفرمت دادن به متن از ا يبرا -د



 برای پاک کردن فرمت های اعمال شده روی متن کدام مورد مناسب تر است؟-1065

 Change Case -لفا

 Remove Format -ب

 Clear All Formatting -ج

 Delete Formatting -د

 چه کاری انجام می دهد؟ Strikethroughدستور -1066

 کند. یک خط درج میمتن  يرو -لفا

 کند. یر متن درج میک خط زی -ب

 کند. یل و کج میمتن را ما -ج

 کند. یمتن را توپر م -د

 برای مرتب سازی نوشته ها بر اساس عدد یا حروف الفبا سریع ترین دستور کدام است؟-1067

 Filter -لفا

 Increase Alphabet -ب

 Sort -ج

 Asset -د

 برای اینکه بخواهیم پاورقی در متن ایجاد شود از کدام گزینه استفاده می کنیم؟-1068

 End note -لفا

 Footnote -ب

 Footer -ج

 Header -د

 جدول چه کاربردی  دارد؟ DESIGNدر زبانه  Table Stylesگروه -1069

 خطوط جدول اعمال سبک بر -لفا

 دیجد يل هاسلوجاد یا -ب

 جدول ياعمال سبک رو -ج

 ریتصو ياعمال سبک رو -د

 برای تغییر رنگ سلول های جدول کدام مورد به کار می رود؟-1070

 Table Color -لفا

 Border -ب

 Fill Color -ج

 Shading -د

 ینیم؟را بر می گز Selectبرای انتخاب سطر جدول کدام یک از دستورات -1071

 Select Cell -لفا

 Select Column -ب

 Select Row -ج

 Select Table -د

 را بر می گزینیم؟ Selectبرای انتخاب ستون جدول کدام یک از  دستورات -1072

 Select Cell -لفا

 Select Column -ب

 Select Row -ج

 Select Table -د



 استفاده می کنیم ؟ Selectات برای انتخاب سلول در جدول از کدامیک از دستور-1073

 Select Cell -لفا

 Select Column -ب

 Select Row -ج

 Select Table -د

 را انتخاب می کنید؟ Selectبرای انتخاب کل جدول کدام یک از دستورات -1074

 Select Cell -لفا

 Select Column -ب

 Select Row -ج

 Select Table -د

 چه کاری انجام می دهد؟ Selectه از گرو Select Rowدستور -1075

 کند یسلول را انتخاب م -لفا

 کند. یستون جدول را انتخاب م -ب

 کند یسطر جدول را انتخاب م -ج

 کند یکل جدول را انتخاب م -د

در کادر محاوره ای ............... می توانیم اندازه ها، جهت، رنگ و تنظیمات دیگر جدول را به صورت یک جا -1076

 ین کنیم.تعی

 Table Option -لفا

 Table Setting -ب

 Table Properties -ج

 View Gridlines -د

 چه کاربردی دارد؟ Drawاز گروه  Eraserگزینه -1077

 رسم ستون و سطر جدول -لفا

 ل جدول به متنیتبد -ب

 جدول ين جهت نوشته هاییتع -ج

 حذف قسمت مورد نظر جدول -د

 مورد نظر جدول از کدام دستور استفاده می شود؟ برای پاک کردن قسمت-1078

 Draw -لفا

 Clear -ب

 Remove -ج

 Eraser -د

 را بر می گزینیم؟ Deleteبرای حذف ستون های جدول کدام دستور از گروه -1079

 Delete Cells -لفا

 Delete Columns -ب

 Delete Rows -ج

 Delete Table -د

 را بر می گزینیم؟ Deleteدستور از گروه برای حذف سطر های جدول کدام -1080

 Delete Cells -لفا

 Delete Columns -ب

 Delete Rows -ج



 Delete Table -د

 را بر می گزینیم؟ Deleteبرای حذف سلول های جدول کدام دستور از گروه -1081

 Delete Cells -لفا

 Delete Columns -ب

 Delete Rows -ج

 Delete Table -د

 را اعمال می کنیم؟ Deleteحذف کل جدول کدام دستور از گروه برای -1082

 Delete Cells -لفا

 Delete Columns -ب

 Delete Rows -ج

 Delete Table -د

 برای تجزیه یک سلول به چند سطر و ستون از کدام دستور استفاده می کنیم؟-1083

 Merge Cells -لفا

 Split Cells -ب

 Split Table -ج

 Split Column -د

 برای تقسیم جدول به دو بخش کدام دستور مناسب است؟-1084

 Merge Cells -لفا

 Split Table -ب

 Split Cells -ج

 Separate Table -د

 توسط این گزینه می توانیم ارتفاع جدول را تعیین کنیم:-1085

 Height -لفا

 Weight -ب

 Width -ج

 Vertical -د

 توان عرض جدول را تعیین کرد: توسط این گزینه می-1086

 Height -لفا

 Weight -ب

 Width -ج

 Vertical -د

 ا را منظم کنیم؟ن ههرگاه اندازه سطرهای جدول نامنظم شد، توسط کدام گزینه می توانیم آ-1087

 Distribute Columns -لفا

 Distribute Rows -ب

 Distribute Cell -ج

 Distribute Table -د

 ندازه ستون های جدول نامنظم شد، توسط کدام گزینه می توانیم آن ها را منظم کنیم؟هرگاه ا-1088

 Distribute Columns -لفا

 Distribute Rows -ب

 Distribute Cell -ج



 Distribute Table -د

 چگونه می توانیم جهت نوشته جدول را تغییر دهیم؟-1089

 Tableاز گروه  Text Orientation -لفا

 Sortاز گروه  Text indentation -ب

 Alignmentاز گروه  Text Direction -ج

 Cell Sizeاز گروه Text Direction -د

 حاشیه سلول چقدر فاصله داشته باشد.از با استفاده از گزینه ............. می توانیم تعیین کنیم متن -1090

 Cell Direction -لفا

 Cell Alignment -ب

 Cell Indention -ج

 Cell Margins -د

 توان استفاده نمود؟برای تکرار عنوان سطر جدول در هر صفحه از کدام ابزار می-1091

 Convert to text -لفا

 Repeat Header Column -ب

 Repeat Header Row -ج

 Repeat Header Cell -د

 چه عملکردی دارد؟ Dataدر گروه  Repeat Header Rowsدستور -1092

 کند یل میه متن تبدجدول را ب -لفا

 میسیم فرمول بنویتوان یم -ب

 کند یجاد میسطرها عنوان ا يبرا -ج

 کند یدر هر صفحه عنوان جدول را تکرار م -د

 کدام گزینه برای درج تصویر به کار می رود .-1093

 Illustrate -لفا

 Shape -ب

 Image -ج

 Picture -د

 نام .................... ایجاد می گردد.با درج نمودن تصویر یک زبانه جدید به -1094

 Format -لفا

 Picture -ب

 Design -ج

 Layout -د

 جزو کدام یک از برنامه های زیر به حساب می آید؟ Wordنرم افزار -1095

 یسیبرنامه نو -لفا

 بانک اطلاعات -ب

 ازپردواژه  -ج

 صفحه گسترده -د

 رد؟در کدام مورد کاربرد دا Wordنرم افزار -1096

 یسیبرنامه نو -لفا

 یامور مال -ب

 یکیامور گراف -ج



 ش کتاب و مقالهیرایه و ویته -د

 برای اعمال فرمت های اعمال شده متن انتخابی روی سایر نوشته ها سریع ترین روش کدام است؟-1097

 کردن متن یکپ -لفا

 نوشتهدن کر Duplicate -ب

 Format Painterاستفاده از  -ج

 Copy formatting -د

 برای درج یک کاراکتر ویژه از چه گزینه ای استفاده می شود؟-1098

 Styleنه یگز viewسربرگ  -لفا

 clipartنه یگز Insertسربرگ  -ب

 objectنه یگز Insertسربرگ  -ج

 Symbolنه یگز Insertسربرگ  -د

 ت؟اس کدام redoکلید میانبر فرمان -1099

 Ctrl +z -لفا

 Ctrl + s -ب

 Ctrl + Y -ج

 Alt + D -د

 کدام گزینه است؟ copyکلید میانبر -1100

 Ctrl + A -لفا

 Ctrl + x -ب

 Alt + c -ج

 Ctrl + c -د

مجلات و اسناد  بوده که بیشتر برای نوشتن و ویرایش کتاب، Office............... از جمله نرم افزارهای بسته -1101

 می شود.ده و.... از آن استفا

 Excel -لفا

 Word -ب

 Access -ج

 PowerPoint -د

 برای پیش نمایش سند قبل از چاپ از کدام گزینه استفاده می شود؟-1102

 Quick Print -لفا

 Print -ب

 Print Preview -ج

 Print Page -د

  ت.استفاده از کلیدهای ترکیبی ............... اس Wordآسان ترین شیوه برای ایجاد یک سند در -1103

 Ctrl + M -لفا

 Alt + N -ب

 Ctrl + O -ج

 Ctrl + N -د

 به سندهای آماده و از قبل ویرایش شده که به عنوان الگو استفاده می شوند چه می گویند؟-1104

 Pattern -لفا

 Template -ب



 Recent -ج

 Blank -د

 ست.ا ……استفاده از کلیدهای ترکیبی  Wordآسان ترین شیوه برای باز کردن یک سند در -1105

 Ctrl + N -فلا

 Alt +N -ب

 Ctrl + O -ج

 Ctrl+ R -د

 برای ذخیره سند از چه کلیدهایی استفاده می شود؟-1106

 Ctrl +x -لفا

 Ctrl + c -ب

 Ctrl +w -ج

 Ctrl +s -د

 برای مدیریت سند ها از کدام گزینه استفاده می شود؟-1107

 INSERT -لفا

 PAGE LAYOUT -ب

 FILE -ج

 DESIGN -د

 چیست؟ Wordدر  Fileکاربرد بخش -1108

 ا و نموداریدرج اش -لفا

 ت پاراگراف و متنیریمد -ب

 سند قبل از چاپ ینیبازب -ج

 ت سندیریمد -د

 .قابل اجرا نیست  Wordفرمت .......... فایل را به صورت غیر قابل تغییر در می آورد و با نرم افزار -1109

 PDF -لفا

 DOCM -ب

 DOC -ج

 DOCX -د

سند خود آدرس ذخیره سازی داده و برای آن نامی را تعیین کنید  به زمانی که شما نیاز داشته باشید تا-1110

 بهتر است از کدام گزینه استفاده کنید؟

 Save As -لفا

 Save -ب

 Export -ج

 Share -د

 استفاده می کنیم؟ Browseچه زمانی از کادر محاوره ای -1111

 دش جدول در سنیرایو -لفا

 دیجاد سند جدیا -ب

 سند يجستجو -ج

 دسن ینیبازب -د

 کنیم؟ می عمل چگونه برای اضافه کردن ابزار یا دستور به نوار ابزار با دسترسی سریع-1112

 Option> Customize Ribbon -لفا



 Customize Quick Access Toolbarنه یبون و انتخاب گزیر يک راست رویکل -ب

 Option> Advanced> Editing Option -ج

 Windowگروه   Viewزبانه  -د

 (  از کدام گزینه استفاده می کنیم؟Quick Access Toolbarوار ابزار )ش نبرای ویرای-1113

 Option> Add-in -لفا

 Option > Customize Ribbon -ب

 Option> Quick Access Toolbar -ج

 Option>Edit>Toolbar -د

 استفاده از ................... می توانیم سند خود را چاپ کنیم. با-1114

 Print -لفا

 Save -ب

 Info -ج

 Open -د

 از چه گزینه ای برای انتخاب تعداد سندهایی که می خواهیم  چاپ شود استفاده می کنیم؟-1115

 Print all page -لفا

 Quick print -ب

 Number of pages -ج

 Copies -د

 برای چاپ صفحه جاری در سند باید کدام گزینه را انتخاب کنیم؟-1116

 Print Selection -لفا

 Print Current Page -ب

 Print First Page -ج

 Print All pages -د

 برای چاپ تمام صفحات سند بهترین گزینه کدام است؟-1117

 Print Current Page -لفا

 Print Pages -ب

 Print Selection -ج

 Print All pages -د

 با استفاده از کدام گزینه می توانیم صفحات مورد نظر را به صورت سفارشی چاپ کنیم؟-1118

 Pages -لفا

 Print Current pages -ب

 Custom Print -ج

  ...Print from ... to -د

 برای چاپ متن انتخاب شده از کدام مورد استفاده می کنیم؟-1119

 Print Selected Text -لفا

 Print Section -ب

 Print Current text -ج

 Print Selection -د

 ا در اینترنت به اشتراک بگذارید؟د رمی توانید سند خو Fileبا استفاده از کدام دستور از منوی -1120

 Export -لفا



 Publish -ب

 Print -ج

 Share -د

 چیست؟ Exportکاربرد گزینه -1121

 گر فرمت هایانتشار سند در د -لفا

 انتشار سند -ب

 ش سندیش نمایپ -ج

 وارد کردن سند با فرمت خاص -د

 کلید میانبر برای بستن سند کدام است؟-1122

 Ctrl + C -لفا

 Ctrl +W -ب

 Alt+F4 -ج

 Alt + W -د

 برای بستن سند از چه دستوری استفاده می شود؟-1123

 Exit -لفا

 Eject -ب

 Close -ج

 Close Document -د

 چگونه عمل می کنیم؟ Officeبرای وارد شدن به حساب کاربری خود در -1124

 File > New> Account -لفا

 File > Open> Account -ب

 File> Account -ج

 File > Option> Account -د

 از کدام دکمه استفاده می کنید؟ Officeبرای واردشدن به حساب کاربری خود در -1125

 Sign Up -لفا

 Sign In -ب

 Sign Out -ج

 Sign at -د

 استفاده می کنیم. Fileبرای تغییر تنظیمات و سفارشی کردن نرم افزار از گزینه ............ در منوی -1126

 Account -لفا

 Info -ب

 Customize Word -ج

 Options -د

 زبانه اقدام می کنیم؟از کدام  Wordهای آماده در برای تغییر شکل ظاهری سند و استفاده از تم-1127

 INSERT -لفا

 HOME -ب

 DESIGN -ج

 LAYOUT -د

 ( چیست؟Templateمزیت الگو )-1128

 ستیر نییقابل تغ -لفا



 قابل اجراست Word 2013فقط در  -ب

 شیرایدر زمان و ییصرفه جو -ج

 ا استیجدول و اش يرادا -د

 به جای دیگر انتقال دهیم؟ توسط کدام دستور می توانیم متن انتخابی را برش زده و-1129

 Cut -لفا

 Paste -ب

 Copy -ج

 Format Painter -د

 هر گاه بخواهیم فرمت یک متن را به متن های دیگر انتقال دهیم از کدام گزینه استفاده می کنیم؟-1130

 Cut -لفا

 Copy Format -ب

 Format Painter -ج

 Paste Format -د

 ؟می شودسند از چه دستوری  استفاده  برای اعمال رنگ پس زمینه روی-1131

 Watermark -لفا

 Page Color -ب

 Page Border Color -ج

 Background Color -د

 برای چسباندن متنی که از قبل انتخاب و کپی یا برش زده شده است کدام دستور به کار می رود؟-1132

 Paste -لفا

 Clipboard -ب

 Replace -ج

 Find -د

 د نوشته های چند ستونی چه دستوری را اجرا می کنیم؟برای ایجا-1133

 Multi Columns -لفا

 Page Layout > Columns -ب

 Page Layout >Line Numbers -ج

 Page Layout > Margins -د

کدام مورد را باید  Columns ای محاوره کادر در دستی صورت برای مشخص کردن تعداد ستون ها به-1134

 تغییر دهیم؟

 Preset -لفا

 Width and Spacing -ب

 Number of columns -ج

 Apply to -د

 را انتخاب می کنیم؟ Columnsبرای قرار دادن خط بین ستون ها کدام گزینه از کادر محاوره ای -1135

 Line spacing -لفا

 Line between -ب

 Line in middle -ج

 Line in right -د

 یست؟چ Change Caseرد گزینه اربک-1136



 دیر زبان صفحه کلییتغ -لفا

 ه سندیحاش يرات روییاعمال تغ -ب

 ن از بزرگ به کوچک و بالعکسیر حروف لاتییتغ -ج

 نیلات ير فرمت نوشته هاییتغ -د

 به چه منظور استفاده می کنیم؟ Fontاز دستور -1137

 متن یا بزرگیر کوچک ییتغ -لفا

 ر فرمت جملهییتغ -ب

 فرمت نوشته حذف -ج

 ن نوع قلمییتع يبرا -د

 برای بزرگ کردن اندازه نوشته کدام گزینه به کار می رود؟-1138

 Change Font size -لفا

 Font -ب

 Increase Font Size -ج

 Decrease Font size -د

 برای اینکه اندازه متن را کم کنیم روی کدام دستور کلیک می کنیم؟-1139

 Decrease Font size -لفا

 Small Font -ب

 Increase Font size -ج

 Change Font size -د

 را گزینه کدام باید شود، نوشته لاتین بزرگ حروف با جمله هر کلمه اول برای اینکه بخواهیم حرف-1140

 برگزینیم؟

 Uppercase -لفا

 Lowercase -ب

 Capitalize Each word -ج

 .Sentence case -د

 د کدام گزینه مناسب است؟اشنی بزرگ باگر بخواهیم تمام حروف انگلیس-1141

 Lowercase -لفا

 Sentence case -ب

 Toggle case -ج

 Uppercase -د

 استفاده می کنیم؟ Change Caseبرای نوشتن حروف کوچک انگلیسی از کدام دستور -1142

 Lowercase -لفا

 Uppercase -ب

 Capitalize each word -ج

 Sentence case -د

 ه انگلیسی کوچک باشد، کدام گزینه را انتخاب می کنیم؟کلماهیم اولین حرف از هر اگر بخو-1143

 Sentence Case -لفا

 Capitalize Each Word -ب

 Toggle case -ج

 Lowercase -د



 برای برجسته کردن نوشته باید کدام گزینه را فعال کنیم؟-1144

 Underline -لفا

 Italic -ب

 Strikethrough -ج

 Bold -د

 ............ متن استفاده می شود ....برای .... Underlineاز گزینه -1145

 رخط دار کردنیز -لفا

 مورب کردن -ب

 توپر کردن -ج

 جلوه دار کردن -د

 برای مورب کردن متن از کدام گزینه استفاده می کنیم؟-1146

 Bold -لفا

 Italic -ب

 Underline -ج

 Effect -د

 چیست؟ Italicکاربرد سبک -1147

 توپر کردن نوشته -لفا

 شتهنو ر خط دار کردنیز -ب

 مورب کردن نوشته -ج

 نوشته يجاد خط رویا -د

 برای نوشتن توان یک عدد از چه گزینه ای استفاده می کنیم؟-1148

 Superscript -لفا

 Subscript -ب

 Strikethrough -ج

 Bold -د

 است؟ اسبمن ای گزینه چه گذاری)زیرنویس(برای اندیس-1149

 Superscript -لفا

 Subscript -ب

 Strikethrough -ج

 Bold -د

 برای جلوه دادن به متن بهتر است کدام دستور را برگزینیم؟-1150

 Text Style -لفا

 Text option -ب

 Text Effects -ج

 Font -د

 با این دستور می توانیم رنگ متن را تغییر دهیم:-1151

 Highlighter -لفا

 Color -ب

 Typography -ج

 Font Color -د



 فاده می شود؟استبرای رنگ کردن زمینه نوشته از کدام گزینه -1152

 Font color -لفا

 Fore color -ب

 Highlight -ج

 Line color -د

 سطحی کدام دستور مناسب تر است؟برای ایجاد فهرست چند-1153

 Bullets -لفا

 Numbering -ب

 Multilevel List -ج

 Table of content -د

 Bulletsنه برای ایجاد گزیمورد نظر خود را در لیست کشویی پیدا نکردیم از کدام  Bulletsزمانی که -1154

 جدید استفاده می کنیم؟

 Define new number format -لفا

 Define new multilevel list -ب

 Change list level -ج

 Define new bullet -د

 کدام است؟ Wordابزار ایجاد فهرست در -1155

 Multilevel list -لفا

 Table of Contents -ب

 Number list -ج

 List of content -د

 متن را وسط چین می کند؟ Alignmentکدامیک از دستورات -1156

 Center -لفا

 Right -ب

 Left -ج

 Justify -د

 استفاده کنیم؟ Alignmentم گزینه برای نوشتن متون فارسی باید از کدا-1157

 Center -لفا

 Right -ب

 Left -ج

 Justify -د

 برای ترازبندی متن از سمت راست کدام دستور مناسب است؟-1158

 Align right -لفا

 Alignment -ب

 Right -ج

 Indent to right -د

 د.گزینه .......................... برای ترازبندی متن کاربرد دار-1159

 Indentation -لفا

 Justify -ب

 Line spacing -ج



 Direction -د

 برای منظم کردن متن کاربرد دارد؟ Alignmentکدام یک از دستورات -1160

 Center -لفا

 Right -ب

 Margins -ج

 Justify -د

 برای کم کردن فاصله پاراگراف از حاشیه باید چه دستوری را اجرا کنیم؟-1161

 Left indention -لفا

 Increase indent -ب

 Decrease indent -ج

 High indention -د

 به چه منظوری به کار می رود؟ Increase indentگزینه -1162

 هیکم کردن فاصله پاراگراف از حاش -لفا

 هید کردن فاصله پاراگراف از حاشایز -ب

 هیش حاشیافزا يبرا -ج

 هیکاهش حاش يبرا -د

 دستور تغییر می کند؟جهت نوشته با کدام -1163

 Direction -لفا

 Indentation -ب

 Alignment -ج

 sort -د

 کدام گزینه برای نوشتن متون فارسی به کار می رود؟-1164

 Left to right text direction -لفا

 Right to left text direction -ب

 Right indention -ج

 Left indention -د

 خطوط را تعیین می کند؟کدام دستور فاصله بین -1165

 Text spacing -لفا

 Paragraph spacing -ب

 Character spacing -ج

 Line and paragraph spacing -د

 چه کاربردی دارد؟ Line and Paragraph Spacingابزار -1166

 و پاراگراف طوطخ يترازبند -لفا

 خطوط و پاراگراف یتورفتگ -ب

 م فاصله خطوط و پاراگرافیتنظ -ج

 د و پاراگرافیجاد خطوط جدیا -د

 استفاده می کنید؟ Borderچه زمانی از ابزار -1167

 شود یه برگه استفاده میم حاشیتنظ يبرا -لفا

 شود یه جدول استفاده میر حاشییتغ يبرا -ب

 شود یل استفاده مجدوجاد کادر دور متن و یا يبرا -ج



 شود. یانتخاب سبک نوشته استفاده م يبرا -د

1168-Shading .برای ................ به کار می رود 

 م فاصله خط و پاراگرافیتنظ -لفا

 ه و کادریجاد حاشیا -ب

 متون يمرتب ساز -ج

 نه داخل کادرین رنگ و طرح زمییتع -د

 استفاده می شود؟ور بندی متن از کدام دستبرای حذف تغییرات و قالب-1169

 Remove formatting -لفا

 Clear formatting -ب

 Delete formatting -ج

 Change formatting -د

 توان سبک جدید و سفارشی ایجاد نمود؟با استفاده از کدام گزینه می-1170

 Create a new style -لفا

 Define New Style -ب

 Apply Style -ج

 ..Save As New Style Set -د

1171-Apply Styles چه کاری انجام می دهد؟ 

 کند یجاد مید ایسبک جد -لفا

 کند یسبک قبل را حذف م -ب

 میموجود را اعمال کن يم سبک هایتوان یکند و م یجاد مید ایسبک جد -ج

 کند یمش یرایموجود را و يسبک ها -د

 را تغییر دهیم؟ tabبه چه روشی می توانیم نوع -1172

 خط کش يک کردن رویبا کل -لفا

 change tabه نیانتخاب گز viewز سربرگ ا -ب

 types of tabنه یانتخاب گز viewاز سربرگ  -ج

 ها در سمت چپ خط کش tabمربع مربوط به  يک رویبا کل -د

 ها باید چه عملی را انجام دهیم؟ tabبرای اجرای هر کدام از -1173

 میکن یک میکل یدر مکان دلخواه در خط کش افق -لفا

 کش با درگ کردن خط -ب

 میفشار یرا م caps lockپ کردن دکمه ین تایصفحه در ح يرو -ج

 scroll barبا فشردن دکمه  -د

 برای نوشتن حروف انگلیسی استفاده می شود؟ tabکدام -1174

 Right Tab -لفا

 Left Tab -ب

 Center Tab -ج

 Decimal Tab -د

 کدام تب برای وسط چین کردن به کار می رود؟-1175

 Right Tab -لفا

 Bar Tab -ب

 Center Tab -ج



 Decimal Tab -د

1176-Center Tab به چه نوع تبی گفته می شود ؟ 

 يتب اعشار -لفا

 تب راست -ب

 تب وسط -ج

 تب بار -د

 برای ایجاد تورفتگی خط اول پاراگراف در محل ایجاد تب کدام گزینه را بر می گزینیم؟-1177

 Hanging Indent -لفا

 First Line Indent -ب

 First Line Tab -ج

 Decimal Tab -د

 برای وسط چین کردن اعداد اعشاری و قرار دادن اعشار عدد در یک راستا کدام تب را انتخاب می کنیم؟-1178

 Center Tab -لفا

 Decimal Tab -ب

 Bar Tab -ج

 Right Tab -د

1179-Bar Tab چه کاری انجام می دهد؟ 

 جاد تبیخط اول پاراگراف در محل ا یجاد تورفتگیا -لفا

 جاد تبیخط در محل ا کی قرار دادن -ب

 از سمت راست یجاد تب در خط کش افقیا -ج

 ک راستایقرار دادن اعشار اعداد در  -د

 چیست؟ Decimal Tabکاربرد -1180

 جاد تب راستیا -لفا

 جاد تب وسطیا -ب

 جاد تب چپیا -ج

 يجاد تب اعشاریا -د

1181-First Line Indent چه کاربردی دارد؟ 

 رود. یبه کار م ياراعشن کردن اعداد یوسط چ يبرا -لفا

 رود. یکل پاراگراف به کار م یجاد تورفتگیا يبرا -ب

 رود یخط اول پاراگراف به کار م یجاد تورفتگیا يبرا -ج

 رود . ین خطوط به کار میجاد فاصله بیا يبرا -د

 تغییر فاصله بین خطوط و پاراگراف استفاده می کنیم؟ کدام گزینه برای زا-1182

 Special character -لفا

 Line and paragraph spacing -ب

 Line and paragraph indent -ج

 Each character Spacing -د

 کدام است؟ Findکلید میانبر -1183

 F3 -لفا

 Ctrl +j -ب

 Ctrl + R -ج



 Ctrl + F -د

 می توان لغت و اصطلاح مورد نظر را در متن فایل پیدا کنیم؟توسط کدام گزینه -1184

 Find -لفا

 Replace -ب

 Search -ج

 Google -د

 کدام دستور برای جایگزین کردن یک متن جدید با متن فعلی به کار می رود؟-1185

 Replace -لفا

 Find -ب

 Object -ج

 Search -د

عبارتی را که می خواهیم ورد آن را برای جایگزینی  Find and Replace.............. از پنجره  در قسمت-1186

 نویسیم.انتخاب کند)پیدا کند(، می

 Replace With -لفا

 Find With -ب

 Find What -ج

 Search word -د

 نویسیم؟چه می Find Whatدر منوی کشویی -1187

 ن شدنیگزیجا يد برایمتن جد -لفا

 میم جستجو کنیخواه یکه م یمتن -ب

 میم توپر کنیخواه یرا که م یمتن -ج

 میم فرمت آن را پاک کنیخواه یکه م یمتن -د

 بارت جدیدی را که می خواهیم با کلمه قبلی جایگزین شود، درج کنیم؟ا عدر کدام کادر باید کلمه ی-1188

 Search Box -لفا

 Find What -ب

 Replace With -ج

 Replace All -د

می توانید تمام کلمات انتخاب شده را جایگزین  Find and Replaceبا استفاده از کدام دکمه در کادر -1189

 کنید؟

 More -لفا

 Replace All -ب

 Replace -ج

 Find what -د

 از کدام گزینه استفاده می شود؟ Find And Replaceبرای یافتن کلمه بعدی در کادر -1190

 Find Previous -لفا

 Replace -ب

 Find what -ج

 Find next -د

کنیم روی کدام دکمه کلیک می  صورت یک به یک جایگزینشده را به برای اینکه بخواهیم کلمات یافته-1191

 کنیم؟



 Replace All -لفا

 Single Replace -ب

 Find Next -ج

 Replace -د

 برای نمایش خط کش کدام سربرگ را انتخاب می کنید؟-1192

 Reference -لفا

 View -ب

 Layout -ج

 Insert -د

 را فعال می کنید؟ Viewبرای خط کش کدام ابزار از سربرگ -1193

 Gridline -لفا

 Eraser -ب

 Ruler -ج

 Wrap -د

 را تغییر می دهیم؟ فحهتوسط کدام دستور اندازه ص-1194

 Width -لفا

 Paper -ب

 Page Layout -ج

 Size -د

 ارتفاع صفحه کدام گزینه را تغییر می دهیم؟برای تغییر -1195

 Width -لفا

 Weight -ب

 Height -ج

 Paper -د

 چه کاربردی دارد؟ Paperدر سربرگ  Widthگزینه -1196

 دهد یر مییارتفاع صفحه را تغ -لفا

 ندک ین مییعرض صفحه را تع -ب

 کند ین مییاندازه کل صفحه را تع -ج

 ند.ک ین مییه را تعیاندازه حاش -د

 جهت صفحه را تعیین می کند؟ Page Layoutکدام دستور در سربرگ -1197

 Orientation -لفا

 Margins -ب

 Size -ج

 Columns -د

 کدام کلید ترکیبی برای کاهش سایز قلم استفاده می شود؟-1198

 + ( Ctrl -لفا

 + ) Crtl -ب

 + [ Ctrl -ج

 + ] Ctrl -د

موجب می شود  Font( کدام گزینه از x+5تایپ نماییم، پس از انتخاب ) ( راx+5)^ 2خواهیم عبارت می-1199



 تا عبارت به درستی تایپ شود؟

 Strikethrough -لفا

 Superscript -ب

 Subscript -ج

 Engrave -د

 توسط کدام گزینه امکان پذیر است؟ یگرکپی کردن قالب بندی یک پاراگراف به یک یا چند پاراگراف د -1200

 Format Painter -لفا

 Position -ب

 Effect -ج

 Paragraph -د

 کدام است؟ Go toکلید ترکیبی -1201

 Ctrl +C -لفا

 Ctrl + G -ب

 Alt +C -ج

 Alt + G -د

 برای ترازبندی پاراگراف، از کدام سربرگ استفاده می کنیم؟-1202

 Insert -لفا

 Font -ب

 Page Layout -ج

 Review -د

 کرد؟ استفاده توان می زیر گزینه کدام از صورت پشت سر همط بهبرای انتخاب چند خ-1203

 یجهت يدهایهمراه با کل Shift دیکل -لفا

 یجهت يدهایهمراه با کل Altد یکل -ب

 یجهت يدهایهمراه با کل Ctrlد یکل -ج

 و انتخاب خطوط Scroll Barد یکل -د

 تفاده می شود؟کلید صفحه کلید اسام برای انتخاب کلمات پراکنده از کد-1204

 Alt -لفا

 Ctrl -ب

 Shift -ج

 Tab -د

 حافظه های اصلی کامپیوتررا نام ببرید؟-1205

 CD-ROM - DVDROM -لفا

 ROM   -   RAM -ب

 EPROM - HARD DISK -ج

 HARD DISK-RAM -د

 کدام مورد یک دستگاه خروجی است؟-1206

 دیصفحه کل -لفا

 ماوس -ب

 اسکنر -ج

 چاپگر  -د



بدیل دستورات غیر قابل فهم  به زبان قابل درک کامپیوتر , کدام برنامه وظیفه این کار را بر عهده ت یبرا-1207

 دارد ؟

 سیستم عامل -لفا

 مترجم ها  -ب

 نرم افزارهاي کاربردي -ج

 نرم افزارهاي کمکی -د

 برای نگهداری موقت داده های در حال پردازش از کدام مورد استفاده می شود؟-1208

 CU -لفا

 ALU  -ب

 REGISTER -ج

 CACHE -د

 کدام یک از گزینه های زیر بیانگر اجزای فیزیکی یک سیستم کامپیوتری است؟-1209

 (HARDWAREسخت افزار )  -لفا

 (FREEWAREگان )ینر م افزار را -ب

 (SOFTWAREنرم افزار) -ج

 (COURSEWARE) یابزاراموزش -د

 ت؟کدام یک از عبارت های زیر صحیح اس-1210

 ت استیک مگابایمتراز ت کیگابایک گی -لفا

 . ت استیک مگابایت کمترازیلو بایک کی  -ب

 ت استیک بیت کمترازیک بای -ج

 ت استیگابایک گیت کمتر ازیک ترابای -د

 صحیح است؟  RAMکدام عبارت در مورد-1211

 کند یداده هاراحفظ مشود یموترخاموش یکه کامپ یهنگام RAM -لفا

 . است ینوشتن يحافظه خواند کی  RAM  -ب

 است یحافظه فقط نوشتنRAM -ج

 ش دادیتوان افزا ینم يوتریچ کامپیرا در ه  RAM -د

 از نظرابعاد در بین گزینه های زیر کدام است؟ بزرگ ترین کامپیوتر-1212

 PC -لفا

 MAINFRAME -ب

 LAPTOP -ج

 SUPER COMPUTER  -د

 ا قرار می گیرد؟یک برنامه به منظور اجرا در کج-1213

 RAM  -لفا

 ROM -ب

 HARD DISK -ج

 CACHE MEMORY -د

 ؟نمی باشدکدام یک از موارد زیر جزء انواع شبکه -1214

 GATE WAYS -لفا

 WAN -ب

 MAN -ج



 LAN -د

 یک سیستم کامپیوتر از چه قسمت هایی تشکیل شده است ؟-1215

 سخت افزار و حافظه جانبی -لفا

 افزارنرم افزار و میان  -ب

 سخت افزار و میان افزار -ج

  میان افزار و  افزار  نرم  و  سخت افزار  -د

 از کدام مورد برای چاپ نقشه ها و تصاویر بزرگ استقاده می شود؟-1216

 پلاترها  -لفا

 پرینترها -ب

 یهاي فتوکپدستگاه -ج

 هاي تکثیرماشین -د

 ه می شود؟به عنوان حافظه سریع نامید CPUکدام واحد از -1217

 CACHE -لفا

 REGISTER -ب

 CU -ج

 ALU -د

 ؟نمی باشدرودی ه وکدام گزینه دستگا-1218

 SPEAKER  -لفا

 MOUSE -ب

 LIGHT PEN -ج

 SCANNER -د

 ؟نیست های زیر ضروریبرای استفاده از صوت و موزیک در کامپیوتر کدام یک از گزینه-1219

 کارت صدا -لفا

 مودم  -ب

 ییدئویوا ی یل صوتیفا -ج

 (SPEAKERبلندگو ) -د

 کامپیوتر مرکزی در شبکه کامپیوتری چه نام دارد؟-1220

 MICRO COMPUTER -لفا

 SUPER COMPUTER -ب

 MINI COMPUTER -ج

 SERVER COMPUTER  -د

 به فروش ازطریق شبکه اینترنت در وب سایت ها چه می گویند؟-1221

 E-TEJARAT -لفا

 E-COMMERCE  -ب

 E-TRAINING -ج

 E-BANKING -د

 ویروس کامپیوتری عبارت است از:-1222

 زا يماریروس بیک وی -لفا

 وتریود در کامپموجک سخت افزار ی -ب

  مخرب يوتریک برنامه کامپی  -ج



 وتریک نرم افزار موجود در کامپی -د

 پ کرد؟ختم می شود درکادر جستجو چگونه باید تای Pحرفی که به  5برای جستجوی فایل های -1223

 p* -لفا

 *p -ب

 ????p -ج

 p????  -د

 در مقابل این عبارت، فضای آزاد یک درایو مشخص می شود.-1224

 CAPACITY -لفا

 BACKUP NOW -ب

 FREE SPACE  -ج

 TYPE -د

 ها و پوشه ها کدام گزینه را انتخاب می نمائیم؟ برای لغو آخرین عمل انجام شده بر روی فایل-1225

 RESTORE -لفا

 CLOSE -ب

 UNDO  -ج

 REDO -د

 پسوند فایل های متنی کدام است؟-1226

 TXT  -لفا

 BMP -ب

 JPG -ج

 RTF -د

 .می شوداز ترکیب کلید های ......... استفاده سخ برای بستن یک برنامه بدون پا-1227

 CTRL+ALT+DELET  -لفا

 SHIFT+CTRL+ALT -ب

 SHIFT+CTRL+A -ج

 ALT+DELET+Y -د

 داقل رساندن اندازه ی پنجره از کدام گزینه استفاده می کنیم؟برای به ح-1228

 MINIMIZE  *لفا

 MAXIMIZE *ب

 CLOSE -ج

 RESTORE DOWN -د

 وجب انتقال آنها به کجا می شود؟ا محذف فایل ها و پوشه ه-1229

 COMPUTER  -لفا

 RECYCLE BIN  -ب

 از بین می روند -ج

 رندقرار می گی CLIPBORDدر حافظه موقت  -د

 کرد؟ توان استفادهنمیبرای بستن پنجره ها از کدام گزینه -1230

 م .یک کنیرا کل CLOSEنه یگز FILE ياز منو -لفا

 میک کنیپنجره  کل يبالاعلامت ضربدر سمت راست گوشه  يرو -ب

 م .یکنیاستفاده م ALT+ F4 یبید ترکیاز کل -ج



 م .یکنیاستفاده م ALT+ TAB یبید ترکیاز کل  -د

 به عمل حرکت دادن ماوس در حالیکه دکمه سمت چپ آن فشرده شده است چه می گویند؟-1231

 DRAG  -لفا

 CLICK -ب

 DOUBLE CLICK -ج

 DROP -د

 می گویند؟ چه به نوار رنگی بالای پنجره ها-1232

 نوار آدرس -لفا

 نوار منو -ب

 نوار عنوان  -ج

 تینوار وضع -د

 است از نشانی منحصر به فرد هرسایت در اینترنت. ................... عبارت-1233

 DOMAIN -لفا

 ADDRESS SITE -ب

 URL  -ج

 HTTPS -د

 کدام گزینه زیر یک موتورجستجوگرمی باشد؟-1234

 YAHOO -لفا

 GOOGLE  -ب

 ASK -ج

 TVTO -د

 کدام پوشه در برگیرنده پیام های دریافت شده می باشد؟-1235

 INBOX  -لفا

 DRAFT -ب

 OUTBOX -ج

 SENTITEM -د

 سایت هایی هستند که در آن سایتها از نظر موضوعی طبقه بندی شده اند؟-1236

 یعیزبان طب يموتور جستجو -لفا

 موتورهاي جستجو -ب

 موتورهاي فرا جستجو -ج

 وب سایتهاي فهرست  -د

 خچه اینترنت کدام است ؟اریت-1237

 BACK-لفا

 HISTORY  -ب

 FAVORITES-ج

 FORWARD -د

 به جای علامت + در جستجوی عبارت ها کدام علمگرد را می توان استفاده کرد؟-1238

 OR -لفا

 AND  -ب

 NOT -ج



 XOR -د

 پسوند سایت های مربوط به موسسات دولتی کدام است؟-1239

 COM -لفا

 EDU -ب

 GOV -ج

 MIL -د

 برگیرنده پیام های حذف  شده می باشد؟ در کدام پوشه-1240

 INBOX -لفا

 DRAFT -ب

 OUTBOX -ج

 TRASH  -د

 برای تغییر اندازه متن صفحات وب چه عملی باید انجام دهیم ؟-1241

 IE/VIEW / TEXT SIZE  -لفا

 IE/ VIEW / STATUS BAR -ب

 IE/VIEW /EXPLORER BAR -ج

 IE/ VIEW / TOOL BAR -د

 زیر مرورگر صفحات وب است؟ هایکدام یک از نرم افزار-1242

 INTERNET EXPLORER -لفا

 MOZILA FIREFOX -ب

 WINDOWS EXPLORER -ج

 INTERNET EXPLORER   -   MOZILA   FIREFOX -د

 برای ادغام خانه های جدول از کدام گزینه استفاده می کنیم؟-1243

 SPILT CELLS -لفا

 MERGE CELLS -ب

 TABLE  SPILT -ج

 MERGE TABLE -د

 ه میزان یک واحد کدام کلید ترکیبی مناسب است؟اهش اندازه قلم بی کبرا-1244

 [+CTRL -لفا

 ]+SHIFT -ب

 [+SHIFT -ج

 ]+CTRL -د

 چه نوع نرم افزاری است؟ WORDنرم افزار -1245

 است یکیک نرم افزار گرافی -لفا

 است يک نرم افزار آماری -ب

 ک نرم افزار واژه پرداز استی -ج

 ستر اک نرم افزار صفحه گستی -د

 صحیح است؟ WORDکدام یک از گزینه های زیر برای ایجاد سند جدید در نرم افزار -1246

 OPEN -لفا

 NEW -ب

 SAVE` -ج



 SAVE AS -د

 برای تنظیم فاصله بین خطوط از کدام گزینه استفاده می شود؟-1247

 LINE COLOR -لفا

 LINE STYLE -ب

 LINE SPACING -ج

 BORDER -د

 ف تراز شوند از کدام گزینه استفاده می کنیم؟گراای خطوط پارااگر بخواهیم انته-1248

 JUSTIFY -لفا

 CENTER -ب

 ALIGN LEFT -ج

 ALIGN RIGHT -د

 برای درج اشکال هندسی از چه گزینه ای استفاده می شود؟-1249

 SHAPES -لفا

 PICTURE -ب

 SMART ART -ج

 CHART -د

 د؟شو از کدام گزینه استفاده می برای تغییر سند از حالت عمودی به افقی-1250

 PORTRAIT -لفا

 PORTRAIT FLEEPED -ب

 LANDSCAPE -ج

 LANDSVCAPE FLEEPED -د

 از کدام فرمان برای تقسیم یک خانه جدول به چند خانه استفاده می شود؟-1251

 INSERTاز سربرگ  SPLITگزینه  -لفا

 LAYOUTاز سربرگ   SPLIT CELLSگزینه   -ب

 INSERTاز سربرگ  MERGEگزینه  -ج

 LAYOUTاز سربرگ وابسته   MERGEگزینه  -د

 پسوند ذخیره ی سند ایجاد شده به صورت الگو کدام است؟-1252

 PDF لفا

 DOTX -ب

 DOCX -ج

 XPS -د

 جهت ایجادلیست علامت گذاری کدام ابزار مناسب است؟-1253

 BULLETS -لفا

 NUMBERING -ب

 TABLE -ج

 SYMBOL -د

 کدام است؟ REDOادل کلید ترکیبی مع-1254

 CTRL+B -لفا

 CTRL+Y -ب

 CTRL+Z -ج



 CTRL+SHIFT+Z -د

 کدام تابع اعداد موجود در یک ناحیه از سلول ها را شمارش می کند؟-1255

 ROUND -لفا

 COUNT  -ب

 COUNTA -ج

 LEN -د

 است؟ کدام A4در  = SUM(A1;A3 (حاصل فرمول  A1=10  , A2=20, A3=30با فرض -1256

 50 -لفا
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 40  -ج

 30 -د

 در سلول در صورت طولانی شدن در چند سطر قرار گیرد؟ شدهچه چیز باعث می شود که متن نوشته -1257

 STRIKE -لفا

 MERGE CELLS -ب

 SHRINK TO FIT -ج

 WRAP TEXT  -د

 ؟نداردکدام خطای نشان می دهدکه پهنای سلول قابلیت نمایش محتویات آن را -1258

 VALUE# -لفا

 DIV#  -ب

 #####  -ج
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باعث اعمال فرمت با قالب رایج پول  FORMAT CELLSره کدام یک از گزینه های زیرواقع در پنج-1259
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 TEXT -ج
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 ک خانه باواژه مورد نظریپرکردن  -لفا

 نه سلولیر رنگ زمییتغ  -ب



 داخل سلول يفشرده ساز -ج

 اطلاعات داخل سلول يازبندتر -د
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 TEXT  -ج
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 کلید میانبر برای مخفی سازی نوار ریبون کدام است؟-1300
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 Ctrl+F1  -ب

  F1 -ج

  Alt+F -د

  ؟غلط است Hard Diskک از موارد زیر در مورد ی کدام-1301

  نمود. يتوان مجددا قالب بند یه را مشد (Format) يکبار قالب بندیکه  یسکید -لفا

  شود. یه اطلاعات موجود پاک میسک سخت ، کلید يدستور قالب بند يبا اجرا -ب
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  اینترنت چه می گویند؟ات به شرکت سرویس دهنده خدم-1302

  Hperlink -لفا

 User Account -ب

  URL -ج

  ISP  -د

 ، کدام است؟( Help)کلید میانبر جهت استفاده از -1303
  

  F2 -الف

  F 1  -ب

  7F -ج

  3F -د

 استفاده می نمائیم؟ Undoاز کدام کلید های صفحه کلید برای اجرای فرمان -1304

 CTRL+ Z  -الف 

  CTRL+ V -ب

 CTRL+ P  -ج

  CTRL+X -د

 برای قفل کردن کامپیوتر از کدام گزینه استفاده می شود؟-1305

  Lock  -لفا

  Shut Down -ب

  Restore -ج

  Log Off -د

 از کدام کلید استفاده می کنیم؟ برای رفتن به پاراگراف بعدی-1306

 Shift  -الف 

 Enter  -ب

  Alt -ج

 Ctrl  -د

 ؟هد کدام پسوند یک وب سایت آموزشی را نشان می د-1307



 Net -الف 

  Com -ب

  Gov -ج

  Edu  -د

هوا  و قیمت ارز را نشان می دهند چه نامیده می ، که اطلاعاتی مانند آب و 7ابزارهای کوچک در ویندوز -1308

 شوند؟

  Flip 3D -لفا

  Navigation -ب

  Touch -ج

  Gadgets  -د

 کدامیک از ابزار های زیر جزء وسایل خروجی هستند؟-1309

 Speaker  -لفا

  Microphone -ب

  Light Pen -ج

  Scanner -د

 م گزینه مناسب است؟برای تغییر نما در حالت رئوس مطالب، کدا-1310
  

 Print layout  -الف

 Outline  -ب

 Web layout  -ج

 Read mod  -د

 .......................................//:httpتایپ -1311

 است. یالزام ير تجاریغ يت هایسا يبرا -الف 

  است. یالزام يتجار يت هایسا يراب  -ب

  ست.ین یالزام -ج

  است . یالزام -د

 برای وارد کردن تصاویر به کامپیوتر از کدام سخت افزار استفاده می شود؟-1312

 چاپگر  -لفا

  اسکنر -ب

  پلاتر -ج

  کیکارت گراف -د

  برای خروج کامل از ویندوز کدام گزینه را انتخاب می نمائیم؟-1313

 Log Off  -لفا

  Restore -ب

  Shut Down  -ج

  Hibernate -د

 جرای فرمان جستجوی واژه ها کدام است؟گزینه مناسب ا-1314

 Edit  -الف 

 Replace  -ب

 Find  -ج



 Home  -د

 برای بارگذاری مجدد یک صفحه وب از کدام گزینه استفاده می کنیم ؟-1315

 Stope -الف 
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  Back -ج
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 انتخاب می کنیم؟یدها تمام موضوعات موجود در یک سند را کل با استفاده از کدام-1316

 CTRL+ V  -الف 

 CTRL+ A  -ب

 CTRL+ S  -ج

 CTRL+ C  -د

 ؟نمی شود ک از موارد زیر سیستم عامل محسوب ی کدام-1317
  

 Linux  -الف

  Unix -ب
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 Windows -د
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 Icons  -الف 

  Tiles -ب
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  F12 -الف 

  F11  -ب

  F10 -ج
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  Ctrl  -د
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 Web layout  -ب

 Draft  -ج

 Print layout  -د

  کدام گزینه نرم افزار سیستمی است؟-1325

  عامل ستمیس -لفا

  نترنتیا -ب

  اکسل -ج

 ورد -د

  ؟نیست کدامیک جزء واحدهای اندازه گیری حافظه-1326

 تیب -لفا

  سلول -ب

  تیبا -ج

  کلمه  -د

 کدام گزینه رابط بین کاربر و اینترنت می باشد ؟-1327

  IT -الف 
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  شبکه -د

 د؟برای انتخاب یک کلمه از کدام گزینه استفاده می شو-1328
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  GUI  کاربر یکیگراف واسط  -د
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 Ctrl+ Home  -لفا
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 University + Shiraz -الف 

  Shiraz - University  -ب

  Shiraz University + -ج

  And Shiraz University -د
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 Uppercase  -ب

 Sentence case  -ج

 Toggle case  -د

 عناوین سطرها و ستون ها با کدامیک از موارد زیر مشخص می شود؟-1354



 سطرها و ستون ها با حروف الفبا  -لفا

 سطرها و ستون ها با ارقام -ب

  سطرها با حروف الفبا و ستون با اعداد -ج

 ن و سطرها با اعدادیتلا يحروف الفبا با  ستونها   -د

 برای تنظیم وضعیت قرارگیری کاغذ به صورت افقی از کدام فرمان استفاده می کنیم؟-1355

 Landscape  -لفا

  Page Range -ب

  Portrait -ج

  Current Page -د

  از کدام فرمان برای ایجاد یک فایل صفحه گسترده جدید استفاده می کنیم؟-1356

 Format  -فلا

  Copy -ب

  New  -ج

  Cut -د

 برای تغییر رنگ متن نوشته شده از کدام گزینه استفاده می شود؟-1357

 Fill color  -الف 

 Font  -ب

 Font color  -ج

 Text highlight  -د

  ........................... استفاده می کنیم. برای بازیابی فایل یا پوشه از سطل بازیافت از فرمان-1358

 Format  -لفا

  Restore  -ب

  Delete -ج

  Empty Recycle -د

  کدام جلوه متن را سایه دار نمایش می دهد؟-1359

 Shadow  -لفا

 Outline  -ب

 Emboss  -ج

 Engrave  -د

  هدف ارگونومیک چیست؟-1360

  يسالم ماندن لوازم کار -لفا

  یسلامت روح -ب

 ط کاریدر مح سلامت انسان  -ج

  يروش کار ينه سازیبه -د

 ام گزینه برای ذخیره تصاویر استفاده می گردد ؟کد-1361

 Save Picture As  -الف 

  Save As Picture -ب

  Show Picture -ج

  Go to my Picture -د

 ود؟برای مرتب کردن داده ها از کدام گزینه استفاده می ش -1362



  Auto Fill -لفا

  Sort  -ب

  auto -ج

  Comments -د

  ترونیک می باشد؟الککدام مورد از معایب تجارت -1363

 سه شوند.یتوانند مقا یکالاها م  -لفا

  شود. ینقل و انتقال پول به سرعت انجام م -ب

  ندارد.   وجود   دار یخر  و  فروشنده  نیب  یکیزیارتباط ف -ج

  باشند. یک روز میقابل ارائه در  يس هایسرو -د

 ود؟ی شبا استفاده از کدام گزینه زیر،  عمل موردگذاری انجام م-1364

 Bullets  -الف 

 Line spacing  -ب

 Numbering  -ج

 Indent  -د

 چگونه می توان پیش نمایش چاپ را مشاهده کرد؟-1365

 Print -لفا

 Print Preview  -ب

  Print  setup -ج

  Page Setup -د

 جهت تایید و لغو محتویات یک سلول از کدام گزینه استفاده می شود؟-1366

 ات سلول.یجهت لغو محتو Escو دکمه د یجهت تائ  Enterدکمه    -لفا

  ات سلولیجهت لغو محتو Escد و دکمه یجهت تائ backspaceدکمه  -ب

  سلول اتیجهت لغو محتو Spacebarد و دکمه یجهت تائ Tabدکمه  -ج

 ات سلولیجهت لغو محتو Spacebarد و دکمه یجهت تائ Enterدکمه  -د

  کدام جمله نادرست است؟-1367

  ابد.ی یخود انتقال م یافت به همان محل اصلیشده از سطل باز یبایل بازیفا -لفا

  رد.یگ یافت قرار میل حذف شده در سطل بازیفا -ب

  راست.ییافت قابل تغیت سطل بازیظرف -ج

  شود. ینم یابیچگاه بازیل حذف شده هیفا  -د

 ؟می دهدچه عملی انجام  format painterابزار  -1368

 .ندک یمقالب متن را حذف   -الف 

 کند. یم یقالب متن را کپ  -ب

 کند. یم یمتن را کپ  -ج

 کند. یم يمتن را قالب بند  -د

 ....................... داریم . جهت چاپ مطالب  صفحه وب نیاز به-1369

  چاپگر   -لفا

  اسکنر -ب

  رسام -ج

 بلندگو  -د

 انواع نرم افزار کدام گزینه است ؟-1370



 مترجم-یستمیس -لفا

  یستمیس-يکاربرد  -ب

 یسیبرنامه نو -يکاربرد -ج

  نییسطح پا-سطح بالا -د

  ادر مشاهده می گردد؟تنظیم زمان انتظار در محافظ صفحه نمایش در کدام ک-1371

  Wait  -لفا

  Copy -ب

  Properties -ج

  View -د

 برای دانلود یک فایل از کدام گزینه استفاده می شود؟-1372

 Save Target As  -الف 

  Save As -ب

  Save File As -ج

  Save -د

 چیست؟ E -Learningو  E-Mailمفهوم  -1373

  کیکترونک ، آموزش الیکتابخانه الکترون -لفا

  کیک ، پست الکترونیتجارت الکترون -ب

  یکیآموزش الکترون   ،   یکیالکترون   پست -ج

  کی، کتابخانه الکترون یکیالکترون يبانکدار -د

 ................................. تعیین می گردد. ای زمان و تاریخ سیستم در کادر محاوره-1374

  Change Date and time setting  -الف 

  Setting -ب

  Properties -ج

  Date -د

 ، از کلید .................. استفاده می کنیم. Excelبرای انتخاب خانه های غیرمجاور در -1375

  Insert -الف 

  Alt -ب

  Ctrl  -ج

  Shift -د

کنند چه نامیده می ه های کوچکی که به یک برنامه اجرایی حمله کرده و اجرای آن را مختل می نامبر -1376

 شود ؟

  Scam -لفا

  viruse -ب

  Hacker -ج

  ISDN -د

1377-Domain در آدرسE-Mail نشانه چیست؟ 

 شناسه کاربر -لفا

  کیس دهنده پست الکترونینام سرو  -ب

  وب جهان گستر وب -ج

  لینام فا -د



  سربرگ برای درج پاورقی است؟ام کد-1378

 Review  -لفا

 Layout  -ب

 References  -ج

 view  -د

  به شبکه خصوصی که همانند شبکه اینترنت می باشدچه می گویند.-1379

  LAN -لفا

  MAN -ب

  WAN -ج

  Interanet  -د

 با کدام گزینه تصویر در زمینه میز کار بصورت کشیده قرار می گیرد؟-1380

 Center  -الف 

  Stretch  -ب

  Fill -ج

  Tile -د

 چه کاری انجام می دهیم؟ Move or Copyی در پنجره Create a copyبا گزینه -1381

  دیدرج کاربرگ جد -الف 

  حذف کاربرگ -ب

  از کاربرگ  یک کپیجاد یا  -ج

 کاربرگ ییجابجا  -د

 از نظر امنیتی باز کردن چه ایمیل هایی می تواند خطرناک باشد؟-1382

 م .یکه فرستنده را بشناس ییها لیمیا -الف 

  ما ناشناس است . يفرستنده برا یکه موضوعات جالب دارند ول ییل هایمیا  -ب

  شود. یم Forwardکه از طرف دوستان   ییل هایمیا -ج

  شود. یم Replyکه  ییل هایمیا -د

 از کدام گزینه برای وارد کردن فایل تصویری در سند استفاده می نمائیم؟-1383

 View/ picture  -لفا

 Insert/ chart  -ب

 Insert/ picture  -ج

 Home/ picture  -د

  برای تغییر سایز آیکن ها از کدام فرمان استفاده می نمائیم؟-1384

  View  -لفا

  Sort -ب

  File -ج

  New -د

  کنیم؟جهت تغییر اندازه تصویر، کدام سربرگ را انتخاب می-1385

 Format  -لفا

 Page layout  -ب

 Layout  -ج

 View  -د



 از کدام گزینه جهت افزودن اعشار استفاده می کنیم؟-1386

  Style -الف 

  Decrease Decimal -ب

  Decimal -ج

  Increase Decimal  -د

 ؟ نمی دهندکدام یک از شرکت های زیر خدمات ساخت پست الکترونیکی را به صورت رایگان -1387

 Google -الف 

  Bing  -ب

  Yahoo -ج

  Hotmail -د

  چرخش متن در جدول از کدام گزینه استفاده می شود؟ای بر-1388

 Insert a cell  -لفا

 Insert a column  -ب

 Text  Direction  -ج

 Insert a table  -د

 بهترین روش برای جلوگیری از ورود ویروس به سیستم کدام گزینه است ؟-1389

 باشد یم یالصاق يل هایفا يکه دارا یکیالکترون يحذف نامه ها -لفا

 ستم یروس در سیو یبرنامه آنت يریبه کارگ -ب

 باشد  داشته   را   شدن  روز  به ییکه توانا یآنت داشتن -ج

  یجانب ياستفاده از حافظه ها -د

 حداقل تعداد کاراکترهای کلمه عبور در پست الکترونیکی کدام گزینه می باشد؟-1390

 6 -الف 

  32 -ب

  8  -ج

  16 -د

 مان استفاده می کنیم؟فر ی ادغام خانه ها از کدامبرا-1391

  Condition Format -الف 

  Merge & Center  -ب

 Format Painter  -ج

  Comment -د

 روس همان ................... است.یو -1392

  سخت افزار  -لفا

  يبرنامه کاربرد -ب

  برنامه مخرب   -ج

  یبمب منطق -د

 ...........استفاده می نماییم....ه سبک خاص و کوتاه از گزینه..........برای ایجاد متن ب-1393

 Text  Box  -الف 

 Format  -ب

 Page Layout  -ج

 Word Art  -د



 ؟ دستگاهی که هنگام قطع برق ، برق رایانه را تامین می کند چه نام دارد -1394

  Modem -لفا

  Ups -ب

  Cpu -ج

  Memory Card -د

 شخیص آدرس ایمیل از آدرس وب چیست ؟روش ت-1395

 @مت وجود علا  -لفا

  س دهندهیعدم وجود نوع سرو -ب

 نام وب سرور -ج

   Httpوجود  -د

  علامت قرمز برنامه آنتی ویروس نشانه چیست؟-1396

  روسیو یخراب شدن آنت -لفا

  روسیو یبه روز نبودن آنت  -ب

  روسیو یانگر مدت زمان استفاده از آنتیب -ج

  روسیوجود و -د

  کدام گزینه صحیح می باشد ؟-1397

  م .یکن  يخوددار مقابل افراد مشکوک  مودن  کلمه عبور درد ناز وار -لفا

  چند حساب استفاده کرد. يکسان براید از کلمه عبور یبا -ب

  عوض شود. يد به صورت دوره ایکلمه عبور نبا -ج

  کند. ین نمیکلمه عبور  معتبر بودن کاربر را تضم -د

 اده می شود؟ستفبرای نمایش گرافیکی داده های عددی از کدام گزینه ا-1398

 Clip Art  -الف 

 Format  -ب

 Shape  -ج

 Chart  -د

 نامه های ناتمام معمولا در کدام پوشه قرار می گیرند ؟-1399

 Inbox -لفا

  Outbox -ب

  Draft  -ج

 Other -د

 ر یک سلول از کدام گزینه استفاده می شود؟جهت شکستن متن اضافی د-1400

 Split Cell  -الف 

  Shrink to Fit -ب

  Wrap Text  -ج

  Merge & Center -د

  به نرم افزار هایی که به مدت یک ماه استفاده از آنها رایگان است ، چه گفته می شود؟-1401

  Shareware  -لفا

  Freeware -ب

  کد باز -ج

  Open Source -د



 برای تغییر عرض ستون کدام گزینه مناسب است؟-1402

 Column width  -الف 

 Row height  -ب

 Table properties  -ج

 Preferred width  -د

 نامه چه چیزی را می نویسیم ؟ Subjectدر قسمت -1403

 رنده یآدرس گ -الف 

 یرنده مخفیآدرس گ -ب

  موضوع نامه  -ج

  متن نامه -د

 برای ارسال مجدد یک نامه الکترونیکی به سایر افراد از کدام گزینه استفاده می نمائیم ؟ -1404

 Reply -لفا

  Reply All -ب

  Send -ج

  Forward  -د

 به ارتباط چند رایانه متصل به هم چه می گویند؟-1405

 PC -لفا

 NETWORK -ب

 ISP -ج

 IP -د

  کترونیکی از کدام گزینه استفاده می شود؟برای ضمیمه یک فایل به نامه ال -1406

  Reply -لفا

   Attach File  -ب

  Forward -ج

  Priority -د

  را فراهم می نماید؟ ابیدر پنجره چاپ کدام گزینه چاپ بخش انتخ-1407

  Selection  -لفا

  Current -ب

  All -ج

  Pages -د

  انتشار نرم افزار است ؟ک از گزینه های زیر از ویژگی های حق ی کدام-1408

 شناسد. یت میدار نرم افزار را به رسمیحقوق خر  -لفا

  شناسد. یم ت یرسم به    را   نرم افزار  کننده  د یتول  حقوق -ب

  کند. یر میم افزار را امکان پذنر سرقت -ج

  ر آن را دارد .یدار مالک نرم افزار است و حق تکثیخر -د

  ارای محدودیت ...................... است.ارسال فایل ضمیمه د-1409

 تیموقع -لفا

 زمان -ب

  حجم  -ج

  سرعت ارسال -د



 ؟برای دوخطی نمودن خطوط اطراف جدول استفاده از کدام گزینه مناسب است-1410

 Pen color  -الف 

 Text  -ب

 Borders  -ج

 Line  -د

  ده نشانه گذاری می کند؟کدام گزینه پیام ها را بر اساس پیام نخوانده ش-1411

  Unread  -لفا

  Read -ب

  Starred -ج

  Bookmark -د

  از کدام دستور برای چرخش تصویر استفاده می شود؟-1412

 Page  -لفا

 Rotate  -ب

 Format  -ج

 Layout  -د

 کدام پوشه نامه های حذف شده را نگهداری می کند؟ Emailپنجره در -1413

 Draft -الف 

  Sent -ب

  Delete Item  -ج

  Inbox -د

 کدام گزینه زیر جهت ادغام کردن خانه های جدول مورد استفاده قرار می گیرد؟-1414

 Split cells  -الف 

 Split table  -ب

 Draw table  -ج

 Merge cells  -د

 ط افراد خارج از سازمان قابل دسترسی است؟توسکدام شبکه -1415

 نترنتیا -لفا

 انتاکستر -ب

  نترانتیا -ج

  LAN -د

 در هنگام ارسال نامه ، آدرس گیرنده باید در کدام قسمت درج شود؟-1416

 To  -الف 

  From -ب

  CC -ج

  Bcc -د

  برای ایجاد ادغام پستی از کدام گزینه استفاده می شود؟-1417

 Envelops  -لفا

 Lablels  -ب

 Merge cells  -ج

 Mailings  -د



  ینترنت وصل نباشید ، نامه هایی که ارسال می شوند در کدام پوشه قرار می گیرند؟اگر به ا-1418

 Outbox  -لفا

  Inbox -ب

  Send Item -ج

  Draft -د

 ؟ به عمل پشتیبان گیری چه می گویند-1419

  Number -لفا

  Design -ب

 backup  -ج

  Table -د

 .............. می توان گیرنده ها را تعیین نمود. ام پستی از قسمتادغدر هنگام -1420

 Start mail merge  -الف 

 Envelopes  -ب

 Address block  -ج

 Select recipients  -د

 برای درج برچسب نامه از کدام ابزار استفاده می کنیم؟-1421

 Email  -لفا

 Envelope  -ب

 Mail merge  -ج

 labels  -د

کلیک    Outlookنامه به همه گیرندگان نامه اصلی باید بر روی کدام  دکمه از نوار ابزار اسخل پبرای ارسا-1422

 نمایید.

 Send -الف 

  Reply -ب

  Reply To  All  -ج

  Forward -د

 جهت ایجاد یک صفحه جدید از کدام کلیدها استفاده می کنیم؟-1423

 Ctrl + Enter  -الف 

 Alt + Enter  -ب

 Shift + Enter  -ج

 Enter  -د

 جهت ظاهر شدن کادر غلط گیر املایی، از چه کلیدی استفاده می کنیم؟-1424

 F6  -الف 

 F7  -ب

 F8  -ج

  F1 -د

  کند. ک رکورد مجموعه ای از اطلاعات را درباره ................. ذخیره میی-1425

  چند موضوع -لفا

  لیچند فا -ب

  ک موضوعی -ج



  لیک فای -د

، برای ثابت شدن سطرها و ستون های قبل از سلول انتخابی از کدام  Freezeن در زمان استفاده از فرما-1426

 گزینه استفاده می نمائیم؟

 Freeze First Column -لفا

  Freeze Top Row -ب

 Freeze Panes  -ج

  Freeze All Column -د

.......... استفاده می ...ابت شدن اولین سطر از گزینه ..........، برای ث Freezeدر زمان استفاده از فرمان  -1427

 نمائیم.

  Freeze First Column -لفا

 Freeze Top Row   -ب

 Freeze Panes -ج

  Freeze All Column -د

  نوع داده متنی با طول زیاد کدام یک از گزینه های زیر می باشد؟-1428

 Number  -لفا

  Yes/ No -ب

  Long text -ج

  Short text -د

  کدام سربرگ استفاده می کنیم؟ از برای تنظیم حاشیه های چاپ-1429

  Page setup -لفا

  Setup -ب

  Home -ج

  Create -د

 برای تنظیم حاشیه صفحات از گزینه................ استفاده می شود.-1430

 Margins  -الف 

 Size  -ب

 Columns  -ج

 Orientation  -د

 چه زمانی مشاهده می گردد؟ DIV/0# یخطا -1431

 باشد. یستون مناسب نم يرا پهنایش دهد زیح نمایات سلول را به فرم صحیواند محتوت یکه اکسل نم یزمان  -لفا

  باشد. یستون مناسب نم يپهنا -ب

  م شده است.یاز داده ها بر صفر تقس یکیکه  یزمان  -ج

  د.ینما ییاز داده ها را در فرمول شناسا یکیتواند  یکه اکسل نم یزمان -د

  امکان پذیر نمی باشد؟ وجیتبدیل گزارش به کدام نوع خر-1432

 Pdf  -لفا

  Docx -ب

  Bmp -ج

  Xlsx -د

  برای ثابت شدن نوار ریبون از بالا و سمت راست ..............را  انتخاب می کنیم.-1433

  Show the ribbon -لفا



  TOP the ribbon -ب

  Open ribbon -ج

  Pin the ribbon -د

( برنامه قابل اجرا باشد از چه 2003نسخه  های قبلی ) در در صورتی که بخواهیم یک فایل ارائه مطالب-1434

 پسوندی استفاده می کنیم؟

  PPTX -لفا

  POT  -ب

  PPT  -ج

  PPS -د

  کدام است؟ 2013اکسسپسوند فایل ها در نرم افزار پایگاه داده -1435

  DOCX -لفا

  PPTX -ب

  Accdb -ج

  XLSX -د

 د ...... می شود.یجادرتنظیم حاشیه صفحات گزارش، سبب ا wideگزینه -1436

  ه کوتاهیحاش -الف 

  ه نرمالیحاش -ب

  کیه باریحاش -ج

  ه پهنیحاش -د

 ود؟) چپ به راست(برای تنظیم حاشیه صفحات از کدام سربرگ و گزینه استفاده می ش-1437

 Page layout------ print  -الف 

 Home------ margins  -ب

 Page layout------- paraghraph  -ج
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